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Grass Valley Web Site

Manual Explanation

October 6, 2014

This public Web site contains all the latest manuals and documentation, and additional
support information. Use the following URL.

http://www.grassvalley.com.

* |f there are any variations between the explanation in this manual and the actual application
method, priority is given to the actual application method.

¢ This manual is a common manual for T2 Elite, T2 Pro and T2 Express. Screenshots and
illustrations in this manual may vary from those of the actual product.

* The screenshots used as examples in this manual are those of the development stage, so
they may vary from those in the final product.

¢ This manual is written for users who have a basic knowledge of how to use a computer.
If there are no special instructions, perform the same operation as a normal computer
operation.

* The contents of this product may modify without prior notice.

T2 Elite/Pro/Express Users Guide
Ver 3.0
Copyright © 2012 - 2014 Grass Valley. All rights reserved.
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Notice

Section

MICROSOFT SOFTWARE LICENSE TERMS WINDOWS EMBEDDED

STANDARD 7

October 6, 2014

These license terms are an agreement between you and Grass Valley, Inc. Please
read them. They apply to the software included on this device. The software also
includes any separate media on which you received the software.
The software on this device includes software licensed from Microsoft
Corporation or its affiliate.
The terms also apply to any Microsoft

¢ updates,

¢ supplements,

¢ Internet-based services, and

® support services
for this software, unless other terms accompany those items. If so, those terms
apply.
If you obtain updates or supplements directly from Microsoft, then Microsoft,
and not Grass Valley, Inc., licenses those to you.
As described below, using the software also operates as your consent
to the transmission of certain computer information for Internet-based
services.
By using the software, you accept these terms. If you do not accept them,
do not use the software. Instead, contact Grass Valley, Inc. to determine its
return policy for a refund or credit.

If you comply with these license terms, you have the rights below.

1. USE RIGHTS

Use. The software license is permanently assigned to the device with which you
acquired the software. You may use the software on the device.
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— Notice

2. ADDITIONAL LICENSING REQUIREMENTS AND/OR USE RIGHTS

a. Specific Use. Grass Valley, Inc. designed the device for a specific use.

You may only use the software for that use.

. Other Software. You may use other programs with the software as long

as the other programs

e directly supports the manufacturer’s specific use for the device, or

e provide system utilities, resource management, or anti-virus or similar
protection.

e Software that provides consumer or business tasks or processes
may not be run on the device. This includes email, word processing,
spreadsheet, database, scheduling and personal finance software. The
device may use terminal services protocols to access such software

running on a server.

. Device Connections. You may not use the software as server software.

In other words, more than one device may not access, display, run, share
or use the software at the same time.

You may use terminal services protocols to connect the device to a
server running business task or processes software such as email, word

processing, scheduling or spreadsheets.

You may allow up to ten other devices to access the software to use

e File Services,
e Print Services,
¢ Internet Information Services, and

¢ Internet Connection Sharing and Telephony Services.

The ten connection limit applies to devices that access the software
indirectly through “multiplexing” or other software or hardware that
pools connections. You may use unlimited inbound connections at any
time via TCP/IP.

. Remote Access Technologies. You may access and use the software

remotely from another device using remote access technologies as

follows.

Remote Desktop. The single primary user of the device may access

a session from any other device using Remote Desktop or similar
technologies. A “session” means the experience of interacting with
the software, directly or indirectly, through any combination of input,
output and display peripherals. Other users may access a session from
any device using these technologies, if the remote device is separately

licensed to run the software.
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October 6, 2014

Other Access Technologies. You may use Remote Assistance or similar

technologies to share an active session.

Other Remote Uses. You may allow any number of devices to access

the software for purposes other than those described in the Device
Connections and Remote Access Technologies sections above, such as to

synchronize data between devices.

e. Font Components. While the software is running, you may use its fonts
to display and print content. You may only

¢ embed fonts in content as permitted by the embedding restrictions in
the fonts; and

* temporarily download them to a printer or other output device to print
content.

f. lcons, images and sounds. While the software is running, you may use
but not share its icons, images, sounds, and media.

3. VHD BOOT. Additional copies of the software created using the software’s

Virtual Hard Disk functionality (“VHD Image”) may be pre-installed on the
physical hard disk of the device. These VHD Images may only be used for
maintaining or updating the software installed on the physical hard disk or
drive. If the VHD Image is the only software on your device, it may be used as
the primary operating system but all other copies of the VHD Image may only

be used for maintenance and updating.

. POTENTIALLY UNWANTED SOFTWARE. The software may include

Windows Defender. If Windows Defender is turned on, it will search this

i

device for “spyware,” “adware” and other potentially unwanted software. If it
finds potentially unwanted software, the software will ask you if you want to
ignore, disable (quarantine) or remove it. Any potentially unwanted software
rated “high” or “severe,” will be automatically removed after scanning unless
you change the default setting. Removing or disabling potentially unwanted

software may result in

¢ Other software on your device ceasing to work, or
¢ Your breaching a license to use other software on this device

By using this software, it is possible that you will also remove or disable

software that is not potentially unwanted software.

. SCOPE OF LICENSE. The software is licensed, not sold. This agreement only

gives you some rights to use the software. Grass Valley, Inc. and Microsoft
reserve all other rights. Unless applicable law gives you more rights despite
this limitation, you may use the software only as expressly permitted in this

agreement. In doing so, you must comply with any technical limitations in the
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software that allow you to use it only in certain ways. For more information,

see the software documentation or contact Grass Valley, Inc. You may not:

work around any technical limitations in the software;

reverse engineer, decompile or disassemble the software;

make more copies of the software than specified in this agreement;
publish the software for others to copy;

rent, lease or lend the software; or

use the software for commercial software hosting services.

Except as expressly provided in this agreement, rights to access the software

on this device do not give you any right to implement Microsoft patents or

other Microsoft intellectual property in software or devices that access this

device.

6. INTERNET-BASED SERVICES. Microsoft provides Internet-based services

with the software. Microsoft may change or cancel them at any time.

a. Consent for Internet-Based Services. The device may contain one or

more of the software features described below. These features connect
to Microsoft or service provider computer systems over the Internet. In
some cases, you will not receive a separate notice when they connect.
For more information about these features, visit go.microsoft.com/
fwlink/?linkid=104604.

By using these features, you consent to the transmission of this
information. Microsoft does not use the information to identify or contact
you.

Computer Information. The following features use Internet protocols,

which send to the appropriate systems computer information, such as
your Internet protocol address, the type of operating system and browser,
the name and version of the software you are using, and the language
code of the device where you installed the software. Microsoft uses this
information to make the Internet-based services available to you. Grass

Valley, Inc. has elected to turn on the following features on the device.

¢ Plug and Play and Plug and Play Extensions. You may connect new

hardware to your device. Your device may not have the drivers needed
to communicate with that hardware. If so, the update feature of the
software can obtain the correct driver from Microsoft and install it on
your device.

e Web Content Features. Features in the software can retrieve related

content from Microsoft and provide it to you. Examples of these
features are clip art, templates, online training, online assistance and
Appshelp. You may choose to switch them off or not use them.

e Digital Certificates. The software uses x.509 version 3 digital certificates.
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These digital certificates confirm the identity of user sending
information to each other and allow you to encrypt the information.
The software retrieves certificates and updates certificate revocation
lists over the Internet.

Auto Root Update. The Auto Root Update feature updates the list of
trusted certificate authorities. You can switch off this feature.

Windows Media Digital Rights Management. Content owners use

Windows Media digital rights management technology (WMDRM) to
protect their intellectual property, including copyrights. This software
and third party software use WMDRM to play and copy WMDRM-
protected content. If the software fails to protect the content, content
owners may ask Microsoft to revoke the software’s ability to use
WMDRM to play or copy protected content. Revocation does not affect
other content. When you download licenses for protected content, you
agree that Microsoft may include a revocation list with the licenses.
Content owners may require you to upgrade WMDRM to access their
content. Microsoft software that includes WMDRM will ask for your
consent prior to the upgrade. If you decline an upgrade, you will not
be able to access content that requires the upgrade. You may switch off
WMDRM features that access the Internet. When these features are off,

you can still play content for which you have a valid license.

Windows Media Player. When you use Windows Media Player, it

checks with Microsoft for

e compatible online music services in your region;

* new versions of the player; and

e codecs if your device does not have the correct ones for playing

content.

You can switch off this feature. For more information, go to:
go.microsoft.com/fwlink/?LinkId=51331.

Malicious Software Removal/Clean On Upgrade. Before installation

of the software, the software will check and remove certain malicious
software listed at www.support.microsoft.com/?kbid=890830
(“Malware”) from your device. When the software checks your device
for Malware, a report will be sent to Microsoft about any Malware
detected or errors that occurred while the software was checking for
Malware. No information that can be used to identify you is included
in the report. You may disable the software’s Malware reporting
functionality by following the instructions found at www.support.
microsoft.com/?kbid=890830.

Network Awareness. This feature determines whether a system is

connected to a network by either passive monitoring of network traffic
or active DNS or HTTP queries. The query only transfers standard TCP/

IP or DNS information for routing purposes. You can switch off the
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active query feature through a registry setting.

Windows Time Service. This service synchronizes with www.time.

windows.com once a week to provide your 1 device with the correct
time. The connection uses standard NTP protocol.

Search Suggestions Service. In Internet Explorer, when you type

a search query in the Instant Search box or type a question mark

(?) before your search term in the Address bar, you will see search
suggestions as you type (if supported by your search provider).
Everything you type in the Instant Search box or in the Address bar
when preceded by a question mark (?) is sent to your search provider as
you type. Also, when you press Enter or click the Search button, the text
in the Instant Search box or Address bar is sent to the search provider.
If you use a Microsoft search provider, use of the information sent is
subject to the Microsoft Online Privacy Statement. This statement is
available at go.microsoft.com/fwlink/?linkid=31493. If you use a third-
party search provider, use of the information sent will be subject to

the third party’s privacy practices. You can turn search suggestions off
at any time. To do so, use Manage Add-ons under the Tools button in
Internet Explorer. For more information about the search suggestions
service, see go.microsoft.com/fwlink/?linkid=128106.

Consent to Update Infrared Emitter/Receiver. The software may contain

technology to ensure the proper functioning of the infrared emitter/
receiver device shipped with certain Media Center-based products. You
agree that the software may update the firmware of this device.

Media Center Online Promotions. If you use Media Center features of

the software to access Internet-based content or other Internet-based

services, such services may obtain the following information from the

software to enable you to receive, accept and use certain promotional
offers:

e certain device information, such as your Internet protocol address,
the type of operating system and browser you are using, and the
name and version of the software you are using,

e the requested content, and

e the language code of the device where you installed the software.

* Your use of the Media Center features to connect to those services
serves as your consent to the collection and use of such information.

Media Playback Updates. The software on the device may include

media playback features which receives updates directly from the
MSCORP Media Playback Update servers. If activated by your
manufacturer, these updates will be downloaded and installed without
further notice to you. The manufacturer is responsible for ensuring

these updates work on your device.

e Windows Update Agent. The software on the device includes Windows
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Update Agent (“WUA”). This feature enables your device to access
Windows Updates either directly from MSCORP Windows Update
server or from a server installed with the required server component
and from the Microsoft Windows Update server. To enable the proper
functioning of the Windows Update service in the software (if you

use it) updates or downloads to the Windows Update service will be
required from time to time and downloaded and installed without
further notice to you. Without limiting any other disclaimer in these
license terms or any license terms accompanying a Windows Update,
you acknowledge and agree that no warranty is provided by Microsoft
Corporation or their affiliates with respect to any Windows Update that
you install or attempt to install on your device.

b. Use of Information. Microsoft may use the device information, error
reports, and Malware reports to improve our software and services. We
may also share it with others, such as hardware and software vendors.
They may use the information to improve how their products run with
Microsoft software.

c. Misuse of Internet-based Services. You may not use these services in
any way that could harm them or impair anyone else’s use of them. You
may not use the services to try to gain unauthorized access to any service,

data, account or network by any means.

7. PRODUCT SUPPORT. Contact Grass Valley, Inc. for support options. Refer to

the support number provided with the device.

8. MICROSOFT .NET BENCHMARK TESTING. The software includes one or
more components of the .NET Framework (“.NET Components”). You may
conduct internal benchmark testing of those components. You may disclose the
results of any benchmark test of those components, provided that you comply
with the conditions set forth at go.microsoft.com/fwlink/?LinkID=66406.

Notwithstanding any other agreement you may have with Microsoft, if you
disclose such benchmark test results, Microsoft shall have the right to disclose
the results of benchmark tests it conducts of your products that compete

with the applicable NET Component, provided it complies with the same
conditions set forth at go.microsoft.com/fwlink/?LinkID=66406.

9. BACKUP COPY. You may make one backup copy of the software. You may

use it only to reinstall the software on the device.

10.DOCUMENTATION. Any person that has valid access to your device or
internal network may copy and use the documentation for your internal,

reference purposes.
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11.PROOF OF LICENSE. If you acquired the software on the device, or on a

disc or other media, a genuine Certificate of Authenticity label with a genuine
copy of the software identifies licensed software. To be valid, this label must
be affixed to the device, or included on or in Grass Valley, Inc.’s software
packaging. If you receive the label separately, it is not valid. You should keep
the label on the device or packaging to prove that you are licensed to use the

software. To identify genuine Microsoft software, see www.howtotell.com.

12.TRANSFER TO A THIRD PARTY. You may transfer the software only with the

device, the Certificate of Authenticity label, and these license terms directly to
a third party. Before the transfer, that party must agree that these license terms
apply to the transfer and use of the software. You may not retain any copies of
the software including the backup copy.

13.NOTICE ABOUT THE H.264/AVC VISUAL STANDARD, THE VC-1 VIDEO

STANDARD, THE MPEG-4 VISUAL STANDARD AND THE MPEG-2 VIDEO
STANDARD. This software may include H.264/AVC, VC-1, MPEG-4 Part 2,
and MPEG-2 visual compression technology. If the software includes those
visual compression technologies MPEG LA, L.L.C. requires this notice:

THIS PRODUCT IS LICENSED UNDER ONE OR MORE VIDEO PATENT
PORTFOLIO LICENSES SUCH AS, AND WITHOUT LIMITATION, THE
AVC, THE VC-1, THE MPEG-4 PART 2 VISUAL, AND THE MPEG 2

VIDEO PATENT PORTFOLIO LICENSES FOR THE PERSONAL AND
NON-COMMERCIAL USE OF A CONSUMER TO (i) ENCODE VIDEO IN
COMPLIANCE WITH THE ABOVE STANDARDS (“VIDEO STANDARDS”)
AND/OR (ii) DECODE VIDEO THAT WAS ENCODED BY A CONSUMER
ENGAGED IN A PERSONAL AND NON-COMMERCIAL ACTIVITY OR
WAS OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE
VIDEO UNDER SUCH PATENT PORTFOLIO LICENSES. NONE OF THE
LICENSES EXTEND TO ANY OTHER PRODUCT REGARDLESS OF
WHETHER SUCH PRODUCT IS INCLUDED WITH THIS PRODUCT IN A
SINGLE ARTICLE. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR
ANY OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED
FROM MPEG LA, L.L.C. SEE WWW.MPEGLA.COM.

14.NOTICE ABOUT THE MP3 AUDIO STANDARD. This software includes MP3

audio encoding and decoding technology as defined by ISO/IEC 11172-3 and
ISO/IEC 13818-3. It is not licensed for any implementation or distribution in

any commercial product or service.

15.NOT FAULT TOLERANT. The software is not fault tolerant. Grass Valley,

Inc. installed the software on the device and is responsible for how it
operates on the device.
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16.RESTRICTED USE. The Microsoft software was designed for systems that do

not require fail-safe performance. You may not use the Microsoft software in
any device or system in which a malfunction of the software would result in
foreseeable risk of injury or death to any person. This includes operation of
nuclear facilities, aircraft navigation or communication systems and air traffic

control.

17.NO WARRANTIES FOR THE SOFTWARE. The software is provided “as

is”. You bear all risks of using it. Microsoft gives no express warranties,
guarantees or conditions. Any warranties you receive regarding the
device or the software do not originate from, and are not binding on,
Microsoft or its affiliates. When allowed by your local laws, Grass Valley,
Inc. and Microsoft exclude implied warranties of merchantability, fithess
for a particular purpose and non-infringement.

18.LIABILITY LIMITATIONS. You can recover from Microsoft and its affiliates

only direct damages up to two hundred fifty U.S. Dollars (U.S. $250.00).
You cannot recover any other damages, including consequential, lost
profits, special, indirect or incidental damages.

This limitation applies to:

¢ anything related to the software, services, content (including
code) on third party internet sites, or third party programs, and

e claims for breach of contract, breach of warranty, guarantee or
condition, strict liability, negligence, or other tort to the extent
permitted by applicable law.

It also applies even if Microsoft should have been aware of the
possibility of the damages. The above limitation may not apply to you
because your country may not allow the exclusion or limitation of
incidental, consequential or other damages.

19.EXPORT RESTRICTIONS. The software is subject to United States export

laws and regulations. You must comply with all domestic and international
export laws and regulations that apply to the software. These laws include
restrictions on destinations, end users and end use. For additional information,

see www.microsoft.com/exporting.

20.ENTIRE AGREEMENT. This agreement, additional terms (including any

printed-paper license terms that accompany the software and may modify or
replace some or all of these terms), and the terms for supplements, updates,
Internet-based services and support services that you use, are the entire

agreement for the software and support services.
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21.APPLICABLE LAW

a. United States. If you acquired the software in the United States,
Washington state law governs the interpretation of this agreement and
applies to claims for breach of it, regardless of conflict of laws principles.
The laws of the state where you live govern all other claims, including
claims under state consumer protection laws, unfair competition laws,

and in tort.

b. Outside the United States. If you acquired the software in any other
country, the laws of that country apply.

22.Third Party Programs. Microsoft provides the following copyright notices
for third party software included in the software. These notices are
required by the respective copyright holders and do not change your
license to use this software.

Portions of this software are based in part on the work of Spider Systems ®
Limited. Because Microsoft has included the Spider Systems Limited software
in this product, Microsoft is required to include the following text that

accompanied such software:

Copyright 1987 Spider Systems Limited
Copyright 1988 Spider Systems Limited
Copyright 1990 Spider Systems Limited

Portions of this software are based in part on the work of Seagate Software.
Portions of this software are based in part on the work of ACE*COMM Corp.
Because Microsoft has included the ACE*COMM Corp. software in this product,
Microsoft is required to include the following text that accompanied such
software:

Copyright 1995-1997 ACE*COMM Corp

Portions of this software are based in part on the work of Sam Leffler and
Silicon Graphics, Inc. Because Microsoft has included the Sam Leffler and Silicon
Graphics software in this product, Microsoft is required to include the following

text that accompanied such software:

Copyright © 1988-1997 Sam Leffler
Copyright © 1991-1997 Silicon Graphics, Inc.

Permission to use, copy, modify, distribute, and sell this software and
its documentation for any purpose is hereby granted without fee, provided
that (i) the above copyright notices and this permission notice appear in
all copies of the software and related documentation, and (ii) the names of
Sam Leffler and Silicon Graphics may not be used in any advertising or
publicity relating to the software without the specific, prior written

permission of Sam Leffler and Silicon Graphics.
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THE SOFTWARE IS PROVIDED "AS-IS" AND WITHOUT WARRANTY
OF ANY KIND, EXPRESS, IMPLIED OR OTHERWISE, INCLUDING
WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY
OR FITNESS FOR A PARTICULAR PURPOSE.

IN NO EVENT SHALL SAM LEFFLER OR SILICON GRAPHICS

BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT OR
CONSEQUENTIAL DAMAGES OF ANY KIND, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER OR NOT ADVISED OF THE POSSIBILITY OF DAMAGE,
AND ON ANY THEORY OF LIABILITY, ARISING OUT OF OR IN
CONNECTION WITH THE USE OR PERFORMANCE OF THIS
SOFTWARE.

Portions Copyright © 1998 PictureTel Corporation

Portions of this software are based in part on the work of Highground Systems.
Because Microsoft has included the Highground Systems software in this
product, Microsoft is required to include the following text that accompanied

such software:

Copyright © 1996-1999 Highground Systems

Windows 7 incorporates compression code from the Info-ZIP group. There are no
extra charges or costs due to the use of this code, and the original compression
sources are freely available from www.info-zip.org/ or ftp:/ftp.info-zip.org/pub/

infozip/src/ on the Internet.
Portions Copyright © 2000 SRS Labs, Inc

This product includes software from the 'zlib' general purpose compression

library.

Portions of this software are based in part on the work of ScanSoft, Inc. Because
Microsoft has included the ScanSoft, Inc. software in this product, Microsoft is
required to include the following text that accompanied such software:

TextBridge® OCR © by ScanSoft, Inc.

Portions of this software are based in part on the work of University of Southern
California. Because Microsoft has included the University of Southern California
software in this product, Microsoft is required to include the following text that

accompanied such software:

Copyright © 1996 by the University of Southern California
All rights reserved.

Permission to use, copy, modify, and distribute this software and
its documentation in source and binary forms for any purpose and
without fee is hereby granted, provided that both the above copyright

notice and this permission notice appear in all copies, and that any
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documentation, advertising materials, and other materials related

to such distribution and use acknowledge that the software was
developed in part by the University of Southern California, Information
Sciences Institute. The name of the University may not be used to
endorse or promote products derived from this software without

specific prior written permission.

THE UNIVERSITY OF SOUTHERN CALIFORNIA makes no
representations about the suitability of this software for any purpose.
THIS SOFTWARE IS PROVIDED "AS IS" AND WITHOUT ANY
EXPRESS OR IMPLIED WARRANTIES, INCLUDING, WITHOUT
LIMITATION, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE.

Other copyrights might apply to parts of this software and are so noted
when applicable.

Portions of this software are based in part on the work of James Kanze. Because
Microsoft has included the James Kanze software in this product, Microsoft is

required to include the following text that accompanied such software:

COPYRIGHT AND PERMISSION NOTICE
All rights reserved.

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, publish, distribute, and/or
sell copies of the Software, and to permit persons to whom the Software
is furnished to do so, provided that the above copyright notice(s) and
this permission notice appear in all copies of the Software and that
both the above copyright notice(s) and this permission notice appear
in supporting documentation. Permission is also given to modify

the software to any extend, under the condition that, in the modified
software, the prefix "GB_" is changed to something else, and the name

"

directories for includes files (g

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF
ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT OF THIRD
PARTY RIGHTS. IN NO EVENT SHALL THE COPYRIGHT HOLDER
OR HOLDERS INCLUDED IN THIS NOTICE BE LIABLE FOR ANY
CLAIM, OR ANY SPECIAL INDIRECT OR CONSEQUENTIAL
DAMAGES, OR ANY DAMAGES WHATSOEVER RESULTING FROM
LOSS OF USE, DATA OR PROFITS, WHETHER IN AN ACTION

OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS ACTION,

in this distribution) is also changed.
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ARISING OUT OF OR IN CONNECTION WITH THE USE OR
PERFORMANCE OF THIS SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall
not be used in advertising or otherwise to promote the sale, use or other
dealings in this Software without prior written authorization of the

copyright holder.

This product contains software from Cisco ISAKMP Services.

Portions of this software are based in part on the work of RSA Data Security,
Inc. Because Microsoft has included the RSA Data Security, Inc. software in this
product, Microsoft is required to include the following text that accompanied

such software:

Copyright © 1990, RSA Data Security, Inc. All rights reserved.

License to copy and use this software is granted provided that it

is identified as the "RSA Data Security, Inc. MD5 Message-Digest
Algorithm" in all material mentioning or referencing this software

or this function. License is also granted to make and use derivative
works provided that such works are identified as "derived from the
RSA Data Security, Inc. MD5 Message-Digest Algorithm" in all material

mentioning or referencing the derived work.

RSA Data Security, Inc. makes no representations concerning either the
merchantability of this software or the suitability of this software for
any particular purpose. It is provided "as is" without express or implied

warranty of any kind.

These notices must be retained in any copies of any part of this

documentation and/or software.

Portions of this software are based in part on the work of OpenVision
Technologies, Inc. Because Microsoft has included the OpenVision Technologies,
Inc. software in this product, Microsoft is required to include the following text

that accompanied such software:
Copyright 1993 by OpenVision Technologies, Inc.

Permission to use, copy, modify, distribute, and sell this software and
its documentation for any purpose is hereby granted without fee,
provided that the above copyright notice appears in all copies and
that both that copyright notice and this permission notice appear

in supporting documentation, and that the name of OpenVision

not be used in advertising or publicity pertaining to distribution of
the software without specific, written prior permission. OpenVision
makes no representations about the suitability of this software for any
purpose. It is provided "as is" without express or implied warranty.
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OPENVISION DISCLAIMS ALL WARRANTIES WITH REGARD

TO THIS SOFTWARE, INCLUDING ALL IMPLIED WARRANTIES

OF MERCHANTABILITY AND FITNESS, IN NO EVENT SHALL
OPENVISION BE LIABLE FOR ANY SPECIAL, INDIRECT OR
CONSEQUENTIAL DAMAGES OR ANY DAMAGES WHATSOEVER
RESULTING FROM LOSS OF USE, DATA OR PROFITS, WHETHER IN
AN ACTION OF CONTRACT, NEGLIGENCE OR OTHER TORTIOUS
ACTION, ARISING OUT OF OR IN CONNECTION WITH THE USE
OR PERFORMANCE OF THIS SOFTWARE.

Portions of this software are based in part on the work of Regents of The
University of Michigan. Because Microsoft has included the Regents of The
University of Michigan software in this product, Microsoft is required to include

the following text that accompanied such software:

Copyright © 1995, 1996 Regents of The University of Michigan.
All Rights Reserved.

Permission to use, copy, modify, and distribute this software and its
documentation for any purpose and without fee is hereby granted,
provided that the above copyright notice appears in all copies and

that both that copyright notice and this permission notice appear

in supporting documentation, and that the name of The University

of Michigan not be used in advertising or publicity pertaining to
distribution of the software without specific, written prior permission.
This software is supplied as is without expressed or implied warranties

of any kind.

Copyright © 1993, 1994 Regents of the University of Michigan.
All rights reserved.

Redistribution and use in source and binary forms are permitted
provided that this notice is preserved and that due credit is given to the
University of Michigan at Ann Arbor. The name of the University may
not be used to endorse or promote products derived from this software
without specific prior written permission. This software is provided “as

is" without express or implied warranty:.

Portions of this software are based in part on the work of Massachusetts Institute
of Technology. Because Microsoft has included the Massachusetts Institute
of Technology software in this product, Microsoft is required to include the

following text that accompanied such software:

Copyright 1989, 1990 by the Massachusetts Institute of Technology. All
Rights Reserved.

Export of this software from the United States of America may

require a specific license from the United States Government. It is the
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responsibility of any person or organization contemplating export to

obtain such a license before exporting.

WITHIN THAT CONSTRAINT, permission to use, copy, modify,

and distribute this software and its documentation for any purpose

and without fee is hereby granted, provided that the above copyright
notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation, and that the
name of MLLT. not be used in advertising or publicity pertaining to
distribution of the software without specific, written prior permission.
M.IT. makes no representations about the suitability of this software for

any purpose. It is provided "as is" without express or implied warranty.

Under U.S. law, this software may not be exported outside the US
without license from the U.S. Commerce department.

Copyright 1994 by the Massachusetts Institute of Technology. All Rights
Reserved.

Export of this software from the United States of America may
require a specific license from the United States Government. It is the
responsibility of any person or organization contemplating export to

obtain such a license before exporting.

WITHIN THAT CONSTRAINT, permission to use, copy, modify,

and distribute this software and its documentation for any purpose

and without fee is hereby granted, provided that the above copyright
notice appear in all copies and that both that copyright notice and this
permission notice appear in supporting documentation, and that the
name of MLLT. not be used in advertising or publicity pertaining to
distribution of the software without specific, written prior permission.
M.IT. makes no representations about the suitability of this software for
any purpose. It is provided "as is" without express or implied warranty.

This product includes software developed by the University of California,
Berkeley and its contributors.

Portions of this software are based in part on the work of the "Entrust" security
technology licensed from Northern Telecom.

Portions of this software are based in part on the work of Hewlett-Packard
Company. Because Microsoft has included the Hewlett-Packard Company
software in this product, Microsoft is required to include the following text that

accompanied such software:

Copyright © 1994 Hewlett-Packard Company

Permission to use, copy, modify, distribute and sell this software and its

documentation for any purpose is hereby granted without fee, provided
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that the above copyright notice appear in all copies and that both that
copyright notice and this permission notice appear in supporting
documentation. Hewlett-Packard Company and Microsoft Corporation
make no representations about the suitability of this software for any

purpose. It is provided "as is" without express or implied warranty.
This product includes software from the 'libpng' PNG reference library.

Portions of this software are based in part on the work of Autodesk, Inc. Because
Microsoft has included the Autodesk, Inc. software in this product, Microsoft is
required to include the following text that accompanied such software:

© Copyright 1995 by Autodesk, Inc.

This product contains graphics filter software; this software is based in part on
the work of the Independent JPEG Group.

This product includes “True Verb” technology from KS Waves Ltd.

Portions of this software are based in part on the work of SGS-Thomson
Microelectronics, Inc. Because Microsoft has included the SGS-Thomson
Microelectronics, Inc. software in this product, Microsoft is required to include

the following text that accompanied such software:

Copyright 1996 SGS-Thomson Microelectronics, Inc. All Rights
Reserved

Portions of this software are based in part on the work of Unicode, Inc. Because
Microsoft has included the Unicode, Inc. software in this product, Microsoft is
required to include the following text that accompanied such software:

COPYRIGHT AND PERMISSION NOTICE

Copyright © 19912005 Unicode, Inc. All rights reserved. Distributed

under the Terms of Use in www.unicode.org/copyright.html.

Permission is hereby granted, free of charge, to any person obtaining a
copy of the Unicode data files and any associated documentation (the
"Data Files") or Unicode software and any associated documentation
(the "Software") to deal in the Data Files or Software without restriction,
including without limitation the rights to use, copy, modify, merge,
publish, distribute, and/or sell copies of the Data Files or Software, and
to permit persons to whom the Data Files or Software are furnished

to do so, provided that (a) the above copyright notice(s) and this
permission notice appear with all copies of the Data Files or Software,
(b) both the above copyright notice(s) and this permission notice
appear in associated documentation, and © there is clear notice in each
modified Data File or in the Software as well as in the documentation

associated with the Data File(s) or Software that the data or software
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has been modified.

THE DATA FILES AND SOFTWARE ARE PROVIDED "AS IS",
WITHOUT WARRANTY OF ANY KIND, EXPRESS OR IMPLIED,
INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND
NONINFRINGEMENT OF THIRD PARTY RIGHTS. IN NO EVENT
SHALL THE COPYRIGHT HOLDER OR HOLDERS INCLUDED IN
THIS NOTICE BE LIABLE FOR ANY CLAIM, OR ANY SPECIAL
INDIRECT OR CONSEQUENTIAL DAMAGES, OR ANY DAMAGES
WHATSOEVER RESULTING FROM LOSS OF USE, DATA OR PROFITS,
WHETHER IN AN ACTION OF CONTRACT, NEGLIGENCE OR
OTHER TORTIOUS ACTION, ARISING OUT OF OR IN CONNECTION
WITH THE USE OR PERFORMANCE OF THE DATA FILES OR
SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall
not be used in advertising or otherwise to promote the sale, use or
other dealings in these Data Files or Software without prior written
authorization of the copyright holder.

The Combined PostScript Driver was the result of a cooperative development

process by Adobe Systems Incorporated and Microsoft Corporation.

Portions of this software are based in part on the work of Media Cybernetics.
Because Microsoft has included the Media Cybernetics software in this product,
Microsoft is required to include the following text that accompanied such
software:

HALO Image File Format Library © 1991-1992 Media Cybernetics, Inc.

Portions of this software are based in part on the work of Luigi Rizzo. Because
Microsoft has included the Luigi Rizzo software in this product, Microsoft is

required to include the following text that accompanied such software:
© 1997-98 Luigi Rizzo (luigi@iet.unipi.it)

Portions derived from code by Phil Karn (karn@ka9q.ampr.org),
Robert Morelos-Zaragoza (robert@spectra.eng.hawaii.edu) and Hari
Thirumoorthy (harit@spectra.eng.hawaii.edu), Aug 1995

Redistribution and use in source and binary forms, with or without
modification, are permitted provided that the following conditions are
met:

1. Redistributions of source code must retain the above copyright notice,
this list of conditions and the following disclaimer.

2. Redistributions in binary form must reproduce the above copyright
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notice, this list of conditions and the following disclaimer in the
documentation and/or other materials provided with the distribution.

THIS SOFTWARE IS PROVIDED BY THE AUTHORS “AS IS" AND
ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY
AND FITNESS FOR A PARTICULAR PURPOSE ARE DISCLAIMED.
IN NO EVENT SHALL THE AUTHORS BE LIABLE FOR ANY

DIRECT, INDIRECT, INCIDENTAL, SPECIAL, EXEMPLARY, OR
CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER

IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE
USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY
OF SUCH DAMAGE.

Portions of this software are based in part on the work of W3C. Because
Microsoft has included the W3C software in this product, Microsoft is required

to include the following text that accompanied such software:

W3C ® SOFTWARE NOTICE AND LICENSE
www.w3.org/Consortium/Legal/2002/copyright-software-20021231

This work (and included software, documentation such as READMEs,
or other related items) is being provided by the copyright holders
under the following license. By obtaining, using and/or copying this
work, you (the licensee) agree that you have read, understood, and will
comply with the following terms and conditions.

Permission to copy, modity, and distribute this software and its
documentation, with or without modification, for any purpose and
without fee or royalty is hereby granted, provided that you include the
following on ALL copies of the software and documentation or portions
thereof, including modifications:

1. The full text of this NOTICE in a location viewable to users of the
redistributed or derivative work.

2. Any pre-existing intellectual property disclaimers, notices, or terms
and conditions. If none exist, the W3C Software Short Notice should be
included (hypertext is preferred, text is permitted) within the body of
any redistributed or derivative code.

3. Notice of any changes or modifications to the files, including the date
changes were made. (We recommend you provide URLSs to the location
from which the code is derived.)
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THIS SOFTWARE AND DOCUMENTATION IS PROVIDED "AS IS,"
AND COPYRIGHT HOLDERS MAKE NO REPRESENTATIONS OR
WARRANTIES, EXPRESS OR IMPLIED, INCLUDING BUT NOT
LIMITED TO, WARRANTIES OF MERCHANTABILITY OR FITNESS
FOR ANY PARTICULAR PURPOSE OR THAT THE USE OF THE
SOFTWARE OR DOCUMENTATION WILL NOT INFRINGE ANY
THIRD PARTY PATENTS, COPYRIGHTS, TRADEMARKS OR OTHER
RIGHTS.

COPYRIGHT HOLDERS WILL NOT BE LIABLE FOR ANY DIRECT,
INDIRECT, SPECIAL OR CONSEQUENTIAL DAMAGES ARISING
OUT OF ANY USE OF THE SOFTWARE OR DOCUMENTATION.

The name and trademarks of copyright holders may NOT be used in
advertising or publicity pertaining to the software without specific,
written prior permission. Title to copyright in this software and any
associated documentation will at all times remain with copyright
holders.

Portions of this software are based in part on the work of Sun Microsystems,
Inc. Because Microsoft has included the Sun Microsystems, Inc. software in this
product, Microsoft is required to include the following text that accompanied

such software:

Sun RPC is a product of Sun Microsystems, Inc. and is provided for
unrestricted use provided that this legend is included on all tape media
and as a part of the software program in whole or part. Users may copy
or modify Sun RPC without charge, but are not authorized to license

or distribute it to anyone else except as part of a product or program
developed by the user.

SUN RPC IS PROVIDED AS IS WITH NO WARRANTIES OF

ANY KIND INCLUDING THE WARRANTIES OF DESIGN,
MERCHANTIBILITY AND FITNESS FOR A PARTICULAR PURPOSE,
OR ARISING FROM A COURSE OF DEALING, USAGE OR TRADE
PRACTICE.

Sun RPC is provided with no support and without any obligation
on the part of Sun Microsystems, Inc. to assist in its use, correction,
modification or enhancement.

SUN MICROSYSTEMS, INC. SHALL HAVE NO LIABILITY WITH
RESPECT TO THE INFRINGEMENT OF COPYRIGHTS, TRADE
SECRETS OR ANY PATENTS BY SUN RPC OR ANY PART THEREOF.

In no event will Sun Microsystems, Inc. be liable for any lost revenue or

profits or other special, indirect and consequential damages, even if Sun
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has been advised of the possibility of such damages.

Sun Microsystems, Inc.
2550 Garcia Avenue
Mountain View, California 94043

Manufactured under license from Dolby Laboratories. “Dolby” and the double-D
symbol are trademarks of Dolby Laboratories. Confidential unpublished works.
Copyright 1992-1997 Dolby Laboratories. All rights reserved.

Portions of this software are based in part on the work of Andrei Alexandrescu.
Because Microsoft has included the Andrei Alexandrescu software in this
product, Microsoft is required to include the following text that accompanied
such software:

The Loki Library

Copyright © 2001 by Andrei Alexandrescu

This code accompanies the book:

Alexandrescu, Andrei. "Modern C++ Design: Generic Programming and
Design Patterns Applied." Copyright © 2001. Addison-Wesley.
Permission to use, copy, modify, distribute and sell this software for
any purpose is hereby granted without fee, provided that the above
copyright notice appear in all copies and that both that copyright notice
and this permission notice appear in supporting documentation.

The author or Addison-Welsey Longman make no representations
about the suitability of this software for any purpose. It is provided "as
is" without express or implied warranty.

Portions Copyright © 1995 by Jeffrey Richter

Portions of this software are based in part on the work of the Distributed
Management Task Force, Inc. (DMTF). Because Microsoft has included software
based on DMTF specifications in this product, Microsoft is required to include
the following text:

Copyright © 2007 Distributed Management Task Force, Inc. (DMTF). All
rights reserved.

Portions of this work are derived from "The Draft Standard C++ Library”"
Copyright © 1995 by PJ. Plauger published by Prentice-Hall and are used with
permission.

Portions of this software are based in part on the work of Hewlett-Packard
Company. Because Microsoft has included the Hewlett-Packard Company
software in this product, Microsoft is required to include the following text that
accompanied such software:

Copyright © 2002, 2003 Hewlett-Packard Company.
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About Notice:
This software is based on software available from mpvtools.

sourceforge.net.

This software processes a format called MPV. MPV is an open
specification for managing collections and multimedia playlists of
photo, video, and music content and associated metadata and is
available at no cost from the Optical Storage Technology Association.
More information about the MPV specification can be found at www.
osta.org/mpv.

Permission Notice:

Permission is hereby granted, free of charge, to any person obtaining
a copy of this software and associated documentation files (the
"Software"), to deal in the Software without restriction, including
without limitation the rights to use, copy, modify, merge, publish,
distribute, sublicense, and/or sell copies of the Software, and to permit
persons to whom the Software is furnished to do so, subject to the

following conditions:

The above copyright notice, this permission notice, and the above
About Notice shall be included in all copies or substantial portions of
the Software.

THE SOFTWARE IS PROVIDED "AS IS", WITHOUT WARRANTY OF
ANY KIND, EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED
TO THE WARRANTIES OF MERCHANTABILITY, FITNESS FOR A
PARTICULAR PURPOSE AND NONINFRINGEMENT. IN NO EVENT
SHALL THE AUTHORS OR COPYRIGHT HOLDERS BE LIABLE FOR
ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN
ACTION OF CONTRACT, TORT OR OTHERWISE, ARISING FROM,
OUT OF OR IN CONNECTION WITH THE SOFTWARE OR THE USE
OR OTHER DEALINGS IN THE SOFTWARE.

Except as contained in this notice, the name of a copyright holder shall
not be used in advertising or otherwise to promote the sale, use or other
dealings in this Software without prior written authorization of the
copyright holder.

All other trademarks are property of their respective owners.
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Overview

32

Overview

T2 is multi-channel video disk recorder that allows simultaneous video
recording and playing and has 1 input and 2 output channels. Video and
audio data are saved in the built-in data drive.

T2 has pre-installed software that performs recording/editing/playing of
video and creating or playing of playlists. The following two operation
modes are available depending on the environment.

> Front panel mode

You can operate this mode by tapping the display on the touch screen LCD
on the T2 front panel. The operation is available under minimum network
environment.

The basic operations can be performed only on the front panel mode.

> Workstation mode

You can connect and use a PC monitor, mouse, and keyboard to T2 in this
mode.

All functions are available in this mode.

Notes on record of external device and growing clip editing»P240

The operating instructions on this manual describe procedures in the front
panel mode.

For the changed specifications from T2 Classic or T2 BASIC/T2 RAID/T2
SSD, and the added and changed functions by the service pack, see our
web site.
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About this manual

About this manual

The indications and the meanings are as follows.

Section 4 — Connection/Start-up/Exit

Connecting peripheral devices
The procedure to connect peripheral devices such as external input/output
device to T2 is described in this part.
1 Connect a device for R1 channel input to T2.
Connect a device to the analog audio input/output section or R1 input
section on T2 rear panel.

Analog audio input/output section»p. 38
R1 input section»p. 38

(1 ) TIP * YPbPr signal is input via the analog RGB pins on the DVI-I port. To
input YPbPr signal, use an analog RGB conversion connector cable.

2 Connect a device for P1/P2 channel output to T2.

Connect a device to the analog audio input/output section or P1/P2 output
section on T2 rear panel.

(2) Analog audio input/output section»p. 38

P1/P2 output section»p. 39

Supported video format and output terminal»p. 205

TIP * YPbPr signal is input via analog RGB pins on the DVII port. To
output YPbPr signal, use an analog RGB conversion connector cable.

3 If you wish to operate T2 in the workstation mode, connect a
mouse, keyboard, and PC monitor (optional) to T2.

Connect the mouse and keyboard to the USB (2.0) port, and connect the

PC monitor to the monitor port.

Rear panel»p. 37

If you wish to operate T2 in the front panel mode, you do not need to

connect a mouse, keyboard, and PC monitor.

4 Insert the power cable to the inlet of T2.

51f necessary, fix the power cable fixing clamp using the provided

(3) NOTE  * When fixing the power cable fixing clamp, be careful not to
loosen the fixing screw of the fan on the power unit.

46 T2 User Manual August 3, 2012

*The illustration on this page is only for explanation purpose. It differs
from the actual page on this manual.

(1) | TiP Describes important points for operations.

(2) | Reference page Indicates related pages.

(3) | NOTE Describes cautions and restrictions for
operations.
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Section

Part Names and Functions

Front panel

(1) (2)
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(3) (4) (5) (6) (7)
(1) | SSD drive bay Works as an SSD drive bay.
(2) | Touch screen LCD Operates T2 by tapping the display on the
screen.
(3) | Power switch Turns on T2.
(4) | USB (2.0) ports Used to connect USB removable devices.
(5) | Volume control Used to adjust the headphone volume.

Used to connect a headphone.
Audio level detail display (R1
(6) | Headphone jack channel)»P139

Audio level detail display (P1/P2
channel)»P150

Performs channel selection or playing back
(7) | Control buttons and recording of video.

Control buttons» P35

34 T2 Elite/Pro/Express Users Guide October 6, 2014



Control buttons

(1) —

(2)—

()— P2

@—T_ _ T

Front panel

) () (6) (7) (8)

™

[R1] button

Switches to 1ch view of the R1 channel. Makes
the R1 channel active.

()

[P1] button

Switches to the 1ch view of P1 channel. Makes
the P1 channel active.

@)

[P2] button

Switches to the 1ch view of P2 channel. Makes
the P2 channel active.

(4)

[Rew] button

By every press, moves back frame by frame.
Holding on the button will rewind by 32 times
speed.

)

[Play] button

Starts playback.

(6)

[FF] button

By every press, moves forward frame by frame.
Holding on the button will fast-forward by 32
times speed.

(7)

[Stop] button

Stops playback or recording.

(8)

[Rec] button

Starts recording.

(9)

[SHTL/JOG]
hutton

Switches to the jog/shuttle mode.
Playing back in jog/shuttle mode» P101

(10)

[VAR] button

Switches to the variable speed mode.
Displays the speed controller and allows to
change the playback speed.

Playing back in variable speed mode (variable
playback)» P100

(1)

Jog/Shuttle

When the [SHTL/JOG] button is on, executes jog/
shuttle playback operations.

When the [VAR] button is on, executes variable
speed playback.

October 6, 2014
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Section 3 — Part Names and

Functions

[Rew] + [Stop] buttons

While playing a clip, moves to the previous
In/Out point or to the top of the clip.

While playing a playlist, moves to the
previous event.

[FF]

+ [Stop] buttons

While playing a clip, moves to the next In/
Out point or to the end of the clip.

While playing a playlist, moves to the next
event.

Rear panel

' @ IE) ) (CHRD BV }7\-‘?)3:7\ i 5
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®) (9 (10 (1) (12) (13) (14)  (1%)

AC Power inlet (3-

Used to connect to the AC power outlet

M pin) with the supplied power cable.
(2) | Main power switch Turns on/off the main power.
3) Analog audio input/ | Used for analog audio input/output.
output section Analog audio input/output section» P37
(4) | LAN port Used to connect a LAN cable.
. . Used for input to the R1 channel.
5) | R1
) nput section R1 input section» P38
. Used for output from the P1 channel.
6) | P1 output sect
©) oufput secfion P1/P2 output section» P38
. Used for output from the P2 channel.
7) | P2 output section
(7) uipd : P1/P2 output section» P38
(8) | Monitor (VGA) port Used to connect a PC monitor.
(9) | Monitor (DVI-I) port | Used to connect a PC monitor.

(10)

USB (2.0) port

Used to connect a keyboard, mouse, and so
on.

36

T2 Elite/Pro/Express Users Guide

October 6, 2014



Rear panel

(11) | Sound Not used.
(12) | REFIN Used to input REF signal.
(13) | GP11/0 Used for GPI input/output.
(14) | REMOTE R$422 port Used for remote control of R1, P1, P2
channels.
(15) | MONITOR Used for audio monitor.
NOTE e In the workstation mode, you cannot use T2 with the monitor

ports (VGA/DVI-I) connected simultaneously. (Exclusive use
only)

¢ Be sure to turn off your T2 when removing and inserting the
cable for the monitor ports.

Analog audio input/output section

(1) ) @)

@ T Va

—A%)

~y

ANALOG AUDIO J

Used for audio input to the R1 channel.

(1) :1 : g:; (Balanced audio input.)
XLR-3-31 x 2 (CH1 - 2)
Used for audio output to the P1 channel.
(Balanced audio output.)
P1-CH1
(2) P1 - CH2 XLR-3-32 x 2 (CH1 - 2)
Audio level detail display (P1/P2
channel) »P150
Used for audio output to the P2 channel.
(Balanced audio output.)
(3) P2 - CHI XLR-3-32 x 2 (CH1 - 2)
P2 - CH2

Audio level detail display (P1/P2
channel) »P150

October 6, 2014
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R1 input section

INPUT | CLTC ) (AESIEBU) (AESIEBU) (CMPST)
HD/SD
R1 | rRecornEr
@ ZP@Z‘;@Z‘;

" @ @

r====1

(1) | LTC Used for LTC (timecode) input.

(2) | AES/EBU Used for digital audio (AES/EBU) input.

(3) | CMPST Used for composite input.

(4) | DVI-I Used for DVI-I input. (Also for DVI and YPbPr.)

5) | SDI Used for SDI input (left), and for active
through (right).

TIP ® YPbPr signal is input via the analog RGB pins on the DVI-I
port. To input YPbPr signal, use an analog RGB conversion
connector cable.

P1/P2 output section

( ) (AESIEBU) _cwswr
QUTPUT

P1| oo < ))
PLAYER
( |
AESI[E[EUJ
QUTPUT

ks

mn @ ©

CMPST

(1) | LTC Used for LTC (timecode) output.
Used for digital audio (AES/EBU) output.

(2) | AES/EBU Audio level detail display (P1/P2
channel)»P150

(3) | CMPST Used for composite output.

@) | DVI-I Used for DVI-I output. (Also for DVI, RGB,
and YPbPr.)

(5) | SDI Used for SDI output.

(6) | MONITOR Used for monitor output (composite).

TIP * YPbPr signal is output via the analog RGB pins on the DVI-I
port. To output YPbPr signal, use an analog RGB conversion
connector cable.

38 T2 Elite/Pro/Express Users Guide October 6, 2014



Section

Connection/Start-up/Exit

This section describes how to connect peripheral devices to T2, start-up
and exit procedures, and switching procedures of front panel mode and
workstation mode.

Connecting peripheral devices

October 6, 2014

The procedure to connect peripheral devices such as external input/output
device to T2 is described in this part.

1 Connect a device for R1 channel input to T2.

Connect a device to the analog audio input/output section or R1 input
section on T2 rear panel.

Analog audio input/output section» P37

R1 input section» P38

TIP * YPbPr signal is input via the analog RGB pins on the DVI-I port. To
input YPbPr signal, use an analog RGB conversion connector cable.

2 Connect a device for P1/P2 channel output to T2.

Connect a device to the analog audio input/output section or P1/P2 output
section on T2 rear panel.

Analog audio input/output section» P37

P1/P2 output section» P38

Supported video format and output port» P239

TIP * YPbPr signal is output via analog RGB pins on the DVI-I port. To
output YPbPr signal, use an analog RGB conversion connector cable.

3 If you wish to operate T2 in the workstation mode, connect a
mouse, keyboard, and PC monitor to T2.

Connect the mouse and keyboard to the USB (2.0) port, and connect the PC
monitor to the monitor port.

Rear panel» P36

If you wish to operate T2 in the front panel mode, you do not need to
connect a mouse, keyboard, and PC monitor.
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Section 4 — Connection/Start-up/Exit

TIP * A mouse, keyboard, and PC monitor are not included in the product
package.

4 Tnsert the power cable to the inlet of T2.

S If necessary, fix the power cable fixing clamp using the provided screws.
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,’;'(K" Qj‘ 9
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e )

NOTE ° When fixing the power cable fixing clamp, be careful not to
loosen the fixing screw of the fan on the power unit.

6 Connect the power cable to the AC power outlet.
Starting up and exiting T2

Starting up T2

1 Turn on the main power switch on the T2 rear panel.
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Starting up and exiting T2

When starting up for the first time, T2 will start up in the front panel mode.
The display appears in the 3ch view on the touch screen LCD.

Other than the first time, T2 will start up in the previously used operation
mode (front panel mode or workstation mode).

TIP e To start up T2 in the workstation mode, start up T2 in the front
panel mode, and then switch to the workstation mode.
Switching from the front panel mode to the workstation
mode» P42

Exiting T2 in the front panel mode

NOTE ° Do not forcibly exit T2 by holding down the power switch or
turning off the main power switch on the T2 rear panel. A
malfunction may occur.

1 Press one of the [R1], [P1], or [P2] button.

You can also perform the operation by tapping [Ich View] on the touch
screen LCD or [Bin].

2 Tap [Menu], and then tap [Tools] -> [Exit].

3ch
View

Config.

Fixed
Length
g Transfer

Format:
1920x1080 REIl‘\ail\il‘\g:
59.94i =J28:03

Grass Valley HQ

SDI E

TC(INT)

3 Select [Shut Down] from the list and tap [OK].

To restart T2, select [Restart].
If you do not use T2 for a long time, turn off the main power switch on the
T2 rear panel and unplug the power cord.

Exiting T2 in workstation mode

NOTE ° Do not forcibly exit T2 by holding down the power switch or
turning off the main power switch on the T2 rear panel. A
malfunction may occur.
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Section 4 — Connection/Start-up/Exit

1 Click [System] on the menu bar, and click [Exit].

2 Select [Shut Down] from the list and click [OK].

To restart T2, select [Restart].
If you do not use T2 for a long time, turn off the main power switch on the
T2 rear panel and unplug the power cord.

Switching front panel mode/workstation mode

Switching from the front panel mode to the workstation
mode

1 On the PC monitor, click [System] on the menu bar, and click
[Switch to Workstation mode].

Switching from the workstation mode to the front panel
mode

1 Tap the touch screen LCD.

You can also switch the mode on the PC monitor, by clicking [System] on
the menu bar, and then clicking [Switch to Front Panel mode].
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Checking the software version

Checking the software version

October 6, 2014

You can check the software version of your T2.

1 Press one of the [R1], [P1], or [P2] button.

You can also perform the operation by tapping [Ich View] on the touch
screen LCD or [Bin].

2 Tap [Menu] on the touch screen LCD, and tap [Tools] -> [About
T2].

The version information of T2 is displayed.

3ch
View

Config.

Fixed
Length
£ngt Transfer

Format:
1920x1080

59.94i
Grass Valley HQ
SDI
TO(NT)
2:24 PM
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Recording

Section

This section describes the recording procedure in the R1 channel.

Displaying R1 channel in 1ch view

In the 1ch view of the R1 channel, various operations for recording are

available.

1 Press the [R1] button.

The display switches to the Ich view of the R1 channel, and the [R1] button

lights in green.

You can also switch by tapping [1ch View] and then tapping the R1 channel

tab.

You can use the operation buttons on the lower part of the touch screen
LCD, to start and end of recording.

> R1 channel - 1ch view

(1 @E) @4 5)6)(7)

(11) (12)(13) (14)

1ch
View

3ch
View

Config.

Fixed
L th
220 Transfer

Format:
1920x1080

TC(INT)

(16) (17)(18) (19)

(1) | R1 channel tab

By tapping, selects and highlights the R1
channel.

(2) | Status

Indicates the recording progress status.
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Displaying R1 channel in 1ch view

Locks R1 channel operations.

While the operations are locked, [Locked]
and [R1] buttons light in red.

Tapping it again releases the lock.

(3) | [Locked]

Displays the video currently inputted.

(4) | Preview Tapping the preview displays in the full
screen view.

(5) | [Cur:] Indicates the current timecode inputted.

(6) | Scrubbing bar Indicates the recording progress status.

Indicates the elapsed time of recording by

(7) | [Elap:] timecode display.

(8) | Audio level display Displays input audio level.

Displays menu such as properties of clip
(9) | [Menu] and rename, unload, set the clip name for
next ingest file, etc.

Switches the recording mode (R1-live mode

(10) | Recording mode /R1-VTR mode/R1-remote mode).

(11) | Operation buttons Operation buttons of R1 channel» P46

Displays the name of the clip currently
recorded.

(12) | [Clip:]

Sets the saving destination of the recorded
clip.

(13) | [Saving destination] | The destination bin name is displayed in
the right. If the saving destination is an
external storage, it changes to green.

If [Fixed Length] is on, sets the time length
(14) | [Length:] (duration) from the start point to the end
point of recording by tapping the timecode.

Indicates the timecode of In/Out points and
duration.

(15) | [In:1/[Out:]1/[Dur:] If fixed length recording mode is off, you
can set In or Out point by tapping the
timecode of [In:] or [Out:].
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Section 5 — Recording

In the R1-live mode, automatically starts
recording operation at a specified time,
and ends it at a specified time. In the front
panel mode, allows to switch on/off of
schedule and to display the schedule list.
To add, edit, or delete schedules, use the
workstation mode.

R1-live mode / schedule mode» P129

(16) | [Schedule]

Displays the video size, frame rate, input
(17) | [Format:] settings, port used for input, source TC (TC
(LTC)/SDI (VITC)/INT), etc.

By tapping to set it on, automatically ends
(18) | [Fixed Length] recording after the duration specified in
[Length:] has passed.

1ch view/3ch view/
(19) | bin/transfer screen
common area

1ch view/3ch view/bin/transfer screen
common aread» P47

> Operation buttons of R1 channel
Mm @ © @ ©6 ©

lf”] Q" q p +D ckap

(1) | [Clear (In/Qut)] Clears set In/Out points.
(2) | [Cue(In)]™" Moves the VIR to the In point.
(3) | [Mark(In)] Sets In point to the current position.
(4) | [Mark(Out)] Sets Out point to the current position.
(5) | [Cue(Out)]™" Moves the VIR to the Out point.
Creates a sub clip between In-Out points
(6) | [Create Subclip]™ set while recording, and saves it as
highlight.

*1  Only for R1-VTR mode.
*2 Only for R1-live mode. However, if the video being recorded is saved
to an external media/storage, a sub clip cannot be created.

46 T2 Elite/Pro/Express Users Guide October 6, 2014



Displaying R1 channel in 1ch view

> 1ch view/3ch view/bin/transfer screen common area

Display the bin view.

(1) | [Bin] Managing contents in the bin»P78

Switches the currently selected channel to

(2) | [1ch View] 1ch view.

(3) | [3ch View] Switches to 3ch view.

Displays the setting screen.

4 ig.
(4) | [Config.] Displaying the setting screen»P177

Display the transfer screen.

(5) | [Transfer] Checking the transfer status» P62

Displays the estimated recording time
Remaining HDD available on HDD.

(remaining time) When the remaining capacity reduces, the
icon is displayed in red.

(6)

Displayed when a removable drive such as
USB removable media, XDCAM, P2, GF, etc.
(7) | [Remove Device] is connected.

By tapping, disconnects the removable
media.

Displays the current time.

(8) | Time Date and time setting dialog box» P192

NOTE «Ifthe icon appears in 1ch view/3ch view/bin/transfer
screen common area, there is a problem with the RAID
system. Consult the shop of purchase.
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Selecting R1 channel in 3ch view

In 3ch view, you can view three channels, the video recorded in the R1
channel and the clip or playlist played in the P1/P2 channel simultaneously.
In 3ch view of the R1 channel, you can use the operation buttons on the
lower part of the touch screen LCD, to start and end of recording.

1 Tap [3ch View].

The display switches to 3ch view.
2 Tap the R1 channel tab.

e 1ch
. 00:00:00;00 View

3ch
View

Config.

: Clip_05

. 00:06:43;07

; 00:00:06;13 Transfer

: 1920%1080i5994_100— Remaining:
13:se
. 00:00:49;02 «
; 00:01:01;09

4:59 PM

R1 channel is selected and highlighted.

> R1 channel - 3ch view

(1 @2)E) 4)

®® @) ®)

Clip:

Cu: T - - 3
Elap: 00:00:00;00

By tapping, selects and highlights the R1

(1) | R1 channel tab channel.
(2) | Status Indicates the recording progress status.
Locks R1 channel operations.
While the operations are locked, [Locked] and
(3) | [Locked] [R1] buttons light in red.
Tapping it again releases the lock.
(4) | Preview Displays the video currently inputted.
Audio level . : :
(5) display Displays input audio level.
(6) | [Clip:] Indicates the name of the clip.
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Recording by VIR control (R1-VIR mode)

(7) | [Cur:] Indicates the current timecode inputted.

Indicates the elapsed time of recording by

(8) | [Elap:] timecode display.

Recording by VTR control (R1-VTR mode)

October 6, 2014

The procedure to control VIR from your T2 and perform recording is
described in this part.

Set the connection information of the VIR used for recording or the video
format for capturing beforehand.

General — Hardware settings»P178

R1 settings»P193

Transfer — common settings» P205

If necessary, make settings in the setting screen according to the environment
in use.

Settings»P177

TIP e In the workstation mode, you can import the batch capture list
to your T2 and record sources at once.
Recording sources at once (batch capturing) »P165
® The VIR can be controlled by using your T2 as a controller and
via AMP command or BVW command.
Controlling an external device from T2 with AMP/BVW (R1-VTR
mode) »P225
AMP command list»>P242
BVW command list»P256

1 Press the [R1] button.

R1 channel is displayed in 1ch view. The video from the external input
device is displayed in the preview.
R1 channel - 1ch view» P44

2 Tap [VTR].

The mode switches to the R1-VTR mode.

3 Tap [Saving destination], select the saving destination of the clip
to record, and then tap [OK].

4 Play back the video to record and tap [Mark(In)] and [Mark(Out)]
to specify the recording range (In/Out points).

Playing back video» P99
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Section 5 — Recording

TIP ¢ You can also specify the timecode by tapping the entry area of
[In:] and [Out:].
* You can also specify the time lapse from the start point of
recording (duration) to automatically end the recording. Tap
[Fixed Length], tap the entry area of [Length:], and enter the
timecode.
R1 channel - 1ch view» P44

5 Press the [Rec] button.

The recording starts at the specified In point. The recording automatically
ends at the specified Out point.

You can set the clip name by tapping the entry area of [Clip:] while recording.
To end the recording in the middle, press the [Stop] button.

After the recording ends, the recorded clip is saved in the bin selected in
step 3.

TIP ¢ The video currently recorded in the R1 channel can be loaded

and played on the P1/P2 channel.
Loading and playing back video currently recorded (chasing
playback)»P101

¢ The video currently recorded in the R1 channel can be output
from the P1/P2 channel with active through.
Outputting currently recorded video with active through (E to E
mode)» P102

¢ To check the properties of the clip currently recorded, tap
[Menu] and then tap [Properties] on the 1ch view of the R1
channel.

¢ To change the name of the clip currently recorded, tap [Menu]
and then tap [Rename] on the 1ch view of the R1 channel.

¢ To unload the video after recording, tap [Menu] and then tap
[Unload] on the 1ch view of the R1 channel.

¢ To set the clip name for next ingest file, tap [Menu] and then
tap [Set the clip name for next ingest file...] on the 1ch view of
the R1 channel. If the name of the clip to be recorded next has
been set in the R1 channel, the clip name setting for the next
recorded clip is prioritized.
Setting of ingesting dialog box» P<?>
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Recording live video (R1-live mode)

Recording live video (R1-live mode)

The procedure to record live video from an external device is described in
this part.

Set the connection information of the external device used for recording or
the video format for capturing beforehand.

General — Hardware settings»P178

R1 settings» P193

Transfer — common settings» P205

Ifnecessary, make settings in the setting screen according to the environment
in use.

Settings»P177

You can also set to automatically start recording operation at a specified
time and end it at a specified time. (Only available in the workstation mode.)
R1-live mode / schedule mode» P129

TIP * The name of the clip to be recorded can be specified. You can
set the naming rule and specify the name of the clip to be
recorded in the next.

R1 channel - 1ch view» P44
Setting of ingesting dialog box»P137

® You can also record video from a device that cannot allow deck
control in the same procedure. Find the start point of the video
for recording beforehand.

1 Press the [R1] button.

R1 channel is displayed in 1ch view. The video from the external input
device is displayed in the preview.
R1 channel - 1ch view» P44

2 Tap [Livel].
The mode switches to the R1-live mode.

3 Tap [Saving destination], select the saving destination of the clip
to record, and then tap [OK].
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4 1f necessary, play the video from the external device and press
the [Rec] button on T2.

The recording starts.
You can set the clip name by tapping the entry area of [Clip:] while recording.

TIP ¢ An important part in the recorded video can be saved in
another clip as highlight. Tap [Mark(In)] and [Mark(Out)], and
then tap [Create Subclip]. However, if the video being recorded
is saved to an external storage, a sub clip cannot be created.

* You can also specify the time lapse from the start point of
recording (duration) to automatically end the recording. Tap
[Fixed Length], tap the entry area of [Length:], and enter the
timecode.

¢ The video currently recorded in the R1 channel can be loaded
and played on the P1/P2 channel.

Loading and playing back video currently recorded (chasing
playback)» P101

¢ The video currently recorded in the R1 channel can be output
from the P1/P2 channel with active through.

Outputting currently recorded video with active through (E to E
mode)»P102

¢ To check the properties of the clip currently recorded, tap
[Menu] and then tap [Properties] on the 1ch view of the R1
channel.

¢ To change the name of the clip currently recorded, tap [Menu]
and then tap [Rename] on the 1ch view of the R1 channel.

5 After recording the necessary video, press the [Stop] button on T2.

After stopping recording, the recorded clip is saved in the bin selected in
step 3.

TIP ¢ To unload the video after recording, tap [Menu] and then tap

[Unload] on the 1ch view of the R1 channel.
¢ To set the clip name for next ingest file, tap [Menu] and then

tap [Set the clip name for next ingest file...] on the 1ch view of
the R1 channel. If the name of the clip to be recorded next has
been set in the R1 channel, the clip name setting for the next
recorded clip is prioritized.
Setting of ingesting dialog box» P137
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Import/Export

This section describes the procedure to import a media file from a removable
media or network drive and to export contents edited in your T2.

Importing a media file

October 6, 2014

Displaying the [Browse] tab

Import of media files from a removable media such as USB removable
device, XDCAM, P2, GF, and from a network drive to your T2 is performed
from the [Browse] tab.

1 Tap [Bin].
The bin view appears.

2 Tap the [Browse] tab.

> [Browse] tab

SP1. >P2 mem

ich
View

[ Removable Media 9 0801 _Clip_25 3ch
e View

[ XDCAM

3 xDCcAMEX

£ P2

2 GF

Config.

Transfer

5:16PM

(8) 9) (10) (11)

(1) | [Preview] Switches on/off of the preview (filmstrip).

Switches between [Bin] tab/[Browse] tab/

(2) | View switching tab [Recycle Bin] tab.
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@)

[New connection]

When a removable media is connected to
T2, you can select a folder to display in the
[Browse] tab.

(4)

[Import]

Imports the selected media file to T2 as a
clip.

©)

[>P1]

Loads the selected media file to the P1
channel.

You can play and check the video without
importing to T2 as a clip. However,

the playback speed depends on the
specifications of the connected removable
media.

(6)

[>P2]

Loads the selected media file to the P2
channel.

You can play and check the video without
importing to T2 as a clip. However,

the playback speed depends on the
specifications of the connected removable
media.

(7)

[Menu]

Displays the related menu.

(8)

Removable media
list

Displays the media or folders in the
removable media connected to T2.

The selected folder is highlighted in blue.

(9)

Filmstrip display

By tapping [Preview] and set it on, displays
the contents in the media file in filmstrip
with six frames.

(10)

Media file list

Displays the list of media files in the drive
selected from the removable media list.
The selected media file is highlighted in
blue.

(11)

1ch view/3ch view/
hin/transfer screen
common area

1ch view/3ch view/bin/transfer screen
common area» P47
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Importing a media file

Displaying media file in removable media

Media files in a removable media such as USB removable device, XDCAM,

P2, GF, etc. can be displayed without importing to T2.

NOTE ° When using XDCAM, XDCAM EX, or P2 device, install the
driver in the maintenance mode before connecting the device
to T2. For more information about the maintenance mode,
refer to the T2 Maintenance Manual.

Operation-ensured driver versions for XDCAM/XDCAM EX» P235
Operation-ensured driver version for P2»P235

TIP ¢ If you make settings of the network drive in the workstation
mode, you can display media files in the network drive from

the [Browse] tab.
BVW list supporting remote mode» P257

1 Connect a removable media to your T2 and insert medium.

2 Tap [Import].

A new removable device(F:\) has been detected.

Export Cancel

The screen switches to the [Browse] tab.

3 Tap [New connection] and select a medium type.

Bin Browse

Removable Media

XDCAM
[ Removable Med|
XDCAM EX

[ XDCAM

[ XDCAMEX

Mp2 G
M 6F

P2

4 Select a drive, and then tap [OK].
Media file list including media files appears.

TIP ¢ To update information in the removable media, tap [Menul],
and then tap [Refresh].
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Playing media file in removahle media

You can load media files in a removable media to T2 and play them.

NOTE - The system is under heavy load during playback of clips in
removable media. It is recommended that you import the file
to your T2 and play it.

1 Select a drive in the [Browse] tab and display the media file.
Displaying media file in removable media» P55
2 Select a media file and tap [>P1] or [>P2].

While another clip is loaded, a confirmation message appears. Tap [Yes] to
unload the clip.
The media file is loaded to the P1 channel or P2 channel.

TIP * You can also load the file to the selected channel by tapping
the media file two times.

3 Press the [Play] button.

Playing back video» P99
TIP ¢ The following operation are available on the media files loaded
to the P1/P2 channel.

- Playback operation using the T2 front panel control buttons
- Setting of In and Out points and moving to In or Out point

NOTE e Depending on the specifications of the connected removable
media, playback operation may not catch up.
¢ The following operations are not available on the media files
loaded to the P1/P2 channel.
- Import of video between set In-Out points
- Gain adjustment of audio level
- Tag editing (workstation mode only)
- Sync playback (pairing)
- Adding to playlist
- Creating sub clips
If you add files to playlist, create sub clips or create still clip,
import the media file before you perform the operation.
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Checking the properties of media file

The procedure for checking the properties of media file is described in this
part.

1 Select a drive in the [Browse] tab and display the media file.
Displaying media file in removable media» P55

2 Select a media file, tap [Menu], and then tap [Properties].
The properties of media file is displayed.

> Properties of media file

ClipInfo = MediaInfo = Timecode

Clip: 1080i_Clip_25
Bin: Fih

Container: AVIFile
Video format: Grass Valley HQ 1440x1080 59.94i
Audio format: PCM Wave audio 48kHz 2ch 16bit

InTC: 00:05:26;18
Qut TC: 00:05:32;01
Duration: 00:00:05;13

Reference: o

Displays the clip information.

You can check the clip name, format, In/Out
points timecode, length, alpha channel presence,
[Clip Info] tab date of creation, etc.

Tapping the entry area allows to change the clip
name.

Checking [Locked] locks the clip from editing.

The information of media file is displayed.

You can check the file path, number of clips and
[Media Info] tab pla.yhsts' linked to the media file, size, In/Out
points timecode, etc.

Tapping [Details...] allows to check the details of

the clips linked to the media file.

Specifies starting timecode.
To use the starting timecode of a media file, select

[Timecode] tab [Source].

To specity a starting timecode, select [Specify
Start Time], tap the entry area, and enter
timecode.

3 Tap [OK].
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Changing media file list display

You can switch the display of the media file list between icon display and
text display.

1 Tap [Menu], and then tap [View].

2 Tap [Icon View] or [Text View].

Importing a media file

The procedure for importing media file to T2 is described in this part.

At the time of import, you can set whether to import the file in the native
format or in a converted format such as Grass Valley HQ AVI. The import
operation will be easier if the format for the imported file and other setting
items have been set beforehand.

Transfer settings»P205

If necessary, make settings in the setting screen according to the environment

in use.

Settings»P177

TIP e For more information about the file formats that can be
imported, see “Appendix”.
Input format»P236

e For XDCAM, XDCAM EX, P2, and GF sources, all files under
the root folder and all folders in the root folder will be copied.
As for files in each folder, only the files that are related to the
selected file for the import will be copied.

* You can convert a file to Grass Valley HQ AVI after importing
it as the native format.

Converting contents to other formats» P84

¢ Still image files are converted to Grass Valley HQ AVI and
imported.

* The maximum file size of the still image that can be imported
is 4,096 x 2,304 pixels (4K).

¢ The system will import files that contain transparency
information after converting them to Grass Valley HQ AVI. In
this case, the conversion is performed so that the bitrate will
be lower (the Q value = 12).

1 Select a drive in the [Browse] tab and display the media file.

Displaying media file in removable media» P55
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2 Select a media file, tap [Import], and then tap [Import...].

The Import dialog box appears.

TIP

* Dragging on the media file selects multiple media files..

> Import dialog box

"m @ ©

Name Format

1080i_Clip_25 AVI(Grass Valley HQ)

(4)

®)

(6)

(7) 8) ()

(1) | (Delete] l?eletes the selected file from the import
list.
(2) | [UP] Moves up the selected file.
(3) | [DOWN] Moves down the selected file.
. Displays the setting screen. Sets the file
(4) | [Config.] format after imported.
Displays the list of the files to be imported.
(5) | Import list [Format] shows the formats of files to be
imported.
(6) | [Bin:] Displays the saving destination bin for the
) imported media files.
(7) [Select Import Selects the saving destination bin for the
Destination Bin] imported media files.
(8) | [Start] Starts import.
(9) | [Cancel] Closes the import dialog box.

3 Tap [Config.].

If conversion of the format of the file to import is not necessary, you do not
need to change the settings in the setting screen. Proceed to step 6.
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4 Tap the tab of the format of the media file.

General
@ P:

R1 Clip import configurati
Field order wh mporting

P1

P2

Confiaure imnort of imaae and imaaes in A seauence formar

Default... (0] 4 Cancel

For example, if the media file to import is XDCAM format, tap the [XDCAM]
tab. If it is an MXF single file, tap the [MXF] tab.

5 From the [File format after import:] list, select a post-import
format and then tap [OK].

6 In the import dialog box, tap [Select Import Destination Bin],
select a bin, and tap [OK].

7 Tap [Start].

Import starts. You can check the progress in the transfer screen.
Checking the transfer status» P62

NOTE e By default, the system will pause any transfer and conversion
during a recording or playback. If you want transfer and
conversion to be performed even during a recording or
playback, change the setting by [Transfer] -> [Common] on
the setting screen. Unchecking [Pause file transfers while
recording or playing out.] enables transfer and conversion
even during a recording or playback. However, if this option
is unchecked, the recording/playback operations may not be
performed normally, therefore, we recommend that you use
the system with this option checked.

Transfer — common settings» P205
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Importing still images with serial numbers as a
sequence clip

Still images with serial numbers can be imported as a single sequence clip
(in Grass Valley HQ AVI).
If necessary, make settings in the setting screen according to the environment

in use.

Settings»P177

NOTE e If a file has a name that has characters followed by numerics,
such as Clip1234.jpg, it will be recognized as a still image file
with a sequential number.

¢ If some of the files have different extensions, or if files with

added alpha channel and those without alpha are mixed,
the import of the still images with serial numbers will be
canceled.

TIP * The maximum file size of the still image that can be imported
is 4,096 x 2,304 pixels (4K).

1 Select a drive in the [Browse] tab and display the media file.

Displaying media file in removable media» P55

2 Select the first file in the serial numbers, tap [Import], and then
tap [Import (Sequence)...].

The Import dialog box appears.
Import dialog box» P59

3 Tap [Config.].

4 In [Configure import of image and images in a sequence format],
select a post-import format and then tap [OK].

P
Common | AVCHD AVI

General t here. =

Default... (0] 4 Cancel
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62

5 In the import dialog box, tap [Select Import Destination Bin],
select a bin, and tap [OK].

6 Tap [Start].

Import starts. You can check the progress in the transfer screen.
Checking the transfer status» P62

NOTE e By default, the system will pause any transfer and conversion
during a recording or playback. If you want transfer and
conversion to be performed even during a recording or
playback, change the setting by [Transfer] > [Common] on
the setting screen. Unchecking [Pause file transfers while
recording or playing out.] enables transfer and conversion
even during a recording or playback. However, if this option
is unchecked, the recording/playback operations may not be
performed normally, therefore, we recommend that you use
the system with this option checked.

Transfer — common settings» P205

Checking the transfer status

You can check the status of file transfer or conversion (jobs) in the transfer
screen.

1 Tap [Transfer].

> Transfer screen
1) 2 @ @

Delete Clear

a
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Displays the list of jobs.
[Clip]

Indicates the name of the clip.

[Status]
(1) | Job list Indicates the job progress status.

[Bin]

Indicates the bin name.

[Path]

Indicates media file path and file name.

Deletes selected jobs. If you tap [Delete]

(2) | [Delete] while executing a job, the job will be
canceled.
(3) | [Clear] Deletes all jobs from the job list.

1ch view/3ch view/
(4) | bin/transfer screen
common area

1ch view/3ch view/bin/transfer screen
common area» P47

Removing medium in removable media

The procedures to remove a medium in the removable media connected
to your T2 (such as XDCAM professional disc, SxS memory card, and P2
card), and to disconnect the folder in the USB removable device or GFPAK
are described in this part.

1 Select a drive in the [Browse] tab.

2 Tap [Menu], and then tap [Disconnect].
3 A message appears. Tap [OK].

4 Remove the medium (XDCAM professional disc, SxS memory
card, or P2 card) from the removable media.

If you want to disconnect your T2 from the removable media, disconnect
the removable media.
Removing removable media» P64
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Removing removable media

The procedure to remove a removable media such as USB removable device,
XDCAM, P2, GF, etc. from T2 is described in this part.

Before removing the removable media you need to disconnect the medium
or file in the media.

Removing medium in removable media» P63

1 Tap [Remove Device].

You can operate it from the bin view, 1ch view, 3ch view, and transfer screen.

Preview [:a >P1 >P2 Menu Bin

ich
View

Bin Browse Recycle Bin
3 Removable Media - ; 5 3ch
Oy View
[ xpcam
[ XDCAMEX
£ p2

[mics
4

Config.

Transfer

5:26 PM

2 Select a removable media, and then tap [Remove].
3 A message appears. Tap [Yes].

4 Remove the removable media from T2.

TIP ¢ If the media indicates a status that it is being used and you
cannot remove it even after tapping [Remove], turn off the T2
and remove the removable media.

Importing a media file on WatchFolder

A specified folder can be monitored as a WatchFolder (shared folder),
and when a media file is placed on the WatchFolder, importing starts
automatically. Folders not only in the internal storage but also in an external
media/storage can be monitored as a WatchFolder.

The import operation will be easier if the format for the imported file and
other setting items have been set beforehand.

Transfer settings» P205

If necessary, make settingsin the setting screen according to the environment
in use.

Settings»P177
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1 Tap [General], and then tap the [Share Folder] tab in the setting
screen.

General — Share Folder settings»P185

2 Selecta imported bin from list of [Destination].

3 Specify the folder to be monitored as a WatchFolder.

To specify a folder in the internal storage as a WatchFolder, check [Set folder
in local storage as watch folder]. A folder named “WatchFolder” will be
created and shared as a WatchFolder.

To specify a folder in an external media or storage as a WatchFolder, check
[Set external folder in external media / storage as watch folder.] and specify
a folder.

Transfer

GPI

4 Tap [OK].
The WatchFolder will be enabled.
5 Access the WatchFolder from another PC.

To access a WatchFolder in the internal storage, IP address setting and user
account are required. To set an IP address, follow steps 1 to 8 in “Uploading
files to T2/downloading files from T2”.

Transferring a file to other T2»P70

General — Share Folder settings»P185

6 Copy a media file that you wish to import to the WatchFolder.

After copying of the media files has completed, import starts.
Media files copied to the WatchFolder will be deleted after the import
operation.
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NOTE e If you copy files that cannot be imported to the WatchFolder in
the internal storage, the files that cannot be imported will be
deleted.

¢ If you copy files that cannot be imported to the WatchFolder in
the external storage, the files that cannot be imported will not
be deleted.

¢ If the media indicates a status that it is being used and you
cannot remove it even after tapping [Remove], turn off the T2
and remove the removable media.

¢ If writing does not catch up with importing, recording will
stop.

Exporting a file

Exporting contents to a file

The procedure to export a clip or playlist stored in the bin of your T2 to a
file is described in this part.

At the time of export, you can set whether to export the file in the native
format or in a converted format.

The export operation will be easier if the format for the exported file and
other setting items have been set beforehand.

Transfer settings»P205

If necessary, make settings in the setting screen according to the environment
in use.

Notes on record of external device and growing clip editing»P240

NOTE e For XDCAM, XDCAM EX, P2, and GF sources, all files under
the root folder and all folders in the root folder will be copied.
As for files in each folder, only the files that are related to the
selected file for the import will be copied. If a clip imported as
its native format is exported with no conversion, the exported
clip may not be properly handled depending on the device.
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TIP ¢ For more information about the file formats that can be

exported, see “Appendix”.
Output format»P238

¢ For important notes on exporting, see “Appendix”.
Notes on export and growing clip editing»P239

* When exporting to a Grass Valley HQ AVI file, the file is
trimmed between the set In and Out points and exported. For
other formats, the whole file is exported.

* You can export Grass Valley HQ AVI files by converting them
to the following formats.

- MXF format (XDCAM HD422) (1920 x 1080
59.94i/50i/29.97p/25p 50 Mbps)

- MXF format (XDCAM HD) (1440 x 1080
59.94i/50i/29.97p/25p/23.98p 25 Mbps)

- MXF format (XDCAM IMX) (720 x 486 59.94i, 720 x 576 50i)

- MXF format (XDCAM DV) (720 x 486 59.94i, 720 x 576 50i)

* When exporting a playlist to a file, the file is converted with
the following features.

- If several formats are contained, they are converted in one
file.

- A timecode set in a playlist or event properties can be
retained in each frame of the converted file.

- When exporting files in Grass Valley HQ AVI format, the
profile (size and frame rate) of the converted file is same as
the profile of the playlist.

- When exporting files in MXF format (XDCAM)), files are
converted according to the settings of [Advanced AVI
transcoding settings] in [Transfer] -> [AVI] on the setting
screen.

- The audio gain set for the event in the playlist is maintained
in the converted clip.

- Audio is converted into PCM 48kHz 24bit 8ch.

* You cannot export a playlist that includes a place holder event.

1 Display the contents in the [Bin] tab.
Displaying the [Bin] tab» P78

2 Select an item, tap [Export], and then tap [Export Media Files...].

A message related to export appears. Read the message, and then tap [OK].
The Export dialog box appears.
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> Export dialog box
m @ @ 4)

ormat

avi(Grass Valley HQ)

Cancel

®) (6) 7) 8 ()

(1) | [Deletel Deletes the selected file from the export list.
(2) | [UP] Moves up the selected file.
(3) | [DOWN] Moves down the selected file.

Displays the setting screen. Sets the file
format and others after exported.

(4) | [Config.]

Displays the list of the files to be exported.

(5) | Export list [Format] shows the formats of files to be
exported.

Displays the saving destination of the files

(6) | [Export Path:] to be exported.

[Select Export Selects the saving destination of the files to
(7)

Folder] be exported.
(8) | [Start] Starts export.
(9) | [Cancel] Closes the export dialog box.

TIP ¢ If you export to XDCAM drive (PDW-U1, PDW-U2), you tap
[Export], and then tap [Export Media Files to XDCAM Drive..].

3 If necessary, tap [Config.] to set the file format after conversion.

¢ If conversion is not necessary, you do not need to change the settings
in the setting screen. Proceed to step 4.

* To export a Grass Valley HQ AVl file to be converted to MXF (XDCAM
format), tap [AVI] and check [Execute transcoding when exporting AVI
file.]. Make settings in [Advanced AVI transcoding settings], and tap [OK].
Transfer — AVI settings» P210
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* To export a playlist, tap the [Playlist] tab. From the [File format after
export:] list, select a post-import format and then tap [OK].
Transfer — Playlist settings»P217

4 In the export dialog box, tap [Select Export Folder], select a
folder, and tap [OK].

5 Tap [Start].

Export starts. You can check the progress in the transfer screen.
Checking the transfer status» P62

NOTE e By default, the system will pause any transfer and conversion
during a recording or playback. If you want transfer and
conversion to be performed even during a recording or
playback, change the setting by [Transfer] -> [Common] on
the setting screen. Unchecking [Pause file transfers while
recording or playing out.] enables transfer and conversion
even during a recording or playback. However, if this option
is unchecked, the recording/playback operations may not be
performed normally, therefore, we recommend that you use
the system with this option checked.

Transfer — common settings» P205

Exporting contents in T2 format

If you export playlists or clips in the T2 format (TWF file), you can import
them to other T2 with the information (In/Out points, effect, event list,
ancillary data, etc.) retained.

TIP ¢ For important notes on exporting, see “Appendix”.

Notes on export and growing clip editing» P239

* TWF file is a file in the ZIP format. If you change the extension
of the TWF file to “*.zip” and extract it with software for ZIP,
you can extract it as a media file.

* You can send/receive playlists and clips directly from T2 to
other T2 via FTP.
Transferring a file to other T2»P70

1 Display the contents in the [Bin] tab.
Displaying the [Bin] tab» P78
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2 Select an item, tap [Export], and then tap [Export in T2 Format
(TWE Files)...].

A message related to export to other T2 appears. Read the message, and
then tap [OK].

The Export dialog box appears.

Export dialog box» P68

3 In the export dialog box, tap [Select Export Folder], select a
folder, and tap [OK].
4 Tap [Start].

Export starts. You can check the progress in the transfer screen.
Checking the transfer status» P62

Transferring a file to other T2

Overview of file transfer function from T2 to T2

You can transfer media files from T2 to other T2 via FIP. If you export
media files from source T2 to the FTP server of target T2, you can use the
files from the [Bin] tab on target T2 without import operations.

Registering the FTP server connection settings

Register the FTP server connection setting of the transfer target T2 on the
transfer source T2.

TIP * Set target T2 to be used as the FTP server beforehand. Perform
steps 1 to 8 in “Uploading files to T2/downloading files from
T2” on target T2.
Uploading files to T2/downloading files from T2» P72 72

1 Tap [Config.].

You can operate it from the bin view, 1ch view, 3ch view, and transfer
screen.

2 Tap [General], and then tap the [FTP] tab.

3 Tap[Add..].

The FTP destination setting dialog box appears.
FTP destination setting dialog box»P184
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4 Configure the FTP server settings of T2 (destination), and then
tap [OK].

In the export dialog box, you can tap [Select Export Folder] to select the FTP
server of T2 (destination).

Exporting a file from T2 to T2

Configure the FTP server settings of T2 (destination) before you perform
export operation.

Registering the FTP server connection settings» P70 70

The export operation will be easier if the format for the exported file and
other setting items have been set beforehand.

Transfer settings» P205

Make settings in the setting screen according to the environment in use.
Settings»P177

TIP e For more information about the file formats that can be
exported, see “Appendix”.
Output format»P238
¢ For important notes on exporting, see “Appendix”.
Notes on export and growing clip editing»P239

1 Display the contents in the [Bin] tab.
Displaying the [Bin] tab» P78

2 Select an item and tap [Export], and then tap [Export Media
Files...] or [Export in T2 Format (TWF Files)...].

NOTE e Playlists or clips composed of multiple files cannot be exported
as the original formats. Export them in the T2 format.

A message related to export or a message related to export to other T2
appears. Read the message, and then tap [OK].

The Export dialog box appears.

Export dialog box» P68

3 If necessary, tap [Config.] to set the file format after conversion.

¢ [f conversion is not necessary, you do not need to change the settings
in the setting screen. Proceed to step 4.

¢ To export a Grass Valley HQ AVI file to be converted to MXF (XDCAM
format), tap [AVI] and check [Execute transcoding when exporting AVI
file.]. Make settings in [Advanced AVI transcoding settings], and tap
[OK].
Transfer — AVI settings» P210
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* To export a playlist, tap the [Playlist] tab. From the [File format after
export:] list, select a post-convert format and then tap [OK].
Transfer — Playlist settings»P217

4 1In the export dialog box, tap [Select Export Folder].

5 Tap [FTP Server], select the FTP server of T2 (destination), and
then tap [OK].

6 Tap [Start].

Export starts. You can check the progress in the transfer screen.
Checking the transfer status» P62

Uploading files to T2/downloading files from T2

You can use FTP server to connect devices or edit terminals to your T2 and
upload/download files.

NOTE e For the following format files, only single files can be
uploaded/downloaded.
- XDCAM: MXF single file of XDCAM format only
- XDCAM EX: Single file of XDCAM EX format only (*mp4,
*.avi)

- GF: MXEF single file of GF format only

® When uploading files to T2 via FTF, if [File format after
import] is set to [AVI(HQ)] for the transfer setting of each
format, the files will be converted to Grass Valley HQ AVI after
uploaded.
Transfer settings» P205

¢ If you want to use Japanese for file names, you must set
the character set of file names to UTF-8 on the FTIP client
side beforehand. Correct file names cannot be displayed if
the character sets do not match. The configuration method
depends on your software. Refer to the help etc.

1 Tap [Config.].

You can operate it from the bin view, 1ch view, 3ch view, and transfer
screen.

2 Tap [General], and then tap the [Network-1] tab or [Network-2]
tab.

3 Configure the IP address and DNS server address.
General — Network-1/Network-2 settings»P179
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Uploading files to T2/downloading files from T2

4 Tap the [FTP] tab.

5 Tap [Settings...].

—_— e

Hardware | Network-1 | Network-2 |Network-3 | FTP | Share Folder | Misc.

FTP Server

] rectory)
sert -

() Limit the FTP transfer ording or playing

Transfer

The dialog box for FTP setting of T2 appears.
FTP setting dialog box for T2»P184

6 Configure the FTP server settings of T2, and then tap [OK].

7 Tap [Start].

Hardware | Network-1 | Network-2 | Network-3 FIP | Share Folder | Misc.

FTP Server

R1

P1

0e Jefa
P2
Transfer
L v =cord or playing.

(# Limit the FTP transf

8 Tap [OK].

9 Access your T2 from a client.

Enter the IP address you configured in [Network-1] or [Network-2] and the
user name and password you configured in the dialog box for FTP setting
of T2, and connect to your T2 via FTP.

10 Upload or download file.

NOTE ° When using the FTP client where disconnection cannot be
made explicitly such as Windows Explore, connection may
be terminated due to the restriction of the simultaneous
connection of clients. In such a case, tap [General] -> the [FTP]
tab on the setup screen, and tap [Stop], and then tap [Start]
again.

[FTP] tab»P182
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NOTE

* Depending on the FTP client, files may be transferred with
multiple connections simultaneously. When using such an FTP
client, make sure that the simultaneous connection of clients
does not exceed the [Max Clients:] value set in the FTP setting
dialog box of T2.

FTP setting dialog box for T2»P184

¢ By default, the system will pause any transfer and conversion
during a recording or playback. If you want transfer and
conversion to be performed even during a recording or
playback, change the setting by [Transfer] -> [Common] on
the setting screen. Unchecking [Pause file transfers while
recording or playing out.] enables transfer and conversion
even during a recording or playback. However, if this option
is unchecked, the recording/playback operations may not be
performed normally, therefore, we recommend that you use
the system with this option checked.

Transfer — common settings» P205

Loading and editing T2 contents to editing software

You can load T2 contents to Grass Valley EDIUS, Adobe Premiere Pro, Apple
Final Cut Pro and Avid Technology Media Composer to edit the data.

NOTE

¢ If you want to use Japanese for file names, you must set
the character set of file names to UTF-8 on the FTP client
side beforehand. Correct file names cannot be displayed if
the character sets do not match. The configuration method
depends on your software. Refer to the help etc.

¢ Grass Valley EDIUS is recommended for the editing software.

Downloading and loading a recorded clip

Clips in a bin can be converted to XDCAM format and the converted clips
can be downloaded from a client via FTP.
Notes on FTP download and growing clip editing»P240

1 Perform steps 1 to 8 in “Uploading files to T2/downloading files
from T2".

Uploading files to T2/downloading files from T2» P72 72

2 Display the contents in the [Bin] tab.
Displaying the [Bin] tab» P78
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Loading and editing T2 contents to editing software

3 Select an item, tap [Menu], and then tap [Convert] -> [Convert to
MXE(XDCAM)].

4 Tap [Yes].

The conversion starts. You can check the progress in the transfer screen.
Checking the transfer status» P62

The new converted clips will be saved in the same bin as their original
ones.

5 Download the converted clip(s) via FTP from a client PC.

6 Load the downloaded clips to the editing software on the client
PC.

Downloading and loading a growing clip

Clips can be ingested to XDCAM format and the growing clips can be
downloaded from a client via FTP.

Notes on export and growing clip editing»P239

Notes on record of external device and growing clip editing» P240

Notes on FTP download and growing clip editing» P240

1 Perform steps 1 to 8 in “Uploading files to T2/downloading files
from T2”.

Uploading files to T2/downloading files from T2» P72
2 Tap [config.].

3 Tap [R1] and set the compression codec to [XDCAM HD422
(MXEF)].

Input Settings | Timecode & Remote | Capture

General g IRk

P1

P2

Default... Cancel Apply
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4 Tap [Allow to edit growing MXF file] and checked.

Transfer

GPI

Default... OK Cancel Apply

5 Tap [OK].

6 A message appears. Tap [OK].
A clip being recorded will become available to download on FTP.

7 Start recording.
8 Download the clip being recorded via FTP from a client PC.

9 Load the downloaded clips to the editing software on the client
PC.

The clip being recorded can be viewed on K2 (FIP) in the EDIUS source
browser. For the setting procedure of the source browser, refer to the EDIUS
manual.

Directly loading a clip recorded or being recorded

T2 Elite accesses a direct access folder (a media folder in T2 Elite) from a
client and loads a clip recorded or being recorded.
NOTE e Only available for T2 Elite (SP 2.0 or later).
¢ Grass Valley EDIUS is recommended for the editing software.
* Only AVI (Grass Valley HQ) and MXF (XDCAM) format media
files can be accessed. The direct access folder is read-only.
* Moving and deleting of media files on the direct access folder
cannot be performed from a client. To import media files from
a client, use WatchFolder, FTP, etc.
Importing a media file on WatchFolder» P64
Uploading files to T2/downloading files from T2»P72
General — Share Folder settings» P185
¢ To load an MXF (XDCAM) clip that is being recorded, check
[Allow to edit growing MXF file] on [config.] > [R1] -> [Input
Settings] in the setting screen.
Downloading and loading a growing clip» P75
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1 Perform steps 1 to 3 in “Uploading files to T2/downloading files
from T2”.

Uploading files to T2/downloading files from T2» P72
2 Tap [config.] and then tap [Share Folder] tab.

3 Tap [Share a T2 media storage as share folder] in the direct access
folder to check it..

FTP | Share Folder = Misc.

O

P1
CIFS. Hlite model only.
P2

Transfer

Default... OK Cancel Apply

4 Tap [OK].
To enable the direct access folder setting, you must restart your T2.

5 Access T2 from a client PC and load a clip.

Access the address set as [Network-1] or [Network-2] from the client. The
media folders are located under the Share folder of T2, and include the
Default folder and a folder with the same name as the created bin.

NOTE ° A clip with which a sub clip has been created between In-Out
points is loaded as the original clip that does not have In-Out
points.

Creating a sub clip between In-Out points (highlight) »P108

¢ The user account used to access the direct access folder can be
set in [General] -> [Share Folder] in the setting screen.
General — Share Folder settings»P185
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Section

Contents Management

This section describes the operations for contents management using the

bin.
Managing contents in the bin

Displaying the [Bin] tab
In the [Bin] tab, you can manage the contents loaded to T2 and export
contents edited with T2.

1 Tap [Bin].
The bin view appears.

2 Tap the [Bin] tab.

> [Bin] tab
M@ @B @ G ® @ 6

Export >P1| >P2

[ Bin(1/5)

Thumbnail ame: -~

L]

311 ean

uy Clip_D4
12°8

Tl 1

S vaen

s,
L%+ )

(10) (1) (12) (13)

(1) | [Preview] Switches on/off of the preview (filmstrip).

Switches between [Bin] tab/[Browse] tab/

(2) | View switching tab [Recycle Bin] tab.
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Deletes all files in the recycle bin.

(3) | [Empty Recycle Bin] | Note that the deleted contents cannot be
restored.
(4) | [New Bin] Creates a new bin.
(5) | [Export] Exports the selected contents.
(6) | [Delete] Deletes the selected contents.
7) | >P1] Loads the selected contents to the P1
channel.
8) | [>P2] Loads the selected contents to the P2
channel.
(9) | [Menu] Displays the related menu.
(10) | Bin list Displays the list of bins.
The selected bin is highlighted in blue.
. - By tapping [Preview] and set it on, displays
(11) | Filmstrip display the contents in filmstrip with six frames.
Displays the list of contents selected in the
(12) | Contents list bin list.
The selected item is highlighted in blue.
(13) ;f: /:'rI::,s/fiihs::Z:'r{ 1ch view/3ch view/bin/transfer screen

common area

common aread P47

Changing bin name
You can change the name of the bin.
1 Select a bin in the [Bin] tab.

Displaying the [Bin] tab» P78

2 Tap [Menu], and then tap [Rename Folder].

3 Enter a name for the bin and tap [OK].
Software keyboard» P122

October 6, 2014
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Deleting a bin

You can delete a bin and the contents in the bin. The deleted bins are moved
to the recycle bin.

1 Select a bin in the [Bin] tab.
Displaying the [Bin] tab» P78
2 Tap [Menu], and then tap [Delete Folder].

A message appears and the list of contents in the bin is displayed.

3 Tap [Yes].

Contents types and icons

The icons that indicate the contents types and common icons, and icons
displayed regardless of the contents types are described in this section.

> Clip

> Still image clip

> Playlist

©)
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> Common icons

(1M (T)

(1) | Pairing Indicates that pairing is set.

Indicates that the contents is used in the

(2) | Used in playlist playlist.

(3) | Lock Indicates that the item is locked.

“1” indicates that another source can be
recorded in the R1 channel while the

Available numberof | i are played back.

(4) | times of recording

while playing 0” indicates that another source cannot

be recorded in the R1 channel while the
contents are played back.

“2” indicates that another contents can be
Available number played back simultaneously in the P1/P2

(5) of times of channel while the contents are played back.
simultaneous “1” indicates that another contents cannot
playing be played back simultaneously in the P1/P2

channel while the contents are played back.

(6) Containing alpha Indicates that the contents have
channel transparency information.

Indicates that the contents is being
(7) | Recording recorded. The sub clip of recording contents
is not shown this icon.
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Moving contents to another hin
You can move the contents in the bin to another bin.

1 Select the bin in the [Bin] tab and display the contents.
Displaying the [Bin] tab» P78

2 Select an item, tap [Menu], and then tap [Move].

3 Select the destination bin and tap [OK].

Changing the display of contents list

You can switch the display of the contents list between icon display and
text display.

1 Tap [Menu], and then tap [View].

2 Tap [Icon View] or [Text View].

Checking the properties of the contents

The procedure to check the properties of the clips or playlists in the bin is
described in this part.

1 Select the bin in the [Bin] tab and display the contents.
Displaying the [Bin] tab» P78
2 Select an item, tap [Menu], and then tap [Properties].

The properties of contents are displayed.

> Clip properties

ClipInfo = MediaInfo = Timecode

Clip_o4

Bin

AVIFile

Grass Valley HQ 14401080 59.94i
PCM Wave audio 48kHz 2ch 16bit
00:09:33;28

00:09:37;01

00:00:03;03

T2 Elite/Pro/Express Users Guide October 6, 2014



Managing contents in the bin

Displays the clip information.

You can check the clip name, format, In/Out
points timecode, length, alpha channel presence,
date of creation, etc.

Clip Info] tab
(Clip Info] Tapping the entry area allows to change the clip

name and audio gain. (For still images, the length
can be changed.)

Checking [Locked] locks the clip from editing.

The information of media file is displayed.

You can check the file path, clips referenced to
the media file, and the number of reference clips,
[Media Info] tab size, In/Out points timecode, etc.

Tapping [Details...] displays the list of clips
referenced to the media file and the number of
reference clips.

Specifies starting timecode.

To use the starting timecode of a media file, select
[Timecode] tab [Source]_' o _
To specify a starting timecode, select [Specify
Start Time], tap the entry area, and enter

timecode.

> Playlist properties

Playlist Info = Timecode = All Events

Playlist: Playlist

Bin: Bin

Duration: 00:00:14;06
Events: 3

Reference: (4]

Pairing:

Created: 6/25/2012 12:27:18 PM
Modified: 7/4/2012 10:41:24 AM
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Displays the playlist information.

You can check the playlist name, bin name

where the playlist is stored, format, length, alpha

channel presence, date of creation, etc.

[Playlist Info] tab Tapp%ng the entry area allows to change the
playlist name and audio gain.

Checking [Locked] locks the playlist from editing.

To change the playlist type, switch to the

workstation mode, and then change it.

Changing the playlist type»P169

Specifies starting timecode.

[Source]
Uses the starting timecode of the media file.

[Timecode] tah [Specﬂv Slarl Tlme]
Specifies a desired starting timecode. Tap the
entry area and enter a desired timecode.

[According to event setting]
Uses the timecode set in each event in the playlist.

Updates the settings of effect for event starting
(start effects) and actions or effects for event
ending (end effects) of all events in the playlist.

Updating playlist effect settings»P115

[All Events] tab

3 Tap [OK].

Releasing pairing of contents

You can release the pairing of contents.
For pairing of contents, refer to “Sync playback of contents (Sync mode)”.
Sync playback of contents (Sync mode)»P103

1 Select the bin in the [Bin] tab and display the contents.
Displaying the [Bin] tab» P78
2 Select an item, tap [Menu], and then tap [Unpairing].

Converting contents to other formats

You can convert contents to other formats.
A playlist can be converted to a single clip (media file).

NOTE e If a playlist is converted to a single clip, the effect set to the
playlist is disabled.
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TIP ¢ If you want to convert a Grass Valley HQ AVI file to an MXF
(XDCAM format) file, set the format details in the setting
screen beforehand.

Transfer — AVI settings» P210
¢ Playlists are converted with the following features.

- If several formats are contained, they are converted in one file.

- A timecode set in a playlist or event properties can be
retained in each frame of the converted file.

- When exporting files in Grass Valley HQ AVI format, the
profile (size and frame rate) of the converted file is same as
the profile of the playlist.

- When exporting files in MXF format (XDCAM)), files are
converted according to the settings of [Advanced AVI
transcoding settings] in [Transfer] -> [AVI] on the setting
screen.

- The audio gain set for the event in the playlist is maintained
in the converted clip.

- Audio is converted into PCM 48kHz 24bit 8ch.

* You cannot convert a playlist that includes a place holder
event.

1 Select the bin in the [Bin] tab and display the contents.

Displaying the [Bin] tab» P78

2 Select an item, tap [Menu], and then tap [Convert] -> [Convert to
(converted format)].

3 Tap [Yes].

The conversion starts. You can check the progress in the transfer screen.
The new converted clips will be saved in the same bin as their original

ones.
Checking the transfer status» P62
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NOTE

¢ By default, the system will pause any transfer and conversion
during a recording or playback. If you want transfer and
conversion to be performed even during a recording or
playback, change the setting by [Transfer] -> [Common] on
the setting screen. Unchecking [Pause file transfers while
recording or playing out.] enables transfer and conversion
even during a recording or playback. However, if this option
is unchecked, the recording/playback operations may not be
performed normally, therefore, we recommend that you use
the system with this option checked.
Transfer — common settings» P205

Checking the recycle bin

Displaying the [Recycle Bin] tab

In the [Recycle Bin] tab, you can restore the deleted contents and completely
delete the files in the recycle bin.

1 Tap [Bin].

The bin view appears.

2 Tap the [Recycle Bin] tab.

> [Recycle Bin] tab

(6)

(1@ @) @) )

Empty
cle gin| | Restore

Recy,

(7) (8) 9)

™

[Preview] Switches on/off of the preview (filmstrip).

(2)

Switches between [Bin] tab/[Browse] tab/

View switching tab [Recycle Bin] tab.
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Deletes all files in the recycle bin.

(3) | [Empty Recycle Bin] | Note that the deleted contents cannot be
restored.

Restores contents to the original bin.

(4) | [Restore] When re.storing a plfaylist, if clips lileed to
the playlist are also in the recycle bin, the
clips are restored at the same time.

(5) | [Menu] Displays the related menu.

(6) Recycle bin folder Displays the list of folders in the recycle

list bin.
. - By tapping [Preview] and set it on, displays

(7) | Filmstrip display the contents in filmstrip with six frames.

. Displays the list of contents in the folder

(8) | Contents list selected in the recycle bin folder list.

1ch view/3ch view/ : . .
9) | bin/transfer screen 1ch view/3ch view/hin/transfer screen

common area

common aread» P47

Backing up all data to other T2 (full sync backup)

October 6, 2014

Overview of full sync backup function

T2 data (media files and database) can be synchronized to other (multiple)
T2 on the network. T2 (slave) data on the sync destination is initialized and
they are completely synchronized to T2 (master) data.

To synchronize data, set the sync destination T2 (slave) to the slave mode
(step 1), and then set the sync source T2 (master) to the master mode. (step 2)

Step 1: Setting T2 on the sync destination (slave) to the
slave mode

NOTE

e Set the remote mode (R1-remote mode/P1-remote mode/P2-
remote mode) to off on both T2 (master and slave) beforehand.
(You cannot switch the remote mode to on and off while

transferring files.)

¢ Synchronization is not available between T2 devices that have
different database versions. Database version will be changed
by such an event as software update.
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1 On the sync destination T2, tap [Bin] or [1ch View].

2 Tap [Menu], and then tap [Tools] -> [T2 to T2 Sync backup...].

If contents are being captured or loaded in the R1/P1/P2 channel, a message
appears asking whether to unload the contents. Tap [OK] to unload the clip.

3 In [Operating mode] on the [T2 to T2 Sync backup] dialog box,
select [Slave mode] and tap [Close].

T2 on the sync destination (slave) is set to the slave mode.
To sync data to multiple T2 (slave), repeat steps 1 to 3 on all of the T2 (slave).

Step 2: Setting T2 on the sync source (master) to the
master mode for data sync

1 On the sync source T2, tap [Bin] or [1ch View].

2 Tap [Menu], and then tap [Tools] -> [T2 to T2 Sync backup...].

If contents are being captured or loaded in the R1/P1/P2 channel, a message
appears asking whether to unload the contents. Tap [OK] to unload the clip.

3 In [Operating mode] on the [T2 to T2 Sync backup] dialog box,
select [Master mode] and tap [Slave configuration...].

T2 on the sync source (master) is set to the master mode.
The number of T2 set to the slave mode is displayed in [Slave count:].

4 1n the [Slave configuration...] dialog box, set the IP address of T2
set to the slave mode.

e Tap [Auto Search...] to search for T2 set to the slave mode on the
network. Select an IP address on the [Search Results] dialog box, and
then tap [Add ALL].

¢ To set an IP address manually, tap [Add] and enter an IP address.

5 Tap [Close].

6 1In the [T2 to T2 Sync backup] dialog box, tap [Start Sync].
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7 A message appears. Tap [OK].

The synchronization starts. You can check the file transfer status on the
upper progress bar, and the whole status on the lower progress bar.

If you stop synchronization in the middle, tap [Stop]. You can also stop
synchronization from T2 set to the slave mode.

TIP e If data synchronization has been stopped forcibly by such an

event as the power off of T2, contents may be displayed with
the following thumbnail. Such contents cannot be used.

¢ If synchronization has been stopped and started again, files
that are already transferred will be skipped.
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Playing/Editing

This section describes operations to play contents in the P1/P2 channel and
to edit playlists.

Displaying P1/P2 channel in 1ch view

In the 1ch view of the P1/P2 channel, you can perform operations regarding
contents editing.

1 Press the [P1] button (or [P2] button).

The display switches to the 1ch view of the P1 channel (or P2 channel) and
the [P1] button (or [P2] button) lights in green.

You can also switch by tapping [1ch View] and then tapping the P1 channel
tab (or P2 channel tab).

If the clip is loaded to the P1 channel (or P2 channel), clip view is displayed.
And if a playlist is loaded, playlist view is displayed.

You can use the operation buttons and jog/shuttle on the lower part of the
touch screen LCD, to play or to switch playback modes.

» P1/P2 channel (clip view) — 1ch view
(1)(2) (3)4) (5) (6) (7)(8)(9) (10) (1) (12)(13)

s (Cur: 00:09:33;18 b 50.

] )

7 Q" q p "p c*::

it

Format:
In: 00:09:33;18  ;440x1080

2 @) ({ctip: ciip o4 E
59.99
Qut: 00:09:37;01

[Dm-: 00:00:03;13

(14) (15) (16) (17) (18)
*(2) to (18) are common in P2 channel.
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™

P1 channel tah/P2
channel tab

By tapping, selects and highlights the P1
channel (or P2 channel).

()

Playback mode

Indicates the current playback mode (sync
mode, E to E mode, loop playback mode)
of the P1 channel (or P2 channel) in white
characters.

By tapping, also switches the playback
mode.

Switching playback mode» P102

©)

Status

Indicates the playback progress status.

(4)

[Locked]

Locks P1 channel (or P2 channel)
operations.

While the operations are locked, [Locked]
and [P1] (or [P2] button) buttons light in red.

Tapping it again releases the lock.

(5)

Preview

Displays the video currently played back.
Tapping the preview displays in the full
screen view.

If a clip is not loaded, displays the output
profile of the channel on the upper left.

(6)

[Cur:]

Indicates the current timecode.

(7)

Playback speed

Indicates the current playback speed
(times).

(8)

Scrubbing bar

Indicates the playback progress status and
markers of set In/Out points.

9)

[Rem:]

Indicates the timecode of the remaining
time.

(10)

[Zoom]

Switches the display scale of the scrubbing
bar.

Tapping it displays [Zoom] in red, and
displays the In-Out points of the clip as the
whole scale.

Tapping it again returns the display to the
original scale and displays the whole clip.

(11)

Audio level display

Displays output audio level.

(12)

[Menu]

Displays the related menu.

(13)

[Playlist View]

Switches to the playlist view.
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Operation buttons of P1/P2 channel (clip

(14) | Operation buttons view)» P92

Indicates the name of the loaded clip.

Tapping the entry area allows to change the
clip name.

Software keyboard» P122

(15) | [Clip:]

Indicates the timecode of In/Out points and
duration.

(16) | [In:1/[0ut:]/[Dur:] Tapping the entry area allows to set the In
and Out points or duration.

Software keypad — Timecode» P123

Indicates the video size of the clip and

(17) | [Format:] frame rate.

1ch view/3ch view/
(18) | bin/transfer screen
common area

1ch view/3ch view/hin/transfer screen
common area» P47

> Operation buttons of P1/P2 channel (clip view)
M @ @G @ ©6 © M
3 ¢ 0 P P o Set

(1) | [Clear (In/Qut)] Clears In/Out points set on the clip.

(2) | [Cue(In)] Moves to the In point of the clip.

Sets In point to the current position. After
(3) | [Mark(In)] In point has been set, the In point marker
appears on the scrubbing bar.

Sets Out point to the current position.
(4) | [Mark(Out)] After Out point has been set, the Out point
marker appears on the scrubbing bar.

(5) | [Cue(Out)] Moves to the Out point of the clip.

Creates a sub clip between the set In-Out
points.

Creating a sub clip between In-Out points
(highlight)»P108

(6) | [Create Subclip]

92 T2 Elite/Pro/Express Users Guide October 6, 2014



Displaying P1/P2 channel in 1ch view

Trims the clip between the set In-Out
points.

Trimming a clip between the set In-Out
points» P107

(7) | [Set]

> P1/P2 channel (playlist view) — 1ch view
(M@)B)4) () (6) (7)8)  (9) (10)(11)(12)(13)(14)(15)

Cur: 00:00:01;07 b x

vent:

00:00;00 Format: 1440x1080
Out: 00:00:07;18 59.94i
Dur: 00:00:07;18

(16)(17) (18) (19) (20)

*(2) to (20) are common in P2 channel.

P1 channel tah/P2 By tapping, selects and highlights the P1
channel tab channel (or P2 channel).

™

Indicates the current playback mode (sync
mode, E to E mode, loop playback mode) in

white characters.

(2) | Playback mode By tapping, also switches the playback

mode.

Switching playback mode» P102

(3) | Status Indicates the playback progress status.
Locks P1 channel (or P2 channel)
operations.

(4) | [Locked] While the operations are locked, [Locked]

and [P1] (or [P2] button) buttons light in red.
Tapping it again releases the lock.
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Displays the video currently mounted.

Tapping the preview displays in the full
screen view.

(5) | Preview o )
If a playlist is not loaded, displays the
output profile of the channel on the upper
left.
6) | [Cur:] Indicates the current timecode of the
' playlist.
(7) | Playback speed Indicates the current playback speed

(times).

(8)

Scrubbing bar

Indicates the playback progress status and
markers of set In/Out points.

Indicates the timecode for the remaining
time of event or the timecode for the
remaining time of whole playlist.

The timecode to be displayed can be

(9) | [Rem:] changed by [Playlist Remain TC:] in [P1] (or
[P2]) -> the [Monitor & Remote] tab on the
setting screen.

[Monitor & Remote] tab»P201
Adds an event to the playlist.
10) | [Add Event
(10) | [Add Event] Greating a playlist»P109
(11) | [Delete Event] Deletes the event selected in the event list.
(12) | [Move Up] Moves up the event selected in the event
list.
(13) | (Move Down] }\i/;)ves down the event selected in the event
(14) | [Menu] Displays the related menu.
(15) | [Clip View] Switches to the clip view.
(16) | Operation buttons Operation buttons of P1/P2 channel (playlist

view)» P95
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(17)

[P.List] / [T.Line]

Indicates the name of the loaded playlist.
Tapping the entry area allows to change the
playlist name.

Software keyboard» P122

[P.List]

Playlist in the normal format.

[T.Line]

Playlist in the timeline format.

Changing the playlist type»P169

(18)

[Current Event:]

Displays the information of the event being
played.

[In:]1/[Out:]/[Dur:]
Indicates the timecode of In/Out points and
the length of the event (duration).

[Format:]
Indicates the video size and frame rate.

(19)

Event list

Displays the list of events in the playlist.
The selected event is displayed with a blue
frame.

The event being played is highlighted in
blue.

(20)

1ch view/3ch view/
bin/transfer screen
common area

1ch view/3ch view/bin/transfer screen
common aread» P47

> Operation buttons of P1/P2 channel (playlist view)

(1)

2 © @ ©6

(6)

In the TRIM mode, clears In/Out points set

(1) | [Clear (In/Qut)] on the event to cancel the TRIM mode.
(2) | [Cue(In)] Moves to the In point of the event.
p
In the TRIM mode, sets In point to the
(3) | [Mark(in)] current position. After In point has been

set, the In point marker appears on the
scrubbing bar.
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In the TRIM mode, sets Out point to the
current position. After Out point has been
set, the Out point marker appears on the
scrubbing bar.

(4) | [Mark(Out)]

(5) | [Cue(Out)] Moves to the Out point of the event.

Switches to the TRIM mode. You can edit
the In/Out points of the event selected in
the event list.

Trimming an event»P112

(6) | [TRIM]

Selecting P1/P2 channel in 3ch view

In 3ch view, you can view three channels, the video recorded in the R1
channel and the clip or playlist played in the P1/P2 channel simultaneously.
In 3ch view of P1/P2 channel, you can use the operation buttons and jog/
shuttle on the lower part of the touch screen LCD, to play or to switch
playback modes.

1 Tap [3ch View].
The display switches to 3ch view.
2 Tap the P1 channel tab (or P2 channel tab).

e 1ch
: 00:00:00;00 Lilsmy

Config.

t Clip_04

. 00:09:33;18

: 00:00:03;12 Transfer

¢ dinner01

Remaining:
=J13:58

y ==B==g==F== «

: 00:00:04;29

1:50 PM

P1 channel (or P2 channel) is selected and highlighted. The playback
operation to the selected channel becomes valid.

If the clip is loaded to the P1 channel (or P2 channel), clip view is displayed.
And if a playlist is loaded, playlist view is displayed.
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> P1/P2 channel (clip view) — 3ch view

(1)) )

©)(7) @

em: 00:00:03;12

ip:  dinner01

00:00:04;29

*(2) to (9) are common in P2 channel.

™

P1 channel tab/
P2 channel tab

By tapping, selects and highlights the P1
channel (or P2 channel).

Indicates the current playback mode (sync
mode, E to E mode, loop playback mode) of the

(2) | Playback mode P1 channel (or P2 channel) in white characters.
By tapping, also switches the playback mode.
Switching playback mode» P102

(3) | Status Indicates the playback progress status.
Locks P1 channel (or P2 channel) operations.
While the operations are locked, [Locked] and

(4) | [Locked] [P1] (or [P2] button) buttons light in red.
Tapping it again releases the lock.
Displays the video currently played back.

(5) | Preview If a clip is not loaded, displays the output
profile of the channel on the upper left.

Audio level : .

(6) display Displays output audio level.
Indicates the name of the loaded clip.

7 | [clip:] Tanpmg the entry area allows to change the
clip name.
Software keyboard» P122

(8) | [Cur:] Indicates the current timecode.

(9) | [Rem:] Indicates the timecode of the remaining time.
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> P1/P2 channel (playlist view) — 3ch view
M@)GB)E4) (5) 6)(7) (8)(9) (10) (1)

*(2) to (11) are common in P2 channel.

1) P1channel tab/ | By tapping, selects and highlights the P1
P2 channel tab channel (or P2 channel).

Indicates the current playback mode (sync
mode, E to E mode, loop playback mode) of the
(2) | Playback mode P1 channel (or P2 channel) in white characters.
By tapping, also switches the playback mode.
Switching playback mode» P102

(3) | Status Indicates the playback progress status.

Locks P1 channel (or P2 channel) operations.

While the operations are locked, [Locked] and
[P1] (or [P2] button) buttons light in red.

Tapping it again releases the lock.

(4) | [Locked]

Displays the video currently played back.

(5) | Preview If a playlist is not loaded, displays the output
profile of the channel on the upper left.

Audio level

(6) display

Displays output audio level.

Indicates the name of the loaded playlist.
Tapping the entry area allows to change the
(7) | [P.List:] playlist name.

Software keyboard» P122

(8) | [Now:] Indicates the name of the current event.
(9) | [Next:] Indicates the name of the next event.
ur: ndicates the current timecode ot the playlist.
(10) | [Cur:] Indi h i de of the playli
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Indicates the timecode of the remaining time
of event or the timecode of remaining time of
whole playlist.

(11) | [Rem:] The timecode to be displayed can be changed
by [Playlist Remain TC:] in [P1] (or [P2]) -> the
[Monitor & Remote] tab on the setting screen.
[Monitor & Remote] tab»P201

Loading contents to P1/P2 channel

The procedure to load the contents in the bin to the P1 channel or P2 channel
is described in this part.

Contents loaded to the P1/P2 channel can be performed playback or editing
of In/Out points.

1 Select the bin in the [Bin] tab and display the contents.
Displaying the [Bin] tab»P78
2 Select an item and tap [>P1] or [>P2].

The item is loaded to the P1 channel or P2 channel.
If the clip is loaded to the P1 channel (or P2 channel), clip view is displayed.
And if a playlist is loaded, playlist view is displayed.

P1/P2 channel (clip view) — 1ch view» P90
P1/P2 channel (playlist view) — 1ch view» P93

TIP * To unload contents, display the P1 channel (or P2 channel) in
1ch view, tap [Menu], and then tap [Unload].

Playing back video

Playing back with operation buttons

You can play the video of the selected channel using the operation buttons.
1 Press the [Play] button.

Control buttons» P35
During the playback, the [Play] button lights up.
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Playing back in variable speed mode (variable playback)

You can play the video of the selected channel in the variable speed mode.

1 Press the [VAR] button.

Control buttons» P35
The mode switches to the variable speed mode and VAR speed control is
displayed.
While in the variable speed mode, the [VAR] button lights up.

> VAR speed control

(1)

Play Speed: 0.00

™

[<1/[>]

By every tap, increases or decreases the
playback speed by 0.1 time.

(2)

Speed control bar

By tapping on the speed control bar,
specifies the playback speed within the
range of -2 to +2 times.

@)

[Play Speed:]

Indicates the current playback speed.

(4)

[Close]

Closes the VAR speed control.

Even after closing the VAR speed control,
you can perform variable speed playback
by operating the jog/shuttle.

2 Press the [Play] button.

3 Tap the speed control bar and move it.

Steps 2 and 3 can also be operated by the jog/shuttle.
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Playing back in jog/shuttle mode

You can fast forward or rewind the video of the selected channel using jog/
shuttle operations.
The playback speed changes by the operating angle of jog/shuttle.

1 Press the [SHTL/JOG] button.

Control buttons» P35
The mode switches to the jog/shuttle mode and the [SHTL/JOG] button
lights up.

2 Turn the jog/shuttle.

Turn to the right to fast forward, and turn to the left to rewind.
Depending on the angle to turn the jog/shuttle, the speed can be switched
from 0.13 to 32 times (7 levels) for the right side, and from -0.13 to -32 times
(7 levels) for the left side.

TIP ® The maximum speed of the shuttle (16 times/32 times) can be
changed.
Miscellaneous - Jog/Shuttle settings» P221

Loading and playing back video currently recorded (chasing

playback)

October 6, 2014

The video currently recorded in the R1 channel can be loaded and played
on the P1 channel (or P2 channel).

If you only want to load the currently recorded video and do not want to
play it back, you do not need to perform steps 1 to 4.

NOTE e This function is only available when the recording format is
AVI (Grass Valley HQ).

1 Tap [Config.].

You can operate it from the bin view, 1ch view, 3ch view, and transfer
screen.

2 Tap [P1] (or [P2]), and then tap [Video].
P1/P2 - Video settings» P199
3 In[Auto play mode:], tap and check [Auto Play].

4 Tap [OK].

5 Press the [P1] button (or [P2] button).
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6 Switch to the clip view.
If the playlist view is displayed, tap [Clip View] to switch the display.
7 Tap [Menu], and then tap [Now recording].

The video currently recorded in the R1 channel are loaded to the P1/P2
channel and played back automatically.

TIP ¢ Clicking the [Move to next edit point] button during chasing
playback in the workstation mode moves the playback to the

latest recording point.
Operation buttons of P1/P2 channel» P145

Switching playback mode

Outputting currently recorded video with active
through (E to E mode)

If the E to E mode is set to on in the P1 channel (or P2 channel), you can
output video currently recorded in the R1 channel to the P1 channel (or P2
channel) with active through.

NOTE e The video format of the channel set to the E to E mode and
that of the R1 channel must be the same.
R1 - Input Settings»P193
P1/P2 - Video settings»P199

1 Tap the P1 channel tab (or P2 channel tab).

2 Tap the playback mode, and then tap [E to E] from the menu.

[E to E] in the menu is checked and [E to E] in the P1 channel tab (or P2
channel tab) is displayed in white characters.

3 On the channel selected in step 1, stop the playback of contents
or unload it.

The video currently recorded is output when the playback of contents has
been stopped or loading of contents is not executed.
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TIP * You can also perform the same operation by tapping [Menu] in
the 1ch view of P1 channel (or P2 channel), and then tapping
[Playout Mode] -> [E to E].

Loop playback of contents (Loop mode)

If the Loop mode is set to on in the P1 channel (or P2 channel), you can
perform loop playback of the contents played on the P1 channel (or P2
channel).

1 Tap the P1 channel tab (or P2 channel tab).

2 Tap the playback mode, and then tap [Loop] from the menu.

[Loop] in the menu is checked and [Loop] in the P1 channel tab (or P2
channel tab) is displayed in white characters.

TIP * You can also perform the same operation by tapping [Menu] in
the 1ch view of P1 channel (or P2 channel), and then tapping
[Playout Mode] -> [Loop].

3 Play the contents selected in step 1.

Sync playback of contents (Sync mode)

By setting pairing on two contents and set sync mode on, the playback
status of the two contents can be synchronized.

You can use this function in such cases as when you want to synchronize
and play the L side and R side of a video.

NOTE e The media files in a removable media cannot be set to be
paired.
¢ A playlist and a clip cannot be set to be paired.
¢ The E to E mode and sync mode cannot be set to on at the
same time.
¢ In sync mode, only the following operations are available.
- Normal or variable speed playback
- Stopping playback
- Forwarding/rewinding frame by frame
- Moving to an In/Out point
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1 Load contents to the P1 channel.

Loading contents to P1/P2 channel» P99

2 Load the contents to be synchronized with the contents loaded in
step 1 to P2 channel.

3 Tap the P2 channel tab.

4 Tap the playback mode, and then tap [Sync] from the menu.

P2() clip: clip 04

EtoE

Loop

ﬂ Sync
[Sync] in the menu is checked and [Sync.] in the P2 channel tab is displayed

in white characters.

TIP * You can also perform the same operation by tapping [Menu] in
the 1ch view of P2 channel, and then tapping [Playout Mode]
-> [Sync].
¢ If the output settings of the P1 channel and P2 channel are
different, the setting of the P2 channel will be automatically
changed to be the same as that of the P1 channel.

5 A message appears. Tap [Yes].

Pairing are set to the contents loaded on the P1 channel and the contents
loaded on the P2 channel.

6 Select the P1 channel and press the [Play] button.

Contents loaded on the P2 channel is played back, being synchronized with
the contents loaded on the P1 channel.

TIP ¢ To release the pairing of contents, operate in the [Bin] tab.
Releasing pairing of contents» P84
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Playback of contents with alpha channel (Fill/Key
signal output mode)

You can play contents with transparency information (alpha channel).

1 Load the contents with alpha channel to the P1 channel (or P2
channel).

Loading contents to P1/P2 channel» P99

The mode switches to the Fill/Key signal output mode. Fill is output to the
loaded channel, and Key is output to the other channel.

The icons indicating Fill and Key appear on the P1 channel tab and P2
channel tab respectively.

| Cur: 00:00:00;00 Rem: 00:00:15;05

| cS

q p .p Transfer

Format:
- 1440x1080 Remain

Remaining:
59.94i E] 13:58

2:00 PM

2 Play the contents on the channel where Fill is output.

Playback operations of clips with alpha channel can be performed only on
the Fill side channel.

When you play a playlist that contains clips with alpha channel, the system
enters the Fill/Key signal output mode and the Key side channel will output
a black screen for normal clip playback.
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TIP ¢ If a clip with alpha channel is added to the playlist in the
normal mode, the mode switches to the Fill/Key output mode
after unmounting. The video may be disrupted due to the
output signal loss when the modes are switched, however, this
is not a system failure.

¢ The following operations are available while a clip with alpha
channel is loaded.

- Moving to an In/Out point

- Setting an In/Out point

- Creating a sub clip (you cannot create a sub clip of a still
image clip with alpha channel)

- Moving to the first frame, frame reverse, stop, playback,
frame forward, moving to the last frame, fast forward,
rewind, and variable speed playback

- Scrubbing bar operation (workstation mode only)

- Setting a fade in effect (applied to the Key side)/fade out
effect (applied to the Key side)/actions (pause, loop) to an
event in a playlist

* The following operations are not available while a clip with
alpha channel is loaded.

- Switching to the TRIM mode in the playlist view

* You can also play clips with alpha channel using the remote
control with AMP commands.

Editing a clip

Setting In and Out points to a clip

You can set In and Out points to a clip.
If In and Out points have been set to a clip, you can move to the set In point
or Out point, trim between In-Out points, or save it as a sub clip.

1 Load a clip to the P1 channel (or P2 channel).
Loading contents to P1/P2 channel» P99

2 Play a clip and tap [Mark(In)] when you want to set the In point.

Operation buttons of P1/P2 channel (clip view)» P92
The In point is set to the current position. A marker appears in the In point
position on the scrubbing bar.
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3 Play a clip and tap [Mark(Out)] when you want to set the Out
point.

The Out point is set to the current position. A marker appears in the Out
point position on the scrubbing bar.

Cur: 00:09:37;00 gm: 00 :00 :03 ;00

TIP * You can also specify In and Out points with the timecode. Tap
the entry area of [In:] and [Out:], and enter the timecode.
P1/P2 channel (clip view) — 1ch view» P90

Trimming a clip between the set In-Out points
If set In and Out points are fixed, you can trim a clip between the In/Out
points.

1 Set In and Out points to a clip.
Setting In and Out points to a clip»P106

2 Tap [Set].

Operation buttons of P1/P2 channel (clip view)» P92

The information of the In-Out points for the clip is updated with the set In
and Out points. The space between the In-Out points is displayed in a pale
white bar.

Cur: 00:09:37;00 Rem: 00 :00 :00;00

[ R 1

B3 | P P

TIP ¢ Even when a clip is trimmed between In-Out points, the
trimmed range of the video will not be deleted.
¢ To change the trimmed video between In-Out points, set In
and Out points to the clip again, and then tap [Set].
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Creating a sub clip between In-Out points (highlight)

You can create a sub clip between set In-Out points and save it as a separate
clip.

1 Set In and Out points to a clip.

Setting In and QOut points to a clip»P106

2 Tap [Create Subclip].

Operation buttons of P1/P2 channel (clip view)» P92
A sub clip including video between the set In and Out points is created and
saved in the same bin as the original clip.

Cutting out a still image clip

You can cut out the current position of the clip that is mounted on the P1
channel (or P2 channel) as a still image clip.

1 Move to the position you wish to cut out as a still image.

2 Tap [Menu] in the clip view and then tap [Create Still Clip].

3 A still image clip is saved in the same bin as the clip being
mounted.

The duration of the still image clip is applied according to the time period
of seconds set for [Duration (still image)] in the [Common] tab of [Transfer]
in the setting screen.

Transfer — common settings» P205

—_—
Gommon | AVCHD AVI

General here. ) =

R1

P1

Cancel

NOTE * You cannot cut out still image clips from clips mounted
directly from an external storage, etc.
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TIP ¢ In the workstation mode, right-click on the preview window,
and click [Create Still Clip].
¢ In the workstation mode, still image clips are stored in the
selected bin.

Checking clip properties
You can check the properties of the clip loaded to the P1/P2 channel.
1 Tap [Menu] in the clip view, and then tap [Properties].

The properties of the clip are displayed.
Clip properties» P82

Changing a clip name
You can change the name of the clip loaded to the P1/P2 channel.
1 Tap [Menu] in the clip view, and then tap [Rename].

2 Enter a name and tap [OK].
Software keyboard» P122

Updating thumbnails of clips

You can update the thumbnail images of the clips displayed on the contents
list in the bin view to the image of the current position.

1 Tap [Menu] in the clip view, and then tap [Set Thumbnail Frame].

Editing a playlist

Creating a playlist

You can create a playlist including multiple contents.

To create a playlist, add contents to the playlist view on the P1/P2 channel.
The contents added on the playlist are called event.

The procedure to create a new playlist is described in this part.
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TIP * You can add a playlist to another playlist as an event. The

added playlist is called playlist event.
If you add a playlist which contains a playlist event to another
playlist, a message appears. Select an adding method of a
playlist event.

¢ Playlists includes normal format and timeline format playlists.
In a playlist in the normal format, each events are added
without creating spaces. In a playlist in the timeline format,
events can be added to a desired position on the timeline by
specifying the timecode.

¢ Creating or editing of a playlist in the timeline format can be
performed only in the workstation mode.
Changing the playlist type»P122
Editing playlist in the timeline format» P171

1 Press the [P1] button (or [P2] button).

2 Switch to the playlist view.
If the clip view is displayed, tap [Playlist View] to switch the display.

3 Tap [Add Event].

P1/P2 channel (playlist view) — 1ch view» P93
The dialog box to add an event appears.

TIP ¢ To add contents to an existing playlist, select an event immediately
before the position to add the contents and tap [Add Event].

4 Tap [Select Bin].

5 Select a bin that includes the contents to be added to the playlist
and tap [OK].
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6 Select contents in the dialog box to add an event and tap [Add].
7 Repeat steps 4 to 6.

8 Tap [Close].

The contents are registered as events in the playlist by the added order.
Playlists are saved in the bin selected in step 5 with the name “Play (serial
number)”.

Deleting an event from a playlist

You can delete an event from a playlist.
Even after events have been deleted from the playlist, the original contents
will not be deleted.

1 Tap and select an event to delete in the playlist view.

The selected event is displayed with a blue frame.

2 Tap [Delete Event].
P1/P2 channel (playlist view) — 1ch view» P93

Playing back a playlist

You can load a playlist to the P1/P2 channel and play it.

1 Load a playlist to the P1 channel (or P2 channel).

Loading contents to P1/P2 channel» P99

When you load a playlist to the P1/P2 channel, the playback position
automatically moves to the In point of the first event.

Double-tapping a desired event can move the playback position to the In
point of the event.

2 Press the [Play] button.

Playing back video» P99
The event being played is highlighted in blue.
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Icons for events

The icons displayed in the thumbnails are described in this part.

> Event icons

(1) | Fade in Indicates that fade in is set.
(2) | Fade out Indicates that fade out is set.
(3) | Pause Indicates that the playback stop operation

of the event is set to pause.

Indicates that a place holder is set.

4
(4) | Place holder Adding place holder to playlist»>P118

(5) | Loop playback Indicates that loop playback is set.

Trimming an event

In the TRIM mode, you can trim an event by setting In and Out points to
the event.

1 Double-tap and select an event to trim in the playlist view.

2 Tap [TRIM].
The mode switches to the TRIM mode.

3 Play an event and tap [Mark(In)] when you want to set the In
point.

Operation buttons of P1/P2 channel (playlist view)» P95
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The In point is set to the current position. A marker appears on the In point
position on the scrubbing bar.

4 Play an event and tap [Mark(Out)] when you want to set the Out
point.

The Out point is set to the current position. A marker appears on the Out
point position on the status bar.

5 Tap [TRIM].

The TRIM mode exits, and the event is trimmed between the set In-Out
points.

Setting effects on an event

You can set effects at the event start point (start effect) or the effect at the
event end point (end effect).

1 Tap and select an event in the playlist view.

The selected event is displayed with a blue frame.

2 Tap [Menu], and then tap [Event Effect].

3 To set a start effect, tap the [Start Effect] tab and set each item.

> Event — [Start Effect] tab

Start Effect [ End Effect

# Fade In

Fade in (from black)

Fade Time

30 frames (1 - 300)
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To set a fade in effect, check [Fade In] and select an
action from the list.

e [Fade in (from black)]

Sets a fade in effect from a black screen.
e [Fade in (from white)]

Sets a fade in effect from a white screen.

[Fade In]

Tap the entry area of [Fade Time] and enter the number
of frames from the start point to the end point.

4 To set an end effect, tap the [End Effect] tab and set each item.

> Event - [End Effect] tab

" StartEffect End Effect

& Fade out
Fade out (to black)

Fade Time

30 frames (1 -300)

& Action

Pause (show black)

To set a fade out effect, check [Fade Out] and select an
action from the list.
e [Fade out (to black)]
Sets a fade out effect to a black screen.
e [Fade out (to white)]
Sets a fade out effect to a white screen.

[Fade Out]

Tap the entry area of [Fade Time] and enter the number
of frames from the start point to the end point.
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To set an end action for playback, check [Action] and
select an action from the list.
¢ [Pause (show black)]
Pauses the playback with a black screen displayed.
e [Pause (show white)]
Pauses the playback with a white screen displayed.
e [Pause (last frame)]
[Action] Pauses the playback with the last frame displayed.
e [Pause (next event)]
Pauses the playback with the first frame of the next
event displayed.
¢ [Pause (show EtoE)]
Displays the video input to the R1 channel with
active through.
* [Loop]
Plays back the event in loop.

5 Tap [OK].

TIP ¢ If you set the effects as an event template of playlist, the
template setting is applied to newly added events.
General — Miscellaneous settings» P187

Updating playlist effect settings

You can collectively set effects for event starting (start effects) and actions

or effects for event ending (end effects) to all events in the playlist.
You can also collectively delete effects set to the events.

1 Display the playlist properties.

Checking playlist properties» P120
Checking the properties of the contents» P82

2 Tap the [All Events] tab.
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> Playlist — [All Events] tab

Playlist Info = Timecode | All Events

[¥ Change start effects:
® Remove all start effects

O Add start effect to every event

Fade Time frames (1 - 300)

[ change end effects:

w

OK Cancel Apply

Check it when you want to update the setting of
start effects.

[Remove all start effects]
Deletes start effects set to the event.

[Add start effect to every event]
Updates start effects (fade in) set to the event.
[Change start To set a fade in effect, check [Fade In] and select
effects:] an action from the list.
e [Fade in (from black)]

Sets a fade in effect from a black screen.
e [Fade in (from white)]

Sets a fade in effect from a white screen.
Tap the entry area of [Fade Time] and enter the
number of frames from the start point to the end
point.
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[Change end
effects:]

Check it when you want to update the setting of
end effects.

[Remove all end effects]
Deletes end effects set to the event.

[Add end effect to every event]
Updates the end effects (fade out or end action for
playback) set to the event.
To set a fade out effect, check [Fade Out] and
select an action from the list.
e [Fade out (to black)]
Sets a fade out effect to a black screen.
e [Fade out (to white)]
Sets a fade out effect to a white screen.
Tap the entry area of [Fade Time] and enter the
number of frames from the start point to the end
point.
To set an end action for playback, check [Action]
and select an action from the list.
* [Pause (show black)]
Pauses the playback with a black screen displayed.
e [Pause (show white)]
Pauses the playback with a white screen displayed.
e [Pause (last frame)]
Pauses the playback with the last frame displayed.
e [Pause (next event)]
Pauses the playback with the first frame of the
next event displayed.
¢ [Pause (show EtoE)]
Displays the video input to the R1 channel with
active through.
* [Loop]
Plays back the event in loop.

3 Set each item and tap [OK].
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Adding place holder to playlist

Place holder is the temporary event that can be replaced to a clip event later.
The length of the event can be set as desired in event properties.

TIP * Adding and replacing a place holder event is available only in

the workstation mode.

1 Right-click on a desired event and click [Placeholder] -> [Insert
into] -> [Before] or [After].

A place holder is added before or after the event, and a down arrow icon is

displayed on the place holder.

Remote

Clip Playlist

Playlist (1)

TIP ¢ Alternatively, right-click on the playlist without selecting any

event, and then click [Placeholder] -> [Insert at the tail], to add
a place holder.

¢ Select [Placeholder] -> [Insert at the tail] from [Playlist Menu]
to create a new playlist containing a place holder event.
P1/P2 channel (playlist view) — 2ch/3ch view» P144

* You can make settings for adding a place holder event.
[Playlist Placeholder] dialog box (workstation mode only) »P191

The properties of the place holder are displayed.

118 T2 Elite/Pro/Express Users Guide October 6, 2014



Editing a playlist

> Properties of place holder

Placeholder Properties (1/2)

Event Info GPL Timecode — Start Effect | End Effect

Out TC:

Duration:

Placeholder

K Cancel

Displays the information on the place holder.

You can check the event name, event type, In/Out
[Event Info] tab | points, duration, alpha channel presence, the name of
the contents being linked, etc.

You can change the event name and duration.

When controlling an external device with GPI
output, allows to check or set the trigger event
[GPI] tab actions. (Only for P1 channel.)

Controlling external devices from T2 with GPI
output»P229

Specifies starting timecode of an event. (Enabled
when [According to event setting] is selected on the
[Timecode] tab in the playlist property.)

[Timecode] tab | To use the starting timecode of a media file, select
[Source].

To specify a starting timecode, select [Specify start
time], tap the entry area, and enter timecode.

Allows to check or set the effects for event starting
[Start Effect] tab | (start effects).
Setting effects on an event»P113

Allows to check or set the effects for event ending
[End Effect] tab | (end effects).
Setting effects on an event»P113

2 Set each item and click [OK].
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Replacing place holder on playlist

You can replace a set place holder to a clip.

1 Click the bin that includes the clip to be replaced with from the
bin list on the [Bin] tab, and then click the clip to be replaced with
from the contents list.

[Bin] tab» P78

2 Right-click on the place holder, click [Placeholder] -> [Replace],
and then click the clip to be replaced with.

The place holder is replaced with the clip.

TIP e Alternatively, drag & drop the clip that is selected on the
contents list in the bin list to {4 in a place holder, to replace a
place holder with a clip.

RS422 input/output pin»>P258
* You can make settings for replacing a place holder event.
[Playlist Placeholder] dialog box (workstation mode only)» P191

Changing a playlist name
You can change the name of the playlist loaded to the P1/P2 channel.
1 Tap [Menu] in the playlist view, and then tap [Rename].

2 Enter a name and tap [OK].
Software keyhoard» P122

Checking playlist properties
You can check the properties of the playlist loaded to the P1/P2 channel.
1 Tap [Menu] in the playlist view, and then tap [Properties].

The properties of the playlist are displayed.
Playlist properties» P83

Checking event properties

You can check the properties of events in the playlist loaded to the P1/P2
channel.

1 Tap and select an event in the playlist view.
The selected event is displayed with a blue frame.

2 Tap [Menu], and then tap [Event Properties].
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The properties of the event are displayed.

> Event properties

Event Info GPT Timecode = StartEffect = End Effect

Event: klip 01

InTC: 00:00:00;00
Out TC: 00:00:15;06
Duration: 00:00:15;06
Type: Clip

Alpha channel: None

Source Name: clip 01

Audio Gain: 0.0 dB

0K Cancel

Displays the information of the event.

You can check the event name, event type (clip or
playlist), In/Out timecode, length, alpha channel
[Event Info] tab presence, the name of the contents being linked, etc.
Tapping the entry area allows to change the event
name and audio gain. (For still images, the length
can be changed.)

When controlling an external device with GPI
output, allows to check or set the trigger event
[GPI] tab actions. (Only for P1 channel.)

Controlling external devices from T2 with GPI
output»P229

Specifies starting timecode of an event. (Enabled
only when [According to event setting] is selected
in the [Timecode] tab in the playlist properties.)
To use the starting timecode of a media file, select

[Timecode] tab [Source].

To specity a starting timecode, select [Specify
Start Time], tap the entry area, and enter
timecode.

Allows to check or set the effects for event ending
[Start Effect] tab (end effects).
Setting effects on an event»P113

Allows to check or set the effects for event ending
[End Effect] tab (end effects).
Setting effects on an event»P113

3 Tap [OK].
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Changing the playlist type

You can select the playlist type (normal or timeline format). The playlist
type can be changed only in the workstation mode.

Changing the playlist type»P169

Entering characters and numerics

Entering characters

The operation to enter characters in each screen is described in this part.

NOTE

* You cannot enter Japanese characters.

1 Tap the entry area of a screen.

2 Enter characters with the software keyboard.

> Software keyboard

(4) ®) 6)

Displays the characters entered with the

(1) | Entry area software keyboard.

(2) | [Shift] Switches upper/lower case of alphabets.

(3) | Cursor (left and right) | Moves the cursor in the entry area.

(4) | [Space] Used as the space key.

) | 10KI Fixes the entered characters and closes the
software keyboard.

(6) | [Cancel] Cancels the entry and closes the software

keyboard.
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7) | el Deletes currently selected entry or deletes
the character right after the cursor.
(8) | [BackSpace] Deletes the character right before the cursor.
3 Tap [OK].

Entering timecode

The operation to enter timecode in each screen is described in this part.

1 Tap the timecode entry area of a screen.

2 Enter a timecode with the software keypad.

> Software keypad — Timecode

Cancel

2 ©G)@4) © (6)

Displays the timecode entered with the
software keypad.

According to the entered digits, the number
will be automatically converted into “hour,
minute, second, frame”. For example, enter
“4321” for 43 seconds 21 frames.

(1) | Entry area

(2) | Cursor (left and right) | Moves the cursor in the entry area.

Applies the entered value to the set value
for timecode as it is.

@) | [=]

Allows to enter reduced or increased value
(relative value) from the current value.

Reduces the set value by entering after
tapping [-].

Increases the set value by entering after
tapping [+].

Fixes the entered value and closes the
software keypad.

4) | [-1/[+]

(5) | [OK]
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Cancels the entry and closes the software

(6) | [Cancel] keypad.

Deletes currently selected entry or deletes

(7) | [Dell the character right after the cursor.
(8) | [BackSpacel] Deletes the character right before the cursor.
3 Tap [OK].

Entering numerics

The operation to enter numerics in each screen is described in this part.

1 Tap the numeric entry area of a screen.

2 Enter numerics with the software keypad.

> Software keypad — Numeric

(1

(6)
®)

(2) ©) (4)

Displays the numerics entered with the

(1) | Entry area software keypad.

Cursor (left and

(2) right) Moves the cursor in the entry area.

Fixes the entered value and closes the

(3) | [0K] software keypad.

Cancels the entry and closes the software

(4) | [Cancel] keypad.

Deletes currently selected entry or deletes
the character right after the cursor.

(5) | [Dell

Deletes the character right before the
Cursor.

(6) | [BackSpace]

3 Tap [OK].
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Operations in Workstation Mode

This section describes screen elements of the workstation mode and
functions available only in the workstation mode.

Screen elements

> Full display — 3ch view

P RHQA T > BB>P) 1)

(1) | Menu bar

By clicking, displays related menu.
Menu bar»P126

Channel display

2) part

Displays R1, P1, and P2 channels in 3ch view.
R1 channel - 2ch/3ch view» P127
P1/P2 channel — 2¢ch/3ch view»P142

(3) | Status bar

Status bar»P151

Bin/transfer
(4) | screen display
part

Performs contents management, import/export
of media files, display of the setting screen, etc.
Bin/transfer screen display part»P152
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> Menu bhar

[System]

By clicking, displays the next menu.

[Switch to Front Panel mode]
Switches from the workstation mode to the front panel
mode.

[Switch to Workstation mode]

Switches from the front panel mode to the workstation
mode.

Switching from the front panel mode to the workstation
mode» P42

[Lock Front Panel]

Lock and unlock front panel. This mode is unlocked
to push [R1]+[P1]+[P2]+ [SHTL/VAR] buttons same time
also.

[T2 to T2 Sync backup...]
Makes a backup of all data to another T2.

[Maintenance...]
Switches to the maintenance mode.

[Exit]
Exits T2.
Exiting T2 in workstation mode» P41

[View]

By clicking, displays the next menu.

[2¢ch (R1+P1)]
Displays R1 and P1 channels in channel display part.

[2¢ch (R1+P2)]
Displays R1 and P2 channels in channel display part.

[2¢ch (P1+P2)]
Displays P1 and P2 channels in channel display part.

[3ch]
Displays R1, P1 and P2 channels in channel display part.
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[Option]

By clicking, displays the next menu.

[Log]
Sets the log level and displays logs.
Checking logs of operations and processes»P174

[Remove media...]

Disconnects a removable drive such as USB removable
media, XDCAM, P2, GF, etc.

[Customize]

Assigns keyboard shortcuts and sets mouse operations.
Changing keyboard shortcut assignment» P161

Assigning commands to mouse operation» P163

[Help]

By clicking, displays the next menu.

[About T2]
Displays the version of T2.

> R1 channel — 2ch/3ch view
@4)(5) (6) (7) (8)(9) (10) 1 (12

(12 (3)

(1) | R1 channel tab

By clicking, selects and highlights the R1
channel.

(2) | Status

Indicates the recording progress status.

(3) | [Locked]

Locks R1 channel operations.

While the operations are locked, [Locked]
and [R1] buttons light in red.

Clicking it again releases the lock.

Displays the video currently played back.
In full screen mode, right-click on it, and

4) | Preview

“) then click [Full Screen Mode] or double-
click on it.

(5) | [Cur:] Indicates the current timecode.

T2 Elite/Pro/Express Users Guide 127



Section 9 — Operations in Workstation Mode

(6)

Scrubbing bar

Indicates the recording progress status.

(7)

[Elapsed:]

Indicates the elapsed time of recording by
timecode display.

(8)

Audio level display

Displays input audio level.

(9)

[Switch to the detail
display]

Switches to the detail view.

Audio level detail display (R1
channel)»P139

Timecode Status display (R1/P1/P2
channel)»P140

(10)

Recording mode

Switches the recording mode (R1-live mode
/R1-VTR mode/R1-remote mode).

R1-live mode»P128

R1-VTR mode»P135

R1-remote mode» P136

In the R1-live mode, automatically starts
recording operation at a specified time, and

(11) | [Schedule] ends it at a specified time.
R1-live mode / schedule mode» P129
Unloads the video loaded to the R1
(12) | [Unload] channel.
(13) | Operation buttons Operation buttons of R1 channel»P138

> R1-live mode

U

[Clip:]

Enter the name of the clip currently
recorded.

(2)

[Tag:]

Enter a tag for search to the clip currently
recorded.
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Displays the properties of the clip currently

(3) | [Properties] recorded.
[Setting of Sets the s.aving. destination and naming
4) ingesting] rule of clips being recorded.
g g Setting of ingesting dialog box» P137

(5) | [] L

(5) | (Mark In:] Indicates the In point timecode of the clip
currently recorded.

(6) | [Mark Out:] Indicates the Out point timecode of the clip
currently recorded.

. Indicates the time length (duration) of the

(7) | [Dur:] .
clip currently recorded.
Displays the video size, frame rate, input

(8) | [Format] settings, port used for input, source TC (TC
(LTC)/SDI (VITC)/TC (INT)), etc.
[Fixed Length On]

©) [Live Record By clicking to set it on, automatically ends

Settings]

recording after the duration from the start
point specified in [Length:].

TIP

* While recording to an external device, [Setting of ingesting]
turns green to indicate that the recording to an external device
is performed.

> R1-live mode / schedule mode

(1

October 6, 2014
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Schedule

(4)
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™

[Add]

Creates a new schedule.

Schedule Recording dialog hox» P131

()

[Delete]

Deletes schedules selected on the schedule
list.

@)

[Edit]

Changes the date and time etc. of a
schedule selected on the schedule list.
Displays the Schedule Recording dialog
box.

(4)

Schedule list

Displays information on new schedules and
schedules that have already been recorded.
The status, name, start time, end time, and
type of schedules can be viewed.

Status of Schedule»P130

TIP

> Status of Schedule

* Select a schedule on the schedule list, right-click on it, and then
click [Select All], to select all schedules.

Status

Details

[Waiting]

Schedule recording is waiting for next start time.

[Retrying]

Recording is retrying.

[Recording]

Recording is in process.

[End]

Recording is completed.

[Disabled]

The schedule is disabled. Recording will not be
executed.

Result

Details

[Success]

Recording is completed successfully.

[Error]

An error is occurred during recording.

[Cancel]

Recording is canceled in the middle.
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> Schedule Recording dialog box

(6)

()

6/10/2013 [ERE Cre time

165:36:00 4

(®) Internal

(O External

Q)

[Schedule Name]

Enter the schedule name.

(2)

[Date :]

([Start Date :], [End
Date :]1, [Day of
week :1)

Selects [One time], [Every day], or [Every
week] from the list.

Selecting [Every day] or [Every week]
repeats recording operation for a fixed
period of time.

[One time]

By clicking the icon on the calendar,
allows to set the date to automatically start
recording.

[Every day]

Changes [Date ‘] to [Start Date :].

Checking [Set end date] displays [End Date
]

Clicking the icon on the calendar allows to
set the [Start Date :] and [End Date :].

[Every week]

Changes [Date ‘] to [Start Date :] and
displays [Day of week :].

Checking [Set end date] displays [End Date
;] and [Day of week :].

Clicking the icon on the calendar allows to
set the [Start Date :] and [End Date :]. Set
[Day of week ] to the day of the week when
you wish to record.
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Sets the time to automatically start

(3) | [Start Time :] recording.

Sets the time to automatically end

(4) | [End Time :] recording.

Selects the saving destination of the clips to
be recorded.

[Capture Path :]

Select [Internal] to save clips to T2.

The bin that is registered to T2 is displayed
from the list.

Also clicking [...] allows to set a newly
created bin to the saving destination.
Select [External] to save clips to a
destination other than T2.

If <non-registered> is indicated, click [...]
and set the saving destination.

(5) | [Output]

[Clip Name :]

Sets the naming rule of clips to be saved.
Enter the clip name.

Clicking [...] enters [Date], [Time] and/

or [Schedule Time] after the clip name
automatically.

[Capture Format :]

Sets the format of the clips to be recorded.
(6) | [Format] Clicking [Settings...] displays the Capture
Format dialog box.

Capture Format dialog box»P133

[Action]
(7) | [Other] Selects if the schedule is to be executed or
not from [Enable] and [Disable].

NOTE ° The following schedules cannot be added or changed.
- A schedule that overlaps to a registered schedule
- A schedule whose recording start time is within one minute
- A schedule that has already been recorded

¢ It may take more than one minute to finish recording after

"recording long time" or "recording in the external storage".
In this case, next schedule recording is started after the last
recording is completed.
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TIP ¢ [Date ;] ([Start Date :], [End Date :]), [Start Time :], and [End
Time :] can also be set by moving the mouse wheel .

> Capture Format dialog box

Capture Format

ideo
Inp

Input format ;

Bitrate :

Audio format 24hitach

oK " Cancel

[Input type :]
Selects the port used for video input.

[Input format :]
Selects the format for video input.

[Aspect :]
[Video] For SD input, selects the aspect ratio.

[Pedestal :]

Selects the setup level (black level) for NTSC from
OIRE and 7.5IRE. OIRE is used in Japan, and 7.5IRE is
used in North America.

Checking [Correct white peak] performs white peak
correction.
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[Input type :]
Selects the port used for audio input from [Analog],
[Digital], and [SDI-Embedded].

[Gain (Analog) :]
Adjusts the gain to obtain an appropriate volume
level.

[Audio]

[File type :]

Selects the compression format from [Grass Valley
HQ(AVI)], [XDCAM HD422(MXF)], [XDCAM
HDMXEF)], [XDCAM IMX(MXF)], and [XDCAM
DV(MXEF)].

[Bitrate :]
Selects a bit rate that supports the compression
format.

[HQ 150Mbps MAX]
By checking, restricts the compression ratio of Grass
Valley HQ Codec to 150 Mbps.

[Compression] | [Audio format :]
Selects an audio format that supports the
compression format.

[ClosedGOP]

By checking when the format is MXF, the information
are closed within GOP.

It increases the data size, but allows re-editing with
editor software that allows editing of GOP data.
Uncheck it normally.

[Allow to edit growing MXF File]

By checking when the format is MXE, the captured
MXEF file is supported growing clip and FTP export.
Uncheck it normally.

TIP ¢ If recording is performed in SDI, you can select 16bit 2ch/24bit
8ch.
R1 - Input Settings»P193
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> R1-VTR mode
(1)

Screen elements

™

[Clip:]

Enter the name of the clip currently
recorded.

()

[Tag:]

Enter a tag for search to the clip currently
recorded.

@)

[Batch]

Switches to the R1-VTR batch mode.
Recording sources at once (batch
capturing) »P165

(4)

[Properties]

Displays the properties of the clip currently
recorded.

(5)

[Setting of
ingesting]

Sets the saving destination and naming rule
of clips being recorded.

Setting of ingesting dialog box» P137

(6)

[Format]

Displays the video size, frame rate, input
settings, port used for input, source TC (TC
(LTC)/SDI (VITC)/TC (INT)), etc.

(7)

[VTR Record
Settings]

[VTR In:]

Enter the In point timecode of the clip
currently recorded.

[VTR Out:]

Enter the Out point timecode of the clip
currently recorded.

[Length:]
Indicates the time length (duration) of the
clip currently recorded.

[Fixed Length On]

By clicking to set it on, automatically ends
recording after the duration from the start
point specified in [Length:].
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TIP  * While recording to an external device, [Setting of ingesting]
turns green to indicate that the recording to an external device
is performed.

> R1-remote mode

(1 @ O

Enter the name of the clip currently
recorded.

(1) | [Clip:]

Enter a tag for search to the clip currently

(2) | [Tag:] recorded.

Displays the properties of the clip currently

(3) | [Properties] recorded.

Sets the saving destination and naming rule
of clips being recorded.

Setting of ingesting dialog box» P137

[Setting of

“) ingesting]

Displays the video size, frame rate, input
(5) | [Format] settings, port used for input, source TC (TC
(LTC)/SDI (VITC)/TC (INT)), etc.

TIP ¢ While recording to an external device, [Setting of ingesting]
turns green to indicate that the recording to an external device
is performed.
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> Setting of ingesting dialog hox

Setting of ingesting

tation mode..

2 naring rules for ingested clips,

Clip

Selects the saving destination of the clips to be
recorded.

Select [Save to internal storage] to save clips to T2.
Select the bin that is registered to T2 from the list.
Also clicking [...] allows to set a newly created bin to
the saving destination.

[Destination] Checking [Ingest to the selected bin] saves clips to
the bin selected in the bin display area.

To record data to a destination other than T2, select
[Save to external media / storage], and then select an
external media/storage from the list.

If <non-registered> is indicated, click [..] and set the
saving destination.

Sets the naming rule by entering a name of clips to

be saved.

The data is recorded by a clip name with the
[Clip naming recorded date and time, according to the items
rules] selected in [Date] and/or [Time].

If the name of the clip to be recorded next has been
set in the R1 channel, the clip name setting for the
next recorded clip is prioritized.
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> Operation buttons of R1 channel

)

4) - ©) - (8)

(1)| € | ®) | () | ©) |(11)| (13)

(10).,,,(12)

(1) | [Cue(In)]™ Moves the VIR to the In point.

(2) | [Cue(Out)]™" Moves the VIR to the Out point.

(3) | [Rewind]"™ Rewinds the VTR.

@) [Move to the By every click, moves back the VIR frame

previous frame]™

by frame.

(5)

[Stop]

Stops playback or recording.

(6)

[Record]

Starts recording.

The icon display changes depending on
the recording mode.

Indicates that a recording stop operation is
necessary.

Indicates that it is a fixed length recording.

Indicates that In point and Out point are
set.

(7)

[Play]™

Plays the VTR.

[Move to the next

By every click, moves forward the VTR

® frame]™ frame by frame.

(9) | [FastFwd]™ Fast forwards the VTR.
(10) | [Mark(In)] Sets In point to the current position.
(11) | [Mark(OQut)] Sets Out point to the current position.
(12) | [Clear (In/Out)] Clears set In/Out points.

(13)

[Create Subclip]™

Creates a sub clip between In-Out points
set while recording, and saves it as

highlight.

*1 Only for R1-VTR mode.

*2 Only for R1-live mode. However, if the video being recorded is saved
to an external media or storage, a sub clip cannot be created.
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> R1 channel — 1ch view
The display is same as that of R1 channel — 3ch view.
R1 channel - 2ch/3ch view»P127

> Audio level detail display (R1 channel)
(1 @

(1 | [<1/I>] Switches the detail display

Selecting [Peak] makes the maximum level
to 0 dB.

Selecting [Ref] makes the set audio
Switching of display | reference level as the standard level.

scale You can set the audio reference level in
[Audio reference level:] from [General] ->
[Hardware] tab in the setting screen.

General - Hardware settings» P178

(2)

(3) | Input port Indicates the port used for input.
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By moving the slider, adjusts the gain for

(4) | Gain slider each channel (only ANA is available).

Displays the input audio level for each

(5) | Level meter track.

Indicates the channel that monitors the

channel to monitor from the list.

By clicking, closes the audio level detail
(7) | [Closel display.

> Timecode Status display (R1/P1/P2 channel)
(1) (2) 3) (4)

LTC

P1

w1 00:01:49;04

P2
b ozl

(10) (9 (8) (7 ® ()

(1) | [<I/I>] Switches the detail display.

Displays the audio level meter of the

(2) | Audio level meter channel whose timecode is displayed.

Displays the timecode input to LTC of R1
(3) | LTC timecode channel. When the timecode is locked, this
is displayed in green.

Lights up in green (lock status) when the
timecode input to LTC of R1 channel is

confirmed to progress frame by frame
(4) | LTC lock status correctly. If the timecode has stopped or
does not progress frame by frame, the
status will not be locked.
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(5)

TC lock status

Lights up in green (lock status) when the
timecode of the P1 channel (or P2 channel)
synchronizes with the frame accuracy of
the LTC timecode of the R1 channel. A
plus is displayed if it is ahead of the LTC
timecode of the R1 channel, and a minus is
displayed if it is behind.

(6)

Frame deviation
number

Displays the frame deviation to the LTC
timecode of the R1 channel. A plus is
displayed if it is ahead, and a minus is
displayed if it is behind. The number

is not displayed when the playback is
synchronized with the same timecode or
when it has stopped.

-120 to +120 can be displayed.

(7

Remote status

The remote mode set in the P1 channel (or
P2 channel) is displayed. Lights up in white
when remote control is enabled.

Remote Control» P224

(8)

Current timecode

Displays the current timecode of the
P1 channel (or P2 channel). When the
timecode is locked, it is displayed in green.

General — Hardware settings»P178

(9)

Playback speed

Indicates the current playback speed
(times).

(10)

[Close]

By clicking, closes the audio level detail
display.
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> P1/P2 channel — 2ch/3ch view

(1) (3)(4)

) ©)(7) (@) ()

U -
|
'L

s =

S

(10) (11)(12) (13)

Cur: 00:09:33;28 Rem

[ U
PR O>B>pp] 1P

*(2) to (16) are common in P2 channel.

(1)

P1 channel tab/
P2 channel tah

By clicking, selects and highlights the P1
channel (or P2 channel).

(2)

[Locked]

Locks P1 channel (or P2 channel) operations.

While the operations are locked, [Locked] and
[P1] (or [P2] button) buttons light in red.

Tapping it again releases the lock.

@)

Output profile

Indicates the output profile of the channel.

(4) | Status

Indicates the playback progress status.

®)

Playback mode

Switches on and off of the current playback
mode (sync mode, E to E mode, loop playback
mode) of the P1 channel (or P2 channel).

In E to E mode, the E to E indicator will display
blue text when R1 channel is played, and white
text when P1/P2 is played.

(6)

Preview

Displays the video currently played back.

To update the thumbnail of the contents with
the video of the current position, right-click the
preview and click [Set Thumbnail Frame].

In full screen mode, right-click on it, and then
click [Full Screen Mode] or double-click on it.

(7) | [Cur:]

Indicates the current timecode.

(8)

Playback speed

Indicates the current playback speed (times).
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(9) | Scrubbing bar

Indicates the playback progress status and
markers of set In/Out points.

(10) | [Remain:]

Indicates the timecode of the remaining time.

Audio level

() display

Displays input audio level.

[Switch audio
level detail
display/VAR
speed control]

(12)

Switches to the audio level detail display or
VAR speed control.

Timecode Status display (R1/P1/P2
channel)»P140

VAR speed control (P1/P2 channel) »P151

[Clipl/

(13) [Playlist]

Switches to the clip view or playlist view.
P1/P2 channel (clip view) — 2ch/3ch view» P143
P1/P2 channel (playlist view) — 2ch/3ch
view»P144

(14) | [Remote]

Switches to the P1-remote mode (or P2-remote
mode).

(15) | [Unload]

Unloads the contents loaded on the P1 channel
(or P2 channel).

[Operation

(16) Button]

Operation buttons of P1/P2 channel» P145

> P1/P2 channel (clip view) — 2ch/3ch view

Cur: 00:06:;2;06
[ e
g P RdBEBBP 1P

(1) 2 @ @

*(1) to (9) are common in P2 channel.

(1) | [Zoom]

Switches the display scale of the scrubbing bar.
Clicking it displays [Zoom] in red, and displays
the In-Out pints of the clip as the whole scale.

Clicking it again returns the display to the
original scale and displays the whole clip.

(2) | [Clip:]

Indicates the name of the loaded clip.
Also allows to edit the clip name.

October 6, 2014
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3) | [Tag:] Indicates the tag for search of the loaded clip.
& Also allows to edit the tag.

Displays the properties of the clip currently

(4) | [Properties] loaded.

Indicates the In point timecode of the clip.

(5) | [Mark In:] Also allows to enter and edit the In point
timecode.

Indicates the Out point timecode of the clip.

(6) | [Mark Out:] Also allows to enter and edit the Out point
timecode.
(7) | [Set] Trims the clip between the set In-Out points.

Indicates the time length (duration) of the clip.

(8) | [Dur:] Also allows to enter and edit the timecode of
the duration.

Displays the In and Out points of the clip,
(9) | [Clip Contents] duration of the clip, video size of the clip, and
frame rate.

> P1/P2 channel (playlist view) — 2ch/3ch view
(1) (2) ®3) 4)

®)

*(1) to (5) are common in P2 channel.

Switches to the TRIM mode. You can edit the
In/Out points of the event selected in the event
(1) | [TRIM] list.

P1/P2 channel (playlist view) — 1ch view/TRIM
mode»P148

(2) | [Playlist Menu] | Displays the related menu.
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Indicates the name of the loaded playlist.
Also allows to edit the playlist name.

- [Playlist:]
(3) [P.Iayll.st.]./ Playlist in the normal format.
[Timeline:] o
[Timeline:]

Playlist in the timeline format.

Changing the playlist type»P169

Displays the properties of the playlist currently

(4) | [Properties] loaded.

Displays the list of events in the playlist.

By right-clicking the event, displays the related

menu.

The background color of the event indicates the

current status of the event.

¢ Red indicates that the event has the playback
position on the scrubbing bar.

(5) | Event list e Green indicates the next event of the event
that has the playback position on the
scrubbing bar.

* Blue indicates that the event is selected.

The background color of the event can be

changed to your preferred color.

[Playlist View Style:] dialog box (workstation

mode only)»P190

> Operation buttons of P1/P2 channel
(2) 5, @4) -, (6) -\ (8) ,(10) ,.(12) .\ (14)

(M7 @) 0 (M7 9) (1)) "(13)
P [AAADTE BB P 03 ek

(1) | [Cue(In)] Moves to the In point of the contents.

(2) | [Cue(Out)] Moves to the Out point of the contents.

In the TRIM mode of clip view or playlist
view, moves to the previous edit point (top
[Move to previous of the clip, In/Out point after trimmed) by
edit point] every click.

In the playlist view, moves to the In point
of the previous event.

3)
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(4) | [Rewind]

Rewinds the contents. By every click,
switches the speed to 2 to 32 times (5
levels) and plays in backward.

(5) [Move to the By every click, moves back the contents
previous frame] frame by frame.

(6) | [Stopl Stops playback.

(7) | [Play] Plays the contents.

(8) [Move to the next By every click, moves forward the contents
frame] frame by frame.

(9) | [FastFwd]

Fast forwards the contents. By every click,
switches the speed to 2 to 32 times (5
levels) and plays.

[Move to next edit

(10) point]

In the TRIM mode of the clip view or
playlist view, moves to the next edit point
(In/Out point after trimmed, end of the
clip) by every click.

In the playlist view, moves to the In point
of the next event.

If you play recording data, move to latest
recording point.

(11) | [Mark(In)]

Sets In point to the current position. After
In point has been set, the In point marker
appears on the scrubbing bar.

(12) | [Mark(Out)]

Sets Out point to the current position.
After Out point has been set, the Out point
marker appears on the scrubbing bar.

(13) | [Clear (In/0Out)]

Clears set In/Out points.

(14) | [Create Subclip]

Creates a sub clip between In-Out points
set while recording, and saves it as
highlight.
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> P1/P2 channel (clip view) — 1ch view

The display is same as that of P1/P2 channel (clip view) — 3ch view.
P1/P2 channel — 2ch/3ch view» P142

P1/P2 channel (clip view) — 2ch/3ch view» P143
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> P1/P2 channel (playlist view) — 1ch view/TRIM mode

The preview and operation button parts are same as that of P1/P2 channel
(playlist view) — 3ch view.

P1/P2 channel - 2ch/3ch view» P142

P1/P2 channel (playlist view) — 2ch/3ch view» P144

The elements which differ from that of P1/P2 channel (playlist view) — 3ch
view are described here.

(1 2E @

®)

*(1) to (7) are common in P2 channel.

Switches on and off of the TRIM mode.
Displayed in red during in the TRIM mode.

By clicking when in the TRIM mode, exits the
TRIM mode.

(1) | [TRIM]

Indicates the name of the loaded playlist.
Also allows to edit the playlist name.
[Playlist:]

Playlist in the normal format.

[Timeline:]

Playlist in the timeline format.

Changing the playlist type»P169

[Playlist:1/
[Timeline:]

()

Indicates the tag for search of the loaded
(3) | [Tag:] playlist.
Also allows to edit the tag.
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(4)

[Properties]

Displays the properties of the playlist currently
loaded.

(5)

[Current Event]

Displays the information of the event being
played.

[Event:]

Indicates the name of the event.

Also allows to edit the event name in the TRIM
mode.

[In:]
Indicates the timecode of the In point.

Also allows to edit the In point timecode in the
TRIM mode.

[Out:]
Indicates the timecode of the Out point.

Also allows to edit the Out point timecode in
the TRIM mode.

[Dur:]
Indicates the timecode of the length of the
event (duration).

Also allows to edit the timecode of the duration
in the TRIM mode.

[Set]
Displays only in the TRIM mode.
Trims between the set In-Out points.

(6)

[Playlist Menu]

Displays the related menu.

(7

Event list

Displays the list of events in the playlist.

By right-clicking the event, displays the related

menu.

The background color of the event indicates the

current status of the event.

¢ Red indicates that the event has the playback
position on the scrubbing bar.

* Green indicates the next event of the event
that has the playback position on the
scrubbing bar.

¢ Blue indicates that the event is selected.

The background color of the event can be

changed to your preferred color.

[Playlist View Style:] dialog box (workstation

mode only) »P190

October 6, 2014
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> Audio level detail display (P1/P2 channel)
(1(2)

(6) ®)

(1) | [<I/[>] Switches the detail display.

Selecting [Peak] makes the maximum level
to 0 dB.

Selecting [Ref] makes the set audio
Switching of display | reference level as the standard level.

scale You can set the audio reference level in
[Audio reference level:] from [General] ->
[Hardware] tab in the setting screen.
General — Hardware settings»P178

(2)

Adjusts the gain of each channel by moving

(3) | Gain slider the slider.

Displays the input audio level for each

(4) | Level meter track.

Allows to select the channel for
headphones, analog, and digital output.

(5) | Output channel Analog and digital output setting is
enabled even when a channel is not
selected.

(6) | [Close] By clicking, closes the audio level detail

display.
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> VAR speed control (P1/P2 channel)

(1

(2)®)

(1 | kI/>] Switches the detail display.

By every click, increases or decreases the
2) | [<I/>] playback speed by 0.01 time.

By clicking on the speed specifying bar or

e the value indicating the speed, specifies the

(3) | Sneed specifying bar playback speed within the range of -2 to +2

times.

By every click, increases or decreases the
@) | l«<li>>] playback speed by 0.1 time.
(5) | [Close] By clicking, closes the VAR speed control.

> Status bar

(1

(2)

(3)(4)(3) (6) 7 ®)

O

[3ch(2ch) Disp.1/
[1ch Disp.] switching

Switches 3ch(2ch) view and 1ch view.

(2)

Operation mode

Displays the current operation mode
(workstation mode/front panel mode).

3)

Log notification icon

Notifies a warning or error log with an icon
when it occurs. Clicking the icon displays
the [Log] dialog box and allows to check
the details.

(4)

[FTP]

Indicates that the FTP server of T2 is in use.

(5)

Transfer process
icon

Indicates an icon that notifies import,
export, or file conversion is in process.

(6)

[CPU]

Indicates the CPU load status of T2.
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Displays the estimated recording time
7) Remaining HDD available on HDD.
(remaining time) When the remaining capacity reduces, the
icon is displayed in red.
(8) | Time Displays t-he currfent ti-me.
Date and time setting dialog hox» P192

NOTE -« Ifthe icon appears on the status bar, there is a problem
with the RAID system. Consult the shop of purchase.

> Bin/transfer screen display part

Mm@ 6 @ (5|>)

Displays the bin view ([Bin] tab, [Browse]

(1) | [Folder] tab, [Recycle Bin] tab, and [Search] tab).

Displays the transfer screen.

(2) | [Transfer] Transfer screen»P157
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Switches to [Bin] tab/[Browse] tab/[Recycle

Bin] tab/[Search] tab.
. — [Bin] tab»P153
(3) | View switching tab [Browse] tab P154
[Recycle Bin] tabh» P155
[Search] tab»P156
(4) | [Config.] Displays the setting screen.
(5) | [X] Exits or restarts T2.
Displays the menu related to import.
(6) | [Import] The display switches to the [Browse] tab.
Import menu»P158
Displays the menu related to export.
(7) | [Export] The display switches to the [Bin] tab.
Export menu»P158
> [Bin] tab

®)

(1) | [New Bin] Creates a new bin.
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You can search contents in the bin.

(2) | [Search Contents] Searching for contents»P168

Displays the list of bins.
The selected bin is highlighted in blue.

Right-clicking the selected bin displays the
related menu.

(3) | Bin list

Displays the list of contents selected in the
bin list.

(4) | Contents list The selected item is highlighted in blue.

Right-clicking the selected contents
displays the related menu.

Displays the details of the contents selected
in the contents list.

(5) | [Detaill

> [Browse] tab

(4)

When a removable media is connected to
1| L[..] T2, you can select a folder to display in the
[Browse] tab.
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(2)

Removabhle media
list

Displays the removable media's media or

folders in the drive connected to T2.

The selected folder is highlighted in blue.

Right-clicking the selected folder displays
the related menu.

3)

Media file list

Displays the list of media files in the drive
selected from the removable media list.
The selected media file is highlighted in
blue.

Right-clicking the selected media file
displays the related menu.

(4)

[Detail]

Displays the details of the media file
selected in the media file list.

> [Recycle Bin] tab

)

@)

(4)

U

[Empty Recycle Bin]

Deletes all files in the recycle bin.

Note that the deleted contents cannot be
restored.
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Displays the list of folders in the recycle
bin.

The selected folder is highlighted in blue.

Right-clicking the selected folder displays
the related menu.

Recycle hin folder
list

(2)

Displays the list of contents in the folder
selected in the recycle bin folder list.

(3) | Contents list The selected item is highlighted in blue.
Right-clicking the selected contents
displays the related menu.

Displays the details of the contents selected

(4) | [Detail] in the contents list.

> [Search] tab

(4)

You can search contents in the bin.

(1) | [Search Contents] | o - ching for contents»P168
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Search result folder
list

(2)

Displays the list of folders of the search
result.

The selected folder is highlighted in blue.
Right-clicking the selected folder displays
the related menu.

(3) | Contents list

Displays the list of contents in the folder
selected in the search result folder list.
The selected item is highlighted in blue.
Right-clicking the selected contents
displays the related menu.

(4) | [Detail]

Displays the details of the contents selected
in the contents list.

> Transfer screen

Folder | Transfer

@)

(1) | [Deletel]

Deletes selected jobs. If you tap [Delete]
while executing a job, the job will be
canceled.

(2) | [Clear]

Deletes all jobs from the job list.

(3) | Job list

Displays the list of jobs.
[Clip]

Indicates the name of the clip.

[Status]
Indicates the job progress status.

[Bin]

Indicates the bin name.

[Path]

Indicates media file path and file name.
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> Import menu

[dmpart " Export [ Detal

When a removable media is connected to T2, you
can select a folder to display in the [Browse] tab
by clicking it.

[Add a new
connection...]

[Import the selected | Imports the media file selected in the media file
items...] list to T2 as a clip.

Imports all the media files in the folder selected

[Import all items...] from the removable media list.

[Import selected Imports still images with numbers that are serial
items as a sequence | to the selected still image as a single sequence clip
file...] (in Grass Valley HQ AVI).

> Export menu

" import [ Biport. " Detail

[Export the selected | Exports the selected contents as media files or T2
items...] format (TWF) files.

Exports the all items in the selected folder as

[Export all items...] media files or T2 format (TWF) files.
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Keyboard and mouse operations in workstation mode
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Multiple selection of contents

You can select multiple contents in the media file list, contents list, and
event list in the same way as PC operations.

Use the [Ctrl] key or [Shift] key on the keyboard or drag the mouse to
select multiple contents and perform operations from the right-click
menu.

In the event list, you can change the event order by the drag & drop
operation with a mouse. You can also sort the multiple events you
selected.

Loading contents to P1/P2 channel by drag & drop
operation

You can quickly load contents in the media file list and contents list to the
P1/P2 channel by drag & drop operation with a mouse.

1 Select contents and drag & drop it to the display area of the P1
channel (or P2 channel).

Adding events to playlist by drag & drop operation

You can quickly add events to the playlist by drag & drop operation with
a mouse.

You can also add the playlist to another playlist as an event without
spreading it out.

1 Select contents and drag & drop to the event list.
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The contents are added to the dropped position as an event.

Sorting events in playlist by drag & drop operation

You can quickly sort events in the playlist by drag & drop operation with
a mouse.

1 Select an event in the event list and drag & drop to the
destination.
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Replacing place holder by drag & drop operation

You can quickly replace place holders by drag & drop operation with a
mouse. You can replace a place holder when Kdis highlighted in red.

1 Select an event from the event list, and drag & drop it on the
place holder.

TIP e If the playlist view is set to the detail view, a place holder
cannot be replaced by drag & drop.

Major keyboard shortcuts

The following illustration shows the allocation of frequently used
keyboard shortcut keys (default).

Channel Select

T T T
15 Rif] |5 PILIZ P2,

Plﬁop l 4 ! »

Changing keyboard shortcut assignment

You can customize the shortcuts assigned to the keyboard.

The procedure to make a new keyboard shortcut setting based on the
default keyboard shortcut to change the shortcut key assignment is
described in this part.

1 Click [Option] on the menu bar, and then click [Customize] ->
[Keyboard Shortcuts...].
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> [Keyboard Shortcuts] dialog box

)

(4)

(1) )

(1)

[Keyboard
Shortcuts:]

Selects a keyboard shortcut to use.
The default name is “default”.

(2)

[Edit List]

Displays the [Edit List] dialog box and allows
to change the keyboard shortcut settings in the
items of new creation/copy/delete/name.

@)

Action category
switching tab

Switches the action category ([General] tab/
[Contents List] tab/[Playlist] tab).

(4)

[Command:]

Displays the list of actions of the selected
category.

()

[Enter the new
key:]

Enter a new shortcut key to assign to the
selected command.

(6)

[Set assign]

Assigns the shortcut key entered in [Enter the
new key:].

(7)

[Current keys:]

Displays the shortcut key assigned to the
selected command.

(8)

[Delete]

Deletes the shortcut key selected in [Current
keys:].

2 Click [Edit List].

3 In the [Edit List] dialog box, click [New...].

4 Enter a name of a keyboard shortcut and click [OK].

5 In the [Edit List] dialog box, click [Close].

6 Select the added shortcut setting from the list of [Keyboard
Shortcuts:] in the [Keyboard Shortcuts] dialog box.
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7 Select a category from the action category switching tab.

8 Select an action with [Command:].

9 Enter the shortcut key to assign in the entry area of [Enter the
new key:] and click [Set assign].

The entered shortcut key is displayed in [Current keys:].

10 Click [OK].

Click [Apply] to keep on making settings of other items.

Assigning commands to mouse operation

You can assign commands so that certain mouse operations performs
certain actions, such as loading a clip on the P1/P2 channel and playing it.
The procedure to create a new setting for mouse and assign the command
to the mouse is described in this part.

1 Click [Option] on the menu bar, and then click [Customize] ->
[Mouse...].

> [Mouse Customize] dialog box

(1 )

@)

(4)

[Mouse
settings:]

(1)

Selects a mouse setting to use.

Displays the [Edit List] dialog box and allows to
(2) | [Edit List] change the mouse settings in the items of new
creation/copy/delete/name.

Action category | Switches the action category ([Contents List]

) switching tab tab/[Playlist] tab).
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Displays the list of mouse operations of the

[Mouse operation mode selected in [Setting].

operation:]

(4)

Select a mouse operation to assign a command.

Displays the list of actions of the selected
category.

5) | [Command:

G| : Select a command to assign to the mouse

operation selected in [Mouse operation:].

Selects the operation mode of mouse from
[Single Click Mode], [Double Click Mode], and
[Single Click + Double Click].

Checking [Allow multiple selection] allows
multiple selections of contents by the mouse
operation.

(6) | [Setting]

Click [Edit List].
In the [Edit List] dialog box, click [New...].
Enter the name of the mouse setting and click [OK].

In the [Edit List] dialog box, click [Close].

o~ O A W DN

Select the added mouse setting from the list of [Mouse settings:]
in the [Mouse Customize] dialog box.

~N

Select the operation mode of mouse in [Setting].

8 Select a mouse operation to assign a command in [Mouse
operation:].

9 Select an action with [Command:].

10 Click [OK].

Click [Apply] to keep on making settings of other items.
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Recording sources at once (batch capturing)

You can import the batch capture list to your T2 and record sources from
VTR at once.
The batch capture lists in the following file formats can be imported.
e CSV file (Model/Mode2) (*.csv): Batch capture list created with EDIUS
* ALE file (*.ale): File corresponding to Avid Log Exchange batch capture
list
* FCL file (*.fcl): File corresponding to Apple Final Cut Pro batch capture
list
NOTE e After importing the batch capture list to your T2, you cannot
change In/Out points, duration, or reel name, and you cannot
add batch capture items.

Set the connection information of the VIR used for action setting of
batch capturing and for recording, or the video format for capturing
beforehand.

General — Hardware settings»P178

R1 settings»P193

Transfer — common settings» P205

Make settings in the setting screen according to the environment in use.
Settings»P177

The procedure to import a batch capture list and start recording is
described in this part.

1 Click the R1 channel tab.

R1 channel is selected.

R1 channel - 2ch/3ch view»P127

2 Click [VTR].

The mode switches to the R1-VTR mode.

3 Click [Batch].

The mode switches to the R1-VTR batch mode.
4 Click [Load Batch Capture List].

5 Select the batch capture list and click [OK].
The batch capture list appears.
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> R1-VTR batch mode
(12 3)

(4)

Duration: 0L 133,13

®) (6)

() [Load Batch Imports the batch capture list (CSV, ALE, FCL
Capture List] files).
Deletes a batch capture item.
) [Delete Batch You can also perform the same operation by
Capture Item] selecting and right-clicking an item, and then
clicking [Delete].
Sorts the batch capture items.
Selecting an item and clicking [Move Up] or
[Move Upl/ [Mov_e Down] moves an item up or down by
(3) one line.
[Move Down] :
You can also perform the same operation by
selecting and right-clicking an item, and then
clicking [Move Up] or [Move Down].
[Status]
Displays the recording progress. When an error
occurs, displays the error detail.
[No]
Batch captur
4) a1 capture Displays the serial number corresponding to
list : .
the suffix of the clip name generated after the
batch capture.
[Reel]
Displays the reel name.
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[In TC1/[Out TC]/[Dur TC]
Displays the timecode of In point/Out point/

duration.
) Batch capture The timecode to be prioritized when recording
list is underlined. To change the prioritized

timecode, select and right-click an item, and
then click [Change to "In/Out Capture"] or
[Change to "In/Dur Capture"].

Displays the total number of the batch capture
items.

(5) | [Count:]

Displays the total duration in the batch capture

(6) | [Duration:] list.

TIP * Select and right-click an batch capture item, and then click
[Select All] to select all items.

6 Press the [Rec] button.

If batch capture items with different reel names set exist in the batch
capture list, a message appears. Insert a tape corresponding to the reel
name into the VTR and click [OK]. (If the same reel names are set in all
batch capture items, or if no reel name is set, the message will not appear
and recording starts.)

Recording starts and the progress is displayed in [Status].

If you stop the batch capture in the middle, click [Stop].

Clips that have been completed recording are stored in the specified bin.

Displaying media files in network drive

October 6, 2014

You can display media files in the network drive at the [Browse] tab by
making settings of the network drive connected to T2 in the workstation
mode.

1 Click [Config.], and click the [General] -> [Network-3] tab.

General — Network-3 settings»P180

2 Click [Add..].

The [Map Network Drive] dialog box appears.
3 Assign a drive letter to [Drive:].

4 In the [Folder:] entry area, enter the “server name and shared
folder” or “IP address and shared folder”, and then click [OK].

You can click [Browse...] to specify the path of the network drive.
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5 Click [OK].

6 Display the [Browse] tab.

[Browse] tab»P154
The drive letter assigned in step 3 is displayed in the removable media list.

7 Click [...] at the right of the drive letter, and select a folder in the
network drive, and then click [OK].

The contents in the network drive are displayed in the media file
list.

TIP ¢ To save the specified recording destination on the external
media/storage after restarting T2, click [Config.], click [General]
-> [Miscellaneous] tab, and then check [Keep the connections
on the browse tab].

Searching for contents

You can specify search conditions and search for contents in the bin.
1 Click [Search Contents].

This operation is available in the [Bin] tab or [Search] tab.

Modified

[ 7f gjzo1z @~ T 7/ oj012 B

[Bin:] Select the search target bin from the list.
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Specify search conditions. If multiple
conditions are specified, AND search will be
performed.

[Name:]
Enter the contents name to search.

[Date:]
Select [Modified] or [Created], click the icon on
the calendar, and set the date.

[Search condition]

[Type:]
Select [SD] or [HD] from the list.

[Tag:]
Enter the tag added to the contents.

2 Select a search target bin from the list of [Bin:].

3 Specify search conditions and click [OK].

The search starts.

The contents that matches the search conditions are displayed in the
contents list in the search result folder of the [Search] tab.

[Search] tab»P156

TIP ¢ To change the search conditions, right-click the search result
folder and click [Change Search Criteria...].
¢ To delete the search result folder, right-click the search result
folder and click [Clear].
¢ To change the name of the search result folder, right-click the
search result folder and click [Rename].

Changing the playlist type

You can change the playlist type. In a playlist in the normal format, each
events are added without creating spaces. In a playlist in the timeline
format, events can be added to a desired position on the timeline by
specifying the timecode.

1 Right-click on the playlist in the bin and click [Properties].
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2 Click [Change...]

Playlist type

Playlist

(1) | [Playlist:]

Indicates the name of the loaded playlist.

(2) | [Type:]

Selects the playlist type from the list.
[Playlist]

Playlist in the normal format. You can add
clips, playlists, and placeholders.

Added events can be placed without spaces
between other events.

Creating a playlist»P109

[Timeline]

Playlist in the timeline format. You can set the
start timecode or duration of playlists and place
clips at desired positions by specifying the
timecode. Events that can be added are clips
only. The spaces between events are registered
as gap events, and a black screen is output
during gap event playback.
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Editing playlist in the timeline format

Set the timeline settings.

[Start time:]

Timeline Set start time of playlist.

Settings [Duration:]

Set duration of playlist. A duration cannot be
set when the duration is shorter than the total
duration of all events.

3)

3 Select a playlist type in list of [Type:].

TIP ¢ Playlist which are added place holder or playlist event cannot
be changed to timeline.
¢ Playlist duration cannot be set when the duration is shorter
than the total duration of all events.
* When timeline playlist change to playlist, the gap events are
change to the place holders.

4 Click [OK].

The playlist type is confirmed on the playlist view or properties.
P1/P2 channel (playlist view) — 2ch/3ch view» P144

Editing playlist in the timeline format

Adding, deleting, and moving events on the playlist in the timeline
format can be performed only in the workstation mode. Performing
playback and applying effects can be operated also on the front panel.
Editing a playlist»P109

Loading contents to P1/P2 channel by drag & drop operation» P159
Sorting events in playlist by drag & drop operation»P160

Creating playlist in the timeline format

After creating a playlist in the normal format, the playlist type can be
changed to the timeline format.

Changing the playlist type» P169

A playlist that includes clip events and gap events added before changing
the format will be created. The duration of the gap event is determined
automatically by the difference between the duration of the playlist and
clip event.
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Cur; 00:00:00;00 R

CURRAISE R =R

Adding event to playlist in the timeline format

1 Show the playlist view of timeline playlist.

2 Select events in the bin and then load contents to the playlist by
drag & drop operation.

Loading contents to P1/P2 channel by drag & drop operation»P159

> [Set start Timecode of Event] dialog box

he Out point of the event will autormatically be

ok T cCancel

(1) | [Event:] Indicates the name of the loaded event.

Sets the position and length of an event to be
added.

[Start time]

Enter the start timecode where an event is to
be added. You cannot add an event if this is
[Timeline indicated in red.

settings]

2
@ [To fit into the interval, the Out point of the event
will automatically be adjusted]

By checking this item, adds an event by
automatically trimming at the Out point if the
Out point of the clip to be added comes later
than the playlist duration.
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Editing playlist in the timeline format

TIP ¢ A gap event is added automatically on the timecode where an
event is not placed.
* An event cannot be added if In and Out points of the event to
be added do not exist within the playlist timeline.
* An event cannot be added if it overlaps with an event other
than a gap event that has already been added.

3 Specify the starting timecode of an event and click [OK].

The event is added. A gap event is added automatically on the timecode
where an event is not placed.

Cur: 00:00:00;00

a8 P A0S BB

Changing starting timecode of an event

1 Show the playlist view of timeline playlist.

2 On the playlist view, right-click on the event whose start
timecode is to be changed, and click [Set Start Timecode...].

3 Set the start timecode in [Set start Timecode of Event] dialog box.
[Set start Timecode of Event] dialog box»P172

TIP * An event cannot be added if it overlaps with an event other
than a gap event that has already been added.

4 Click [OK].

Deleting event from playlist in the timeline format

You can delete events from playlists in the timeline format.
Gap events cannot be deleted.

1 Right-click on the event in the playlist view and click [Delete].

2 Click [OK].
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Changing the display of playlist view

Changing the display of event list

You can switch the display of event list to the icon view or list view

without thumbnail.

1 Right-click on the event list and click [View] -> the display option
([Icons]/[Tiles]/[List]/[Details]).

TIP ¢ If keyboard shortcuts are assigned to events and one of [Icons]/
[Tiles]/[List] is selected for the view, an icon is displayed on the
thumbnail.

- A red icon indicates the shortcut assigned to the event of the
selected channel.

- A black icon indicates the shortcut assigned to the event of
the specified channel.

¢ If one of [Icons]/[Tiles]/[List] is selected for the view, you can

change the display size of the thumbnail. Right-click on the

event list and click [View] -> [Thumbnail Size] -> the display

size ([Large]/[Middle]/[Small]).

Changing the display or background color of events
You can change the settings of the event view style and background color.

1 Right-click on the event list and click [View] -> [Customize...].

The [Playlist View Style:] dialog box appears.
[Playlist View Style:] dialog box (workstation mode only) »P190

2 Configure the settings, and then click [OK].
Checking logs of operations and processes

Displaying a log

You can output logs of operations and processes. Use it to find out the

cause of troubles.

1 Click [Option] on the menu bar, and then click [Log] -> [Show
log...].
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Checking logs of operations and processes

> [Log] dialog box

Selects [Operation Log] to display operation
logs, and select [Process Log] to display process
logs.

Output log

() switching

Displays the list of groups for operations or
(2) | Group list processes. A group is created daily (or when
the log data exceeds 10 MB).

Displays the log list of the group selected in the

(3) | Log st group list.

(4) | [Description:] Displays the explanation for the log selected in
prion: the log list.

(5) | [Closel] Closes the dialog box.

Export the logs to external folder which is

(6) | [Export] selected.

TIP  * When an error occurs, you can also display the [Log] dialog
box by clicking the notification icon on the status bar.
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Changing log level settings

You can change the output log levels of operations and processes.
By the default setting, information, warning, and error will be output.

1 Click [Option] on the menu bar, and then click [Log] -> [Logging
level...].

> [Log Level Setting] dialog box

Selects the type of operation log to output.

[Error]
Outputs only error logs.

[Warning + Error]
[Operation Log] Outputs warning and error logs.

[Information + Warning + Error]
Outputs information, warning, and error logs.

[All]
Outputs all logs including debug information.

Selects the type of process log to output.

[Error]
Outputs only error logs.

[Warning + Error]
[Process Log] Outputs warning and error logs.

[Information + Warning + Error]
Outputs information, warning, and error logs.

[All]
Outputs all logs including debug information.

2 Configure the settings, and then click [OK].

176 T2 Elite/Pro/Express Users Guide October 6, 2014



Settings

Section

This section describes items that you can set in the setting screen.

Displaying the setting screen

You can make settings in the setting screen.

1 Tap [Config.].

The configuration screen appears.

> Settings

Transfer

Audio reference level :

Audio Input/Output level :

Default...

U

Main category

Switches the main category of each setting.
By tapping, displays the sub category tabs
included in the main category.

()

Sub category tab

By tapping, displays the detailed settings of
the sub category.

3)

[Default...]

Restores all the settings made in the setting
screen to the default.

To enable the settings, you must restart
your T2.

(4)

[OK]

Saves the current settings and closes the
setting screen.
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Closes the setting screen without saving the

(5) [Cancel] current settings.

Saves the current settings. You can keep on

(6) | [Apply] making settings of other items.

General settings

General — Hardware settings
You can set synchronization or audio level between an external device

connected to your T2.

1 Tap [General], and then tap the [Hardware] tab in the setting screen.

> [Hardware] tab

Hardware Network-1 | Network-2 |Network-3 =~ FTP | Share Folder | Misc.

- Reference : Internal

R1
P1
P2

Transfer
Audio reference level : ) v db

Audio Input/Output level : v dBu
GPI

iscellancous Default... Cancel

Selects a sync signal from [External], [Input],
and [Internal].

The signal status (NO SIGNAL/SYNC OK) will
be displayed in the lower line.

[P1:]
If the sync signal has been synchronized with
the P1 channel, displays [SYNC OK].

[P2:]
If the sync signal has been synchronized with
the P2 channel, displays [SYNC OK].

[Tri-Level HD H-shift:]

When HD3 value REF is used, adjusts REF
phase by entering a value. (Only when
[External] is selected.)

[Reference:]
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[Reference:]

[BB HD H-shift:]

When SD Black Burst REF is used for HD REEF,
adjusts REF phase by entering a value. (Only
when [External] is selected.)

[BB SD H-shift:]

When SD Black Burst REF is used for SD REF,
adjusts REF phase by entering a value. (Only
when [External] is selected.)

[Audio reference
level:]

Selects the audio reference level (Headroom)
from the list.

[Audio Input/Output
level:]

Selects the audio input/output level from the
list.

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

General — Network-1/Network-2 settings
You can make network settings of your T2.

1 Tap [General], and then tap the [Network-1] tab or [Network-2]
tab in the setting screen.

> [Network-1]/[Network-2] tab

Hardware | Network-1 | Network-2 ' Network-3 | FTP | Share Folder | Misc.

Local Area Connection 1 (Intel(R) 82579LM Gigabit Network Connection)

® Obtain an IP address automatically

R1

O Use the following TP address :

P1

P2

(®) Obtai DNS server address automatically

Transfer O Use the following DNS server addresses :

Default...

OK Cancel

[Obtain an IP address
automatically]

Uses DHCP and sets an IP address
automatically.

T2 Elite/Pro/Express Users Guide 179



Section 10 — Settings

Used to connect to the local area network by
specifying the IP address, subnet mask, and
default gateway:.

[IP address:]

[Use the following IP Specifies an IP address.
address:]
[Subnet mask:]

Specifies a subnet mask.

[Default gateway:]
Specifies a default gateway.

[Obtain a DNS server Uses DHCP and sets a DNS server address
address automatically] | automatically.

Used to connect to the local area network by
specifying the address of the preferred DNS
server and an alternate DNS server.

[Preferred DNS server:]
Specifies the address of the preferred DNS
server.

[Use the following DNS
server addresses:]

[Alternate DNS server:]
Specifies the address of an alternate DNS
server.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

General — Network-3 settings

You can set the network drive to connect with your T2.

1 Tap [General], and then tap the [Network-3] tab in the setting
screen.
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> [Network-3] tab

General
Network Drive

Drive Folder

R1

P1
P2

Transfer 4

* This list can be edited on workstation mode only.

Default... (0] ¢ Cancel

Displays the list of currently set network

Network drive list )
drives.

By clicking, displays the [Map Network Drive]
dialog box and adds a network drive.

[Add...] [Map Network Drive] dialog box (workstation
mode only)»P181
[Disconnect]” Disconnects the network drive.

*Only available in the workstation mode.

> [Map Network Drive] dialog box (workstation mode only)

Map Network Drive

[Drive:] Assigns a drive letter to a network drive.

Enter the “server name and shared folder” or
“IP address and shared folder” in the entry
[Folder:] area.

You can click [Browse...] to specify the path of
the network drive.

[Reconnect on next By checking, restores the network drive
bootup] allocations on the next start-up of T2.

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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General - FTP settings

You can configure FTP settings when T2 is used as FTP server, or
the destination when external FTP server is used for a file transfer
destination.

1 Tap [General], and then tap the [FTP] tab in the setting screen.

> [FTP] tab

Hardware |Network-1 | Network-2 |Network-3 | FTP | ShareFolder | Misc.

FTP Server

v
R1

P1
P2

Transfer
(i Limit the FTP transfer rate ording or playing.

512 Kbps

Default...
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[FTP Server]

Displays the FTP settings when T2 is used as FTP
server.

[Settings...]

By tapping, configures FTP settings for T2.
Tapping it displays the FTP setting dialog box for
T2 to configure the settings.

FTP setting dialog box for T2»-P184

[Start]
Sets and uses T2 as FTP server.

[Stop]
Releases the setting and stops using T2 as FTP
server.

[Limit the FTP transfer rate while recording or

playing.]

By checking, automatically restricts FTP transfer
rate while recording or playing. Tapping the
entry area allows to change the limit value of
the transfer rate. Different limit values can be
specified for uploading and downloading, and
when uploading and downloading are performed
simultaneously, the transfer rate will be the
double of the set value.

If this option is unchecked, the recording/
playback operations may not be performed
normally, therefore, we recommend that you use
the system with this option checked.

[FTP Export List]

Displays the list of the FTP servers set as file
transfer destinations.

[Add...]

Tapping it displays the FTP destination setting
dialog box to configure the destination server.
FTP destination setting dialog box» P184

[Delete]
Deletes a server from [FTP Export List].
[Change...]

Changes the server settings.
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> FTP setting dialog box for T2

User Name !

ftpuser

Password !
Max Clients : 5

Bin(root directory) : Default

OK Cancel

[User Name:]/
[Password:]

Enter a user name and password.

[Max Clients:]

Specifies the maximum number of users allowed

to access the FTP server of T2.

[Bin(root directory):]

Specifies the bin to store media files uploaded to

the root directory:.

> FTP destination setting dialog box

Setting Name: server

Host Name / IP Address:

Port Number: 21 (1-65535)

/Default
Example: /Default

Directory:

User Name:

Password;

Connection Test

[Setting Name:]

Enter the server setting name.

[Host Name/IP
Address:]

Enter the IP address or host name of the FTP

server.

[Port Number:]

Enter a port number (1 to 65535).

[Directory:]

Enter the address of file transfer destination

folder (bin).

[User Name:]/
[Password:]

Enter a user name and password.

[Connection Test]

By tapping, tests the FTP connection with the

entered user name and password.

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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General — Share Folder settings

You can make settings for the user account of T2 and shared folders such
as WatchFolder, direct access folder, etc.

TIP * Media files copied to the WatchFolder of the internal storage
will be deleted after the import operation.
¢ Direct access folder is read only.

1 Tap [General], and then tap the [Share Folder] tab in the setting
screen.

> [Share Folder] tab

Settings...

folder

Transfer

Default...

Sets the user account of T2. A user account is
required when you access the WatchFolder or
direct access folder in the internal storage.

[Settings...]

By tapping this, the dialog box to configure the
user account settings of T2 will be displayed. To
enable the settings, you must restart your T2.

User Accounts setting dialog box» P187

[User Accounts :]
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Monitors the specified WatchFolder and performs
import operation automatically. To enable the
settings, you must restart your T2.

Importing a media file on WatchFolder» P64

[Destination :]
Selects the saving destination bin for the media
files to be imported.

[Set folder in local storage as watch folder]

By checking, monitors the shared folder of the
internal storage as WatchFolder.

[Watch Folder] Indicates the WatchFolder name, and user name
and password to access the WatchFolder. To

enable the settings, you must restart your T2.

[Set external folder in external media / storage as

watch folder]

By checking, allows to set a folder on an external
media or storage as WatchFolder. To enable the
settings, you must restart your T2.

[Path :]
Specifies the folder to monitor as WatchFolder.

Directly accesses a media file in the internal
storage via Windows common internet file
system (CIFS). To enable the settings, you must
restart your T2.

Directly loading a clip recorded or being
recorded» P76

[Share a T2 media storage as share folder]

By checking this, the internal storage will be set
as a shared folder to share the saved media files,
which can be accessed from clients. Media files
that can be accessed are AVI (Grass Valley HQ)
and MXF (XDCAM) only.

[Direct access
folder] (T2 Elite only)

[Limit the operation(delete, rename) on T2 when

using media file]
By unchecking this, deleting or renaming of the

media files accessed from clients will be enabled
on T2.
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> User Accounts setting dialog box

User Name

Gvadmin

watchuser

[User Name:]/
[Password:]

Sets the user account. A user account is required
when a client access the WatchFolder or direct
access folder in the internal storage. You can
access all folders in the internal storage using any
account.

The default user name and password are as
follows.

(User Name) GVadmin (Password) adminGV!

(User Name) watchuser (Password)

watchpassword
[Add...] Add user account.
[Delete] Deletes a selected user account.
[Change...] Edit a selected user account.

TIP ¢ The user account setting is enabled after T2 is restarted.

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

General — Miscellaneous settings

You can configure display language for T2 software, restart status, or

other settings.

1 Tap [General], and then tap the [Miscellaneous] tab in the setting

screen.
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> [Miscellaneous] tab

Language :
DF mode :
Playlist auto scroll :

Playlist event template :
P2

Date and Time

Transfer

Default...

English
®DF ONDF

®oN  OoFfF

Settings...

Settings...

OK Cancel

[Language:]

Selects the display language for T2 software from
the list.

To enable the settings, you must restart your T2.

[DF mode:]

Select [DF] to set drop frame display to timecode,
or select [NDF] to set non-drop frame display.

[Playlist auto scroll:]

Sets whether to scroll the event list automatically
when playing a playlist.

[Playlist event
template:]

By tapping [Settings...], sets the effect as the event
template of the playlist. The template setting is
applied to newly added events.

The event template setting dialog box»P189

[Playlist View
Style:]"

By clicking [Settings...], changes the settings for
event display or event background color in the
workstation mode.

[Playlist View Style:] dialog box (workstation mode
only)»P190

[Playlist
Placeholder]™

By clicking [Settings...], configures the settings
to secure the space for events to be added to
playlists before actually adding an event to a
playlist.

[Playlist Placeholder] dialog box (workstation mode
only)»P191

[Preview update
interval:]"

By clicking [Settings..], sets the update interval of
preview of the R1/P1/P2 channel.

[Preview update interval:] dialog box (workstation
mode only)»P191

[Date and Time :]

By tapping [Settings..], sets the date and time.
Date and time setting dialog box» P192
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Sets whether to restore the status of the time
when exiting T2 at the next start-up.

[Keep the connections on the browse tab]

By checking, restores the removable media
connection status displayed in the [Browse] tab.
The removable media state displayed in the
[Browse] tab will be updated at the next start-up.

[Automatically playback the mounted contents on

P1/P2]
[Status at the next By checking, restores the contents status loaded
startup] to the P1/P2 channel.

By checking [Keep the playback frame positions

on P1/P2], restores the scrubbing bar playing

position.

Checking [Automatically playback the mounted

contents on P1/P2] plays the contents loaded to

the P1/P2 channel automatically at the next start-

up.

* The names or In/Out points of media files
loaded directly from the [Browse] tab cannot be
restored.

*1 Only available in the workstation mode.

> The event template setting dialog box

Start Effect  End Effect

O Fade In

frames (1 - 300)

Default

Sets the effects for event starting (start effects).

Eff
[Start Effect] tab Event — [Start Effect] tab» P113

Sets the effects for event ending (end effects).

End Eftectitab 1 £vent - [End Effect] tabwP114

[Default] Deletes event template settings.
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> [Playlist View Style:] dialog box (workstation mode only)

[Current Event
Background Color:]

Sets to show/hide the background color
indicating that the event has the playback
position on the scrubbing bar.

To change the background color, check this
item and specify the value for R, G, and B. The
specified color is displayed on the right.

[Next Event
Background Color]

Sets to show/hide the background color
indicating the next event of the event that has the
playback position on the scrubbing bar.

To change the background color, check this

item and specify the value for R, G, and B. The
specified color is displayed on the right.

[Selected Event
Background Color]

Sets to show/hide the background color
indicating the selected event.

To change the background color, check this
item and specify the value for R, G, and B. The
specified color is displayed on the right.

[Show keyhoard
shortcuts(A-Z,
Function, 0-9 Key
only)]

Sets to show/hide the keyboard shortcut icon

assigned to the event.

* Icons can be shown only when the [A] to [Z]
keys, function keys, and [0] to [9] keys on the
keyboard are assigned.

[Show progress bar]

Sets to show/hide the progress bar of the
playback.
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> [Playlist Placeholder] dialog box (workstation mode only)

Placeholder

e (the content

Sets the duration of the place holder (hour/

[Duration:] minute/second).

Allows to select the replace mode from the list if
the duration of the source is longer than that of
the set place holder.

[Replace]
[Replace mode (the | Replaces with a place holder maintaining the
content duration length of the source.
is longer than the [Replace from start]
placeholder's):] Replaces only the duration of the place holder

from the In point.

[Replace from end]

Replaces only the duration of the place holder
from the Out point.

[Show event
property when
adding]

By checking, displays the property screen of the
place holder.

> [Preview update interval:] dialog box (workstation mode only)

Interval of Preview Update

upch

Update [ ~

ower the CPU usage for better user

To set the update interval of preview
[Update mode:] automatically, select [Auto], and to set it manually,
select [Manual].
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[R1:1/
[P1, P2: Update
every]

Set when [Manual] is selected in [Update mode;].
Enter the number of frames in [frames] of [R1]
or [P1, P2: Update every]. If the value is larger,
the preview update interval becomes longer.

(By default, the preview is updated every two
frames.)

If you do not want to update the preview,
uncheck [Update preview].

> Date and time setting dialog box

Date and Time
Date :

6/10/2013 B

ings in maintenance mode.

Internet Time
Bk with an Internet time

Time :

18:00:01 B 18:00:01

Cancel

[Date :] By clicking the icon on the calendar, sets the date.
[Time :] Sets the time.

Displays the current time zone setting. This
[Time zone ] setting can be changed in the maintenance mode.

For more information about the maintenance
mode, refer to the T2 Maintenance Manual.

[Internet Time]

Checking [Synchronize with an Internet time
server], and then restarting or clicking [Update
now] synchronizes with the Internet time server.
Synchronization of time can be set from 1 to 24
hours. (Workstation mode only)

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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R1 settings

R1 - Input Settings
You can make settings for input format to record in the R1 channel.

1 Tap [R1], and then tap the [Input Settings] tab in the setting
screen.

> [Input Settings] tab

Input Settings | Timecode & Remote [ Capture

General

P1
P2

Transfer

Default... Cancel

[Input type:]
Selects the port used for video input.

[Input format:]
Selects the format for video input.

[Aspect:]
[Video] For SD input, selects the aspect ratio.

[Pedestal:]

Selects the setup level (black level) for NTSC
from OIRE and 7.5IRE. OIRE is used in Japan,
and 7.5IRE is used in North America.
Checking [Correct white peak] performs white
peak correction.

[Input type:]
[Audio] Selects the port used for audio input from
[Analog], [Digital], and [SDI-Embedded].
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[File type :]

Selects the compression format from [Grass
Valley HQ(AVI)], [XDCAM HD422(MXF)],
[XDCAM HD(MXF)], [XDCAM IMX(MXEF)],
and [XDCAM DV(MXEF)].

[Bitrate :]

Selects a bit rate that supports the compression
format.

[HQ 150Mbps MAX]
By checking, restricts the compression ratio of
Grass Valley HQ Codec to 150 Mbps.

_ [Audio format :]
[Compression] Selects an audio format that supports the
compression format.

[ClosedGOP]

By checking when the format is MXE, the
information are closed within GOP. It increases
the data size, but allows re-editing with editor
software that can handle GOP. Uncheck it
normally.

[Allow to edit growing MXF File]

By checking when the format is MXE, the
captured MXF file is supported growing clip
and FTP export.

Uncheck it normally.

TIP * You can load a file being recorded to an external media/storage

to editing software, and operate time-shift editing.
Loading and editing T2 contents to editing software» P74

* When recording data in Grass Valley HQ (AVI format), chasing
playback is available.
Loading and playing back video currently recorded (chasing
playback)» P101

* You can select 16bit 2ch or 24bit 8ch audio when recording via
SDI.
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NOTE * When recording data in the MXF (XDCAM HD422/HD/IMX/
DV) format, playback cannot be operated on all of the sources.
The playback will be stopped.
* When recording data in the MXF (XDCAM HD422/HD/IMX/
DV) format, chasing playback, chasing export, and format
conversion are not available.

Loading and playing back video currently recorded (chasing playback)»P101

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

R1-Timecode & Remote settings

You can make settings for the timecode or R1 channel remote control
when recording in the R1 channel.

1 Tap [R1], and then tap the [Timecode & Remote] tab in the

setting screen.

> [Timecode & Remote] tab

P —
Input Settings | Timecode & Remote | Capture

Caee Select Timecode

P2
Record ancillary data

Remote Protocol (VTR Mode) ¢

AN
1

Transfer

Default... Cancel

Selects the timecode type from [TC(LTC)] and

[Select Timecode] [SDI (VITC)].

Selects the timecode to use for recording.

To use the timecode of an external device,
select [External].

[Recorded Timecode] To use the time of T2, select [Internal - System
time).

If [Internal - Specified start TC] is selected, tap
the entry area and specify the timecode.
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[Record ancillary datal

Sets whether to save the VANC data when
recording.

If “ON” has been selected and video with
ancillary data is recorded, the video with
ancillary data can be played back on T2.

For XDCAM HD or XDCAM HD422 MXF
format data, stores the ancillary data according
to SMPTE 436M. In this case, ancillary data can
be exported to a device that supports SMPTE
436M.

[Remote Protocol (VTR

When controlling a VIR from T2 in the R1-VTR
mode, selects remote protocol (AMP/BVW).

Mode):] If [AMP] is selected, set the IP address and
channel of the VTR in [AMP Connection].
When controlling a T2 from an external
IR i controller in the R1-remote mode, selects a
emote remote protocol (AMP/BVW).
Protocol(Remote . . .
Mode):] Check [Enable local operations while being

remote controlled.] to operate T2 locally even in
the remote mode.

TIP ¢ If [Enable local operations while being remote controlled.] is
checked, the operations available in the R1-remote mode are as

follows.

- Recording and stop

- Entering a clip name

- Editing tags (workstation mode only)
- Displaying properties

- Unloading clips

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

R1 - Capture settings

You can set whether to automatically export files being recorded in the R1

channel.

1 Tap [R1], and then tap the [Capture] tab in the setting screen.
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> [Capture] tab

R1 settings

Input Settings | Timecode & Remote | Capture

General

Capture

Destination settings :

Default...

Cancel

[Destination

() settings :]

Indicates the saving destination of the clips to
be recorded and other information.

Tapping [Settings...] allows to set the saving
destination.

Saving destination dialog box» P198

[Split the clip
when the input
signal has
discontinued.]

(2)

By checking, divides clips when the input
sinal has discontinued.

[Split clip when
(3) | time code has
discontinued.]

By checking, divides clips when saving.

[Automatically
(4) | export a clip
being recorded.]

By checking, exports the file being recorded
in the R1 channel to the specified location
automatically.

(5) | [Export path:]

By tapping, allows to specify the export
destination.

October 6, 2014
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> Saving destination dialog box

Destination

Clip naming rules

Set the naming rules for ingested clips.

Clip

Cancel

Selects the saving destination of the clips to be
recorded.

To save the clips to T2, select [Save to internal
storage.], and then select the bin that is registered
to T2 from the list. In the workstation mode, clips
[Destination] can be stored in the selected bin.

To save the clips to a destination other than T2,
select [Save to external media / storage.].

If <non-registered> is indicated, set the external
storage in advance.

Displaying media file in removable media» P55

Sets the naming rule of clips to be saved.
Tapping the entry area allows to enter the clip
name.

Clicking [...] enters [Date] and/or [Time] after the
[Clip naming rules] | clip name automatically.

If the name of the clip to be recorded next has
been set in the R1 channel, the clip name setting
for the next recorded clip is prioritized.

R1 channel - 1ch view» P44

TIP ¢ If the data cannot be saved to an external storage at the time
when recording starts, it is saved to the internal storage.
¢ If writing does not catch up, the recording will be stopped.
¢ For external media/storages that have been operation verified,
see our website.

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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P1/P2 settings

P1/P2 - Video settings

You can make settings for output format to load video to the P1/P2

channel and play it.

1 Tap [P1] (or [P2]), and then tap the [Video] tab in the setting

screen.

> [Video] tab

Video | Monitor & Remote | ProcAmp

General

R1

P2

Default...

i _suam e ramd far

OK Cancel

[Format:]

Selects the format for video output.

[DVI option:]

When DVI/RGB output format is used, selects
the resolution to use.

[Output capability]

According to the items selected in [Format:]
and [DVI option:], displays the ports available
for output with green highlights.

[Aspect:]

For SD, selects the aspect ratio from [4:3] and
[16:9].

[Component type:]

Selects the analog signal type output from the
DVI-I port.

[Pedestal:]

Selects the setup level (black level) for NTSC
from OIRE and 7.5IRE. OIRE is used in Japan,
and 7.5IRE is used in North America.
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Selects the display mode when playback has

paused.

Selecting [Field] performs field corrections

[Still image:] between stql images. The video is displayed in
a smooth still image.

Selecting [Frame] displays the top field and

bottom field alternately. The video is displayed

to be shaking.

Selects how conversion is to be performed
when the aspect ratio of the source loaded to
the P1 channel (or P2 channel) differs from the
channel settings.

Selecting [Bars] displays black bars in the
upper and lower or in the right and left.

e |21
— [l

Conversion:] Q

Selecting [Crop] cuts the upper and lower parts
or the right and left parts.

O| =[O
O |=— | O

Checking [Auto Play] automatically plays
[Auto play mode:] the video when a source is loaded to the P1
channel (or P2 channel).

[Automatically mount | By checking, automatically loads a source
a clip being recorded being recorded in the R1 channel to the P1
on the player, when it's | channel (or P2 channel) when the source
ready for playback.] become transmittable.

[When a subclip
is created in R1, By checking, automatically adds a sub clip
automatically mount created in the R1 channel to a playlist loaded to
it in the playlist of the | the P1 channel (or P2 channel).

player.]
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NOTE * Even when [Automatically mount a clip being recorded on
the player, when it's ready for playback.] or [When a subclip
is created in R1, automatically mount it in the playlist of the
player.] was checked, they do not work in the following cases.

- The specified channel is locked or the sync mode is set to on

- The specified channel is in the Fill/Key signal output mode

- The specified channel is in the remote mode (except when
the local operations are enabled in the remote mode)

- Recording of the MXF format data is being performed

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

P1/P2 — Monitor & Remote settings

You can make settings for the monitor output from P1/P2 output section
and remote control of P1/P2 channel.

1 Tap [P1] (or [P2]), and then tap the [Monitor & Remote] tab in
the setting screen.

> [Monitor & Remote] tab

Video | Monitor & Remote | ProcAmp

General
Monitor out

R1

P2 Playlist Rermnain TC :

Transfer Remote
Remote protocol &

(J Enable local operations while being remote controlled.

Default... OK Cancel
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[Monitor out]

Makes settings for monitor output.

[Channel:]
Selects the channel for monitor output.

The channel that can be output from the P1
output section is fixed to [P1].

The channel that can be output from the P2 output
section is selectable from [R1], [P1], and [P2].

[0SD:]

Selects whether to show the on-screen display
on the monitor.

Checking [Show Cur timecode] displays the
current timecode on the on-screen display.
Checking [Show Remain timecode] displays
the remaining time on the on-screen display.

[Playlist Remain TC:]

Selects the display style for the remaining time
of playlist for on-screen display.

Selecting [Event] displays the remaining time
of the event.

Selecting [Total] displays the remaining time of
the whole playlist.

[Remote protocol:]

When controlling T2 from an external
controller in the P1-remote mode (or P2-remote
mode), selects a remote protocol (AMP/BVW/
TC Chase).

Overview of AMP control»P224

Overview of BVW control»P225

Overview of TC Chase control»P225

[Settings...]
Can be selected when TC Chase is selected for
the remote protocol.

TC Chase setting dialog box» P203

[Enable local
operations while being
remote controlled.]

By checking, allows to operate T2 locally even
in the remote mode.

Rewinds a short duration of time before the In

(Preroll:] point and starts playback from the point.
Allows to set the playback duration by the
[Postroll :] seconds in order to play back video later than

the Out point.
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TIP ¢ If [Enable local operations while being remote controlled.] is
checked, the operations available in P1-remote mode (or P2-
remote mode) are as follows.

- Scrubbing bar operations (workstation mode only)

- Playback control operations (move to the first frame, rewind,
frame reverse, stop, playback, frame forward, fast forward,
and move to the last frame)

- Moving to In/Out points, setting In/Out points, deleting In/
Out points, creating sub clips

- Switching display scale of the scrubbing bar

- Switching audio level display

- Creating thumbnail

- Entering names of clips/playlists

- Editing tags (workstation mode only)

- Entering values for In point/Out point/duration, setting In
point/Out point/duration

- Editing playlist events list (add, delete, sort, copy, paste, and
change names)

- Displaying properties

- Loading and unloading clips/playlists

- Switching on/off for the sync mode, E to E mode, Loop mode

- Operations with buttons on the lower part of the LCD

> TC Chase setting dialog box

Chanrel :

Timecode Chase
When the input LTC is

Offset :
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Configures settings regarding the TC Chase
control.

[When the input LTC is lost :]

Sets the operation when the input LTC is lost.
Select [Continue playback] to continue playback
along the input timecode. Select [Stop playback]
to stop playback.

[Internet Time] [Offset ]

Sets the offset for the input LTC.

Select [Off] not to be set for the offset and to play
back with the same timecode as the input LTC.
Select [On] to set the offset with a desired number
of frames (-15 to 15 frames).

This is locked with the offset value set for the
input LTC.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

P1/P2 - Image quality adjustment settings

You can make adjustment of the image quality when video is composite
output or SD component output from the P1/P2 channel.

1 Tap [P1] (or [P2]), and then tap the [ProcAmp] tab in the setting
screen.

> [ProcAmp] tab

Video | Monitor & Remote | ProcAmp

General

R1

P2

Transfer

Restore default

Default... Cancel

[Video gain
(Composite, SD Adjusts the Y gain.
Component)]
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[Chroma gain
(Composite, SD
Component)]

Adjusts the C gain.

[Chroma phase
(Composite)]

Adjust the color of video.

[Black level
(Composite, SD
Component)]

Adjusts the black level.

[Video output
level (Composite,
Component)]

Performs fine adjustment of amplitude.

[Restore default]

Restores the settings made in the [ProcAmp]
tab to default.

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.

Transfer settings

October 6, 2014

Transfer — common settings

You can make settings for file transfer.

1 Tap [Transfer], and then tap the [Common] tab in the setting

screen.
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> [Common] tab

Common | AVCHD AV

General

R1 Clip import configuration

Field ¢ Tpor

XDCAM Playlist

-

Confiaure imnort of imaae and images in a seauence format

Default...

OK Cancel Apply

[Pause file transfers
while recording or
playing out.]

By unchecking, enables transfer and conversion
even during a recording or playback. However,
if this option is unchecked, the recording/
playback operations may not be performed
normally, therefore, we recommend that you
use the system with this option checked.

[Clip import
configuration]

Selects the field order when importing
Windows Media Audio and H.264 (QuickTime
Video (avcl)). Selecting [Auto] automatically
selects and sets the appropriate field order.
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Sets the frame size and scaling method when
importing media files that do not match the
profile supported by T2.

[Size:]

Selects the frame size for import.

[Scaling:]

Selects the scaling method when the frame size of
the imported source differs from that set in [Size:].

Selecting [Bars] displays black bars in the upper
and lower or in the right and left, to fit the long
sides of the frame of the source to that set in [Size:].

@ ]=[0]
—=1o]

[Configure clip import Q
(for not supported
profile)]

Selecting [Crop] cuts the upper and lower parts
or the right and left parts, to fit the short sides
of the frame of the source to that set in [Size:].

0| =[O
O |==

Selecting [Stretch] stretches or reduces the
whole image, to fit the frame size of the source
to that set in [Size:].

O
O

O
O

—
—
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Makes settings for import of still images or
sequence still images.

[Format:]
Selects the format for import.

[Aspect:]
For SD, selects the aspect ratio from [4:3] and [16:9].

[Scaling:]

Selects the scaling method when the frame size
of the imported source differs from that of the
format set in [Format:].

Selecting [Bars] displays black bars in the upper
and lower or in the right and left, to fit the long
sides of the frame of the source to that of [Format:].

©]=[0]
= [o]

[Configure import of Q
image and images in a
sequence format]

Selecting [Crop] cuts the upper and lower parts
or the right and left parts, to fit the short sides
of the frame of the source to that of [Format:].

O] =
—

O

Selecting [Stretch] stretches or reduces the
whole image, to fit the frame size of the source
to that of [Format:].

O |= |0
O] =

O O

[Duration(still image):]
Sets the playback duration of the imported still
images by seconds.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — AVCHD settings

You can make settings for the format to import AVCHD sources.

1 Tap [Transfer], and then tap the [AVCHD] tab in the setting
screen.

> [AVCHD] tab

Default... OK Cancel Apply

[File format after import:]
Selects whether to import the file in the native

[AVCHD Import format or in a converted format at the time of
Settings] import.
Selecting [HQ] converts the files to Grass
Valley HQ AVI format.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — AVI settings

You can make settings for the format when converting contents in Grass
Valley HQ AVI format to MXF (XDCAM format) to export.

1 Tap [Transfer], and then tap the [AVI] tab in the setting screen.

> [AVI] tab

Common | AVCHD AV

General
R1
P1

P2

Default... (0] ¢ Cancel Apply

[Execute transcoding when exporting AVI file.]
[AVI Export Settings] By checking, converts files to the format set in
[Advanced AVI transcoding settings] to export.

[File type:]
Selects the file type.

[Format:]
Selects the format.

[Quality/Speed:]
Selects the quality.

[Scaling:]

Selects the scaling method when the frame size
[Advanced AVI of the exported contents differs from that of the
transcoding settings] format set in [Format:].

Selecting [Bars] displays black bars in the
upper and lower or in the right and left, to fit
the long sides of the frame of the contents to
that of [Format:].

©]=[0]
— o]

O
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[Advanced AVI
transcoding settings]

Selecting [Crop] cuts the upper and lower parts
or the right and left parts, to fit the short sides
of the frame of the contents to that of [Format:].

O
O

Selecting [Stretch] stretches or reduces the
whole image, to fit the frame size of the
contents to that of [Format:].

O O
O O

[Audio format:]
Selects the audio format.

[ClosedGOP]

By checking, the information are closed within
GOP It increases the data size, but allows
re-editing with editor software. Uncheck it
normally.

—> | O
—

—
—

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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Transfer — MXF settings

You can make settings for the format to import MXF sources.
1 Tap [Transfer], and then tap the [MXF] tab in the setting screen.

> [MXF] tab

[ cCommon [ AvcHD AV MXF

General
MXF Import Settings
Fi rimport:
R1

Default... (0] ¢ Cancel Apply

[File format after import:]

Selects whether to import the file in the native
format or in a converted format at the time of

import.

Selecting [AVI(HQ)] converts the files to Grass
Valley HQ AVI format.

[MXF Import Settings]

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.

212 T2 Elite/Pro/Express Users Guide October 6, 2014



Transfer settings

Transfer — XDCAM settings

You can make settings for the format to import XDCAM sources or
XDCAM EX sources.

1 Tap [Transfer], and then tap the [XDCAM] tab in the setting
screen.

> [XDCAM] tab

[ common [ AvcHD AVT MXF

General
XDCAM Import Settings
Fil mport:
R1

XDCAM EX Import Settings
File mport:

Default... OK Cancel Apply

[File format after import:]
Selects whether to import the file in the native

[XDCAM Import format or in a converted format at the time of
Settings] import.
Selecting [HQ] converts the files to Grass
Valley HQ AVI format.

[File format after import:]
Selects whether to import the file in the native

[XDCAM EX Import format or in a converted format at the time of
Settings] import.
Selecting [HQ] converts the files to Grass
Valley HQ AVI format.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — P2 settings

You can make settings for the format to import P2 sources.

1 Tap [Transfer], and then tap the [P2] tab in the setting screen.

> [P2] tab

[ cCommon [ AvcHD AV MXF

General
P2 Import Settings
Fi rimport:
R1

Default... (0] ¢ Cancel Apply

[File format after import:]

Selects whether to import the file in the native
format or in a converted format at the time of
import.

Selecting [P2 MXF (OP-Atom)] imports the
source in the native format.

Selecting [MXF (OP-1a)] converts the files to
MXF (OP-1a).

Selecting [HQ] converts the files to Grass
Valley HQ AVI format.

[P2 Import Settings]

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — GF settings

You can make settings for the format to import GF sources.

1 Tap [Transfer], and then tap the [GF] tab in the setting screen.

> [GF] tab

General

R1

Default... OK Cancel Apply

[File format after import:]

Selects whether to import the file in the native
format or in a converted format at the time of
import.

Selecting [GF MXF (OP-Atom)] imports the
source in the native format.

[GF Import Settings]

Selecting [HQ] converts the files to Grass
Valley HQ AVI format.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — QT settings

You can make settings for the format to import GF sources.

1 Tap [Transfer], and then tap the [GF] tab in the setting screen.

> [QT] tab

Common | AVCHD AV MXF

General
ime Import Settings
mport:

Default... (0] ¢ Cancel Apply

[File format after import:]

Selects whether to import the file in the native
format or in a converted format at the time of
import.

Selecting [QuickTime] imports the source

in the native format. If the format of the file
does not support the native format import,

it is converted to Grass Valley HQ AVI
automatically.

Selecting [HQ)] converts the files to Grass
Valley HQ AVI format.

[Quick Time Import
Settings]

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Transfer — Playlist settings

You can make settings for the format to export playlists.

1 Tap [Transfer], and then tap the [Playlist] tab in the setting
screen.

> [Playlist] tab

Common | AVCHD AVI MXF

Play!|

Default... (0] ¢ Cancel || Apply

[File format after export:]

Selects the format for export.

[Playlist Export Selecting [MXF(XDCAM)] converts the files to
Settings] MXE (XDCAM) and exports it.

Selecting [HQ] converts the files to Grass
Valley HQ AVI and exports it.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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GPI settings

GPI - Input settings

You can make settings to control T2 with GPI input.

1 Tap [GPI], and then tap the [Input] tab in the setting screen.

> [Input] tab

Input [ Cutput

GPI-Input 1

Or: Op1 Op2

Stop

® High

Default...

O Low

OK Cancel

Apply

[GPI-Input]

Displays the number of the selected GPI input
pin.

Tap [Previous] or [Next] and select a GPI input
pin to set.

[Trigger settings]

Sets the GPI input trigger.

[Channel:]
Selects the channel to control with GPI input.

[Action:]

Selects the action when the GPI input pin
selected in [GPI-Input] is input.

List of actions for trigger setting»P218
[Active:]

Selects the GPI signal to activate from [High]
and [Low].

> List of actions for trigger setting

[Stop]

Stops playback or recording.

[Play]

Plays the contents loaded to the channel.

[Record]

Starts recording.
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[Rewind]

Rewinds contents. When it comes to the
beginning of the loaded contents or when
performing another operation, rewinding
stops.

[FastFwd]

Fast forwards contents. When it comes to the
end of the loaded contents or when performing
another operation, fast forwarding stops.

[CueStart]

Moves to the In point of the loaded contents.

[CueEnd]

Moves to the Out point of the loaded contents.

[Eject]

Unloads the loaded contents.

[Preview]

Loads the clip that is loaded to the R1 channel
to the P1 channel.

[CueNextEvent]

When loading a playlist, moves to the next
event of the selected event.

[CuePrevEvent]

When loading a playlist, moves to the previous
event of the selected event.

[VARPlayback]

Performs variable playback of the loaded
contents in the speed specified in [VAR
setting:].

Miscellaneous - Jog/Shuttle settings» P221

[VARPIay+0.1]

Increase playback speed by x0.1.

[VARPlay-0.1]

Decrease playback speed by -x0.1.

[VARPIay+0.01]

Increase playback speed by x0.01.

[VARPIay-0.01]

Decrease playback speed by -x0.01.

[Keyboard Shortcut]

Assign GPI Input 1 - 6 to a key on the
keyboard. When GPI input is active, the
keyboard shortcuts will be active.

Major keyboard shortcuts»P161

2 Set each item and tap [OK].

Tap [Apply] to keep on making settings of other items.
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GPI - Output settings

You can make settings to control external devices by T2 with GPI output.
1 Tap [GPI], and then tap the [Output] tab in the setting screen.

> [Output] tab

Input | Output

General
GPI-Output 1

R1
Settings
Name : boo
P1 22
@ Hgh O Low
P2 I Trigger

Transfer * GPT-Outputs in Trigger mode are available on P1 only.

Default... OK Cancel Apply

Displays the number of the selected GPI output pin.

[GPI-Output] Tap [Previous] or [Next] and select a GPI
output pin to set.

Sets the GPI output trigger.

[Name:]
Sets the name of the GPI output trigger.

[Active:]
Selects the GPI signal to activate from [High]
and [Low].

[Mode:]

Sets the GPI output trigger mode.

[Settings] Selecting [Trigger] controls an external device with
GPI output by specifying a trigger for an event in
the playlist loaded to the P1 channel of T2.
Selecting [Tally-R1] outputs tally signal from
GPI and lights up the tally lamp of the external
monitor while recording in the R1 channel.
Selecting [Tally-P1] (or [Tally-P2]) outputs tally
signal from GPI and lights up the tally lamp

of the external monitor while playing in the P1
channel (or P2 channel).

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Other settings

Miscellaneous — Jog/Shuttle settings
You can make settings for operations of the jog/shuttle.

1 Tap [Miscellaneous], and then tap the [Jog/Shuttle] tab in the
setting screen.

> [Jog/Shuttle] tab

Jog/Shuttle = AMP [Remote

General
Shuttle speed : 16

Ri VAR setting ¢ 1/8

Default...

Selects the maximum speed for playback when

[Shuttle speed:] playing with the jog/shuttle.

Selects the playback speed when
[VAR setting:] [VARPlayback] is selected in [Trigger settings]
in the [GPI] -> [Input] tab of the setting screen.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Miscellaneous — AMP settings

You can make settings for the AMP command actions when you control
T2 from an external device with the AMP command.

1 Tap [Miscellaneous], and then tap the [AMP] tab in the setting
screen.

> [AMP] tab

Jog/Shuttle | AMP | Remote

General
Command behavior

EraselD :
R1

P1

P2

GPI

- Default...

[EraselD:]

Makes settings for the actions of Erase ID
command of AMP.

[Command hehavior] Selecting [Recycle] moves the contents to the
recycle bin.

Selecting [Delete] deletes the contents
completely.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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Other settings

Miscellaneous — Remote settings

You can make settings for the remote actions when you control T2 from an
external device with the GPI/RS422 command.

1 Tap [Miscellaneous], and then tap the [Remote] tab in the setting
screen.

> [Remote] tab

[ Jog/Shuttle | AMP | Remote

General

R1

Default...

Selecting [No (Minimum)] doesn't set delay.

Selecting [Yes (Sync Multiple T2s)] sets delay.

[Remote(GPI/R5422) When multiple T2s are used, this is selected.

Start/Stop Delay:]

Selecting [Custom] sets delay. You can set
custom delay frames.

2 Set each item and tap [OK].
Tap [Apply] to keep on making settings of other items.
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11
Remote Control

This section describes the remote control using GPI input/output, AMP
command, BVW, and TC Chase command.

Remote control using AMP/BVW/TC Chase

Overview of AMP control

For T2, the following AMP control are available via Ethernet.
¢ Controlling an external device from T2 with AMP (R1-VTR mode)
¢ Controlling T2 from an external controller with AMP (R1-remote
mode)
¢ Controlling T2 from an external controller with AMP (P1/P2-remote
mode)

TIP  * For AMP specifications and settings, refer to the Grass Valley
AMP protocol documents on our website or the following
URL.
http:/www.gvgdevelopers.com/concrete/apis/amp_protocol/
documentation/

¢ For sample source codes of AMP protocol, refer to our website

or the following URL.
http:/www.gvgdevelopers.com/concrete/apis/amp_protocol

amp-socket-connection-example/

¢ For the AMP commands list, see “Appendix”.
AMP command list»P242

* The port number of T2 for connecting AMP is 3811.

* AMP control sample programs can be downloaded from our
website.

NOTE ° The AMP commands for T2 do not support controlling via
RS422.

* AMP control sample program software is not eligible for
product support.
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Remote control using AMP/BVW/TC Chase

Overview of BVYW control

For T2, the following BVW control are available via R5422
¢ Controlling an external device from T2 with BVW (R1-VTR mode)
¢ Controlling T2 from an external controller with BVW (R1-remote
mode)
¢ Controlling T2 from an external controller with BVW (P1/P2-remote
mode)

TIP e For the BVW list of commands used in the R1-VTR mode, see

“Appendix”.
BVW command list»P256

¢ For the availability of BVW commands used in the remote
mode, see “Appendix”.
BVW list supporting remote mode» P257

¢ For the input/output pin assignment of R5422, see “Appendix”.
RS422 input/output pin»P258

Overview of TC Chase control

T2 supports playback of P1 channel (or P2 channel) whose frame accuracy
synchronizes with SMPTE-compliant LTC.

TIP * For detailed procedures for TC Chase, refer to a separate
document released on our website.

Controlling an external device from T2 with AMP/BVW
(R1-VTR mode)

The operation of T2 to control an external device (VIR) with the AMP
command (via Ethernet) or BVW command (via R5422), using T2 as a
controller (master) is described in this part.

When you use the BVW command, you do not need to perform steps 1 to 3.

1 Tap [Config.] on the touch screen LCD of T2.

2 Tap [General], and then tap the [Network-1] tab or [Network-2] tab.

3 Set the IP address of T2.
General — Network-1/Network-2 settings»P179
4 Tap [R1], and then tap [Timecode & Remote].
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5 Select a remote protocol from the list of [Remote Protocol(VTR
Mode):].

If [BVW] is selected, proceed to step 7.

6 If [AMP] is selected in step 5, set the IP address and channel of
the VTR.

7 Tap [OK].

8 Press the [R1] button, and then tap [VIR].

Controlling of an external device from T2 with AMP command or BVW
command will be enabled.

Controlling T2 from an external controller with AMP/
BVW (R1-remote mode)

The settings of T2 to control the R1 channel of T2 from an external
controller with the AMP command (via Ethernet) or BVW command (via
RS422) is described in this part.

T2 accepts commands from the external controller as a device (slave).

1 Tap [Config.] on the touch screen LCD of T2.

2 Tap [R1], and then tap the [Timecode & Remote] tab.

3 Select a remote protocol from the list of [Remote Protocol(Remote
Mode):].

TIP ¢ Check [Enable local operations while being remote controlled.]
to operate T2 locally even in the remote mode.
R1 -Timecode & Remote settings»P195

4 Tap [OK].

5 Press the [R1] button, and then tap [Remote].

Controlling of R1 channel from an external controller with AMP or BVW
command will be enabled.

Controlling T2 from an external controller with AMP/
BVW (P1/P2-remote mode)

The settings of T2 to control the P1/P2 channel of T2 from an external
controller with the AMP command (via Ethernet) or BVW command (via
R5422) is described in this part.

T2 accepts commands from the external controller as a device (slave).
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Remote control using AMP/BVW/TC Chase

1 Tap [Config.] on the touch screen LCD of T2.

2 Tap [P1] or [P2], and then tap the [Monitor & Remote] tab.
P1/P2 - Monitor & Remote settings» P201
3 Select a remote protocol from the list of [Remote protocol:].

TIP ¢ Check [Enable local operations while being remote controlled.]
to operate T2 locally even in the remote mode.

P1/P2 — Monitor & Remote settings»P201

4 Tap [OK].
5 Press the [P1] button.

6 Tap [Menu], and then tap [Remote].

[Remote] will be checked.
Controlling of P1/P2 channel from an external controller with AMP or
BVW command will be enabled.

TIP ¢ For EraselD command of AMP, you can set whether or not to
delete clips completely.
Miscellaneous — AMP settings» P222

Controlling T2 with TC Chase (P1/P2-remote mode)

This section describes the settings for TC Chase control to perform
playback where the LTC input to the R1 channel and the timecode of P1/
P2 channel are synchronized.

TC Chase control requires reference signal and video signal input that
synchronizes with the input LTC, in addition to the LTC input to the R1
channel.

TIP ¢ For detailed procedures for TC Chase, refer to a separate
document released on our website.

1 Tap [Config.] on the touch screen LCD of T2.

2 Tap [General], and then tap the [Hardware] tab.
General — Hardware settings»P178

3 Select a [External] from the list of [Reference :].

Confirm that it is synchronized with the input reference signal correctly.
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4 Tap [R1], and then tap the [Input Settings] tab.

R1 - Input Settings»P193

5 Select [Input type :] and [Input format :] used for the input video
signal.

6 Tap [P1] or [P2], and then tap the [Video] tab.

P1/P2 - Video settings»P199

7 Select the format to playback.

8 Tap the [Monitor & Remote] tab.
P1/P2 - Monitor & Remote settings» P201
9 Select a [TC Chase] from the list of [Remote protocol:].

TIP ® Check [Enable local operations while being remote controlled.]
to operate T2 locally even in the remote mode.
P1/P2 - Monitor & Remote settings» P201

10 Tap [OK].
11 Press the [P1] button.

12 Tap [Menu], and then tap [Remote].

[Remote] will be checked.
P1/P2 channel will be played back, being synchronized with the LTC
input to the R1 channel.

Remote control using GPI

Overview of GPI control

For T2, the following GPI control are available.

> Controlling T2 with GPI input

You can control T2 by assigning actions to the GPI input port (6 pins).

GPI input will be accepted regardless whether T2 is in the remote mode or
the channel is locked.

On T2, configure the settings in [GPI] -> [Input] tab of the setting screen.
GPI - Input settings»P218

NOTE ° When controlling T2 with GPI input, do not use RS422 at the
same time. Controlling with RS422 may become disabled.
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Remote control using GPI

> Controlling external devices from T2 with GPI output
Controlling external devices from T2 with GPI output» P229

> Tally output from GPI

You can configure your T2 to output tally signal from GPI and turn on the
tally lamp of an external monitor while playing back or recording video.
On T2, configure the settings in [GPI] -> [Output] tab of the setting screen.
GPI - Output settings» P220

TIP ¢ For GPI input/output pin, see “Appendix”.
GPI settings»P218

Controlling external devices from T2 with GPI output

You can control an external device with GPI output by specifying a trigger
for an event in the playlist loaded to the P1 channel of T2.

1 Tap [Config.] on the touch screen LCD of T2.

2 Tap [GPI], and then tap [Output].
GPI - Output settings»P220

3 Tap [Previous] or [Next] and select a GPI output pin.
The number of the selected pin is displayed on the right of [GPI-Output].

4 Set [Name:] and [Active:] in the trigger setting, and select
[Trigger] from the list of [Mode].

5 Tap [OK].

6 Load the playlist including the event to specify a trigger to the
P1 channel.

7 Press the [P1] button.

8 Tap an event to set the trigger from the event list to select it.

The selected event is displayed with a blue frame.

9 Tap [Menu], and then tap [Event Properties].
10 Tap the [GPI] tab.

11 Check [Trigger GPI] and select the name of the trigger setting set
in step 4 from the list.
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12 Select an action of the event to be the trigger.

Event Info GPT Timecode | StartEffect = End Effect

& Trigger GPI  GPT-OUT-2

@® start of Event
O End of Event
O start plus

© End Minus

* GPI-Outputs are available on P1 only.

OK Cancel Apply

* Select [Start of Event] to set the playback start of an event to be the
trigger.

¢ Select [End of Event] to set the playback end of an event to be the
trigger.

* Select [Start plus] to add a specified time to the time of playback start
of an event and set it to be the trigger. Tap the timecode and enter the
time to add.

¢ Select [End Minus] to subtract a specified time from the time of
playback end of an event and set it to be the trigger. Tap the timecode
and enter the time to subtract.

13 Tap [OK].
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Appendix

This section includes the list of the keyboard shortcut in the workstation mode, input/output format,

operation-ensured drivers for each device, AMP command, and BVW command.

Keyboard shortcut list in workstation mode

The following list shows the keyboard shortcuts.

Section

Category

Action

Shortcut

[General]

[Select R1 channel]

(1]

[Select P1 channel]

(2]

[Select P2 channel]

3]

[Change focus to the folder list]

[Change focus to the content list]

[Change focus to the playlist of the selected channel]

[Switch between 1ch View and 2ch/3ch View]

[Change the content’s tab]

[Show the Configuration screen]

[Show the content search screen|]

[Lock/Unlock the selected channel]

[Turn On/Off the Loop in the selected channel (P1/P2)]

[Turn On/Off the EtoE in the selected channel (P1/P2)]

[Turn On/Off the Remote of the selected channel (P’1/P2)]

[Turn the sync play mode On/Off]

[Eject the selected channel]

[Start Recording the selected channel (R1)]

M]

[Start playback in the selected channel]

L

—_

[Play reverse in the selected channel]

—

]

[Play or pause the selected channel]

Space]

[Stop playing/recording in the selected channel]

K]

[Fast Forward (skip) in the selected channel]

[
[
[
[
[
[

il

[Rewind (1 step back) in the selected channel]

[H]
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Category Action Shortcut
[Increase (1 step forward) the VAR speed in the selected 1
channel]

[Slower (1 step back) the VAR speed in the selected channel] | []
[Increase (0.1 forward) the VAR speed in the selected
channel]
[Slower (0.1 back) the VAR speed in the selected channel]
[Increase (0.01 forward) the VAR speed in the selected
channel]
[Slower (0.01 back) the VAR speed in the selected channel]
[Move to top frame(previous event) of the selected channel] | [A]
[Move to last frame(next event) of the selected channel] [S]
[Move to In point of the selected channel] [Shift+]]
[Move to Out point of the selected channel] [Shift+O]
[Move to the previous frame in the selected channel] [<-]
[Move to the next frame in the selected channel] -]
[Move to the previous frame in the selected channel(JOG
Mode)|?
[Move to the next frame in the selected channel(JOG
Mode)]?
[Set the In point of the selected channel] [1]
[Set the Out point of the selected channel] [O]
[Clear the In/Out points of the selected channel] {ggg:{g}
[Fast forward (0.01 forward) the current speed in the
selected channel]
[Fast forward (0.1 forward) the current speed in the selected
channel]
[Slow (0.01 back) the current speed in the selected channel]
[Slow (0.1 back) the current speed in the selected channel]
[Load the content(s) to the selected channel]™
[Load the content(s) to P1]!
[Load the content(s) to P2]!
[Cue up to the event within the playlist in the selected
channel]?
[Cue up to the event within the playlist in the selected
channel and pause]?
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Category

Action

Shortcut

[Cue up to the event within the playlist in the selected
channel and play]?

[Cue up to the event within the playlist P1]™

[Cue up to the event within the playlist in P1 and pause]*

[Cue up to the event within the playlist in P1 and play]™

[Cue up to the event within the playlist P2]*

[Cue up to the event within the playlist in P2 and pause]™

[Cue up to the event within the playlist in P2 and play]™

[Contents List]

October 6, 2014

[Mount the selected item on the selected channel]

[Return]

[Mount the selected item on the selected channel (with
shifting the focus)]

[Mount the selected item on the selected channel and
pause]

[Mount the selected item on the selected channel and pause
(with shifting the focus)]

[Mount the selected item on the selected channel and play]

[Mount the selected item on the selected channel and play
(with shifting the focus)]

[Mount the selected item on P1]

[Mount the selected item on P1 (with shifting the focus)]

[Mount and pause the selected item on P1]

[Mount and pause the selected item on P1 (with shifting the
focus)]

[Mount and play the selected item on P1]

[Mount and play the selected item on P1 (with shifting the
focus)]

[Mount the selected item on P2]

[Mount the selected item on P2 (with shifting the focus)]

[Mount and pause the selected item on P2]

[Mount and pause the selected item on P2 (with shifting the
focus)]

[Mount and play the selected item on P2]

[Mount and play the selected item on P2 (with shifting the
focus)]

[Scroll to top of selected item]

[Home]

[Scroll to last selected item]

[End]

[Delete selected item]

[Delete]
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Category

Action

Shortcut

[Copy selected item]

[Ctrl]+[C]

[Cut selected item]

[Ctri+[X]

[Paste item from the clipboard]

[Ctrl]+[V]

[Show the rename dialog box for the selected item]

[Change the thumbnail frame color of the selected item to
the default color]

[Change the thumbnail frame color of the selected item to
the color 1]

[Change the thumbnail frame color of the selected item to
the color 2]

[Change the thumbnail frame color of the selected item to
the color 3]

[Change the thumbnail frame color of the selected item to
the color 4]

[Change the thumbnail frame color of the selected item to
the color 5]

[Show the film strip for the selected item]

[Show the properties for the selected item]

[Playlist]

[Cue up to the selected event]

[Return]

[Cue up and pause to the selected event]

[Cue up and play to the selected event]

[Delete the selected event]

[Delete]

[Copy the selected event]

[Ctrl]+[C]

[Paste the selected event]

[Ctrl]+[V]

[Show the rename dialog box of the selected event]

[Set the fade in of the selected event to “none”]

[Set the fade in of the selected event to “from black”]

[Set the fade in of the selected event to “from white”]

[Set the fade out of the selected event to “none”

[Set the fade out of the selected event to “from black”]

[Set the fade out of the selected event to “from white”]

[Set the end effect action to “none” in the selected event]

[Set the end effect action to “Pause (Show black frame)” in
the selected event]

[Set the end effect action to “Pause (Show white frame)” in
the selected event]
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Category Action Shortcut

[Set the end effect action to “Pause (Show last frame)” in the
selected event]

[Set the end effect action to “Pause (Show next event frame)”
in the selected event]

[Set the end effect action to “Pause (Show EtoE)” in the
selected event]

[Set the end effect action to “loop” in the selected event]

[Show the properties of selected event]

*1 Can mount clips and playlists that start with 00_ to 99_.

*2 Can be set to the maximum of 100 events.

*3 Using the shortcut for controlling from an external controller JOG, you can move frames
smoothly when consecutive commands are received. It is most suitable when assigned to the
JOG of Shuttle Pro, etc.

Operation-ensured drivers for each device

Operation-ensured driver versions for XDCAM/XDCAM EX

The operations of the following version of driver have been ensured on this product.

Product name Version
XDCAM Drive Software Ver. 4.0.3

Operation-ensured driver version for P2

The operations of the following version of driver have been ensured on this product.

Product name Version
Memory Card Drive “P2 drive” AJ-PCD20 P2 Driver Ver. 2.1.8 (64 bit)
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Input/output format list

Input format

O: Supported, A: Not all supported, X: Not supported

Container

Video

Audio

Post-import format

Format

Format

Native

AVI (HQ)
conversion

Rewrap MXF
(OP-1a)

Unpack

AVI

Grass Valley HQ

Grass Valley HQ + Alpha

Grass Valley HQX

Grass Valley HQX + Alpha

DV

DVCPRO25

DVCPRO50

DVCPRO HD

Uncompress YUV

Uncompress RGB

Grass Valley Lossless

Linear PCM

O

X1

O

MXF

Grass Valley HQ

Grass Valley HOX

Linear PCM

AVC-Intra 50

AVC-Intra 100

D10

DV

DVCPRO25

DVCPRO50

DVCPRO HD

JPEG2000

MPEG2

Linear PCM/
A-law

O| X

AVCHD

H.264/AVC

Dolby Digital (AC-3)/
Linear PCM

P2

DV

DVCPRO25

DVCPRO50

DVCPRO HD

AVC-Intra 50

AVC-Intra 100

Linear PCM
(48kHz, 16 bit/24 bit)

XDCAM
(VFAM/FAM)

HD 422 (50Mb/s)

HD (35Mbys)

HD (25Mbys)

HD (18Mb/s)

DV

IMX

8 channels AES3/
Linear PCM/A-law

XDCAM EX

HD (35Mby/s)

HD (25Mbys)

Linear PCM
(48kHz, 16 bit)

GF

DV

DVCPRO25

DVCPRO50

MPEG-2

Linear PCM
(48kHz, 16 bit/24 bit)

Windows
Media

Windows Media Video

Windows Media
Audio
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Container

Video

Audio

Post-import format

Format

Format

Native

AVI (HQ)
conversion

Rewrap MXF
(0P-1a)

Unpack

QuickTime

DV

DVCPRO 25

DVCPRO 50

DVCPRO HD

H.264 (QuickTime Video
(avcl))

ProRes422

ProRes422 HQ

ProRes422 Proxy

ProRes4444

JPEG2000

Animation

MPEG-4

Photo JPEG

PNG

Uncompressed YUV

Sans

QuickTime Video (mp4v)

Uncompress 10 bit

Uncompress 10 bit YUV

QuickTime Video (rpza)

QuickTime Video (cvid)

Motion JPEG A

Motion JPEG B

Sorenson Video 3

Uncompressed RGB

Grass Valley HQ

Grass Valley HQ + Alpha

Grass Valley HQX

Grass Valley HQX + Alpha

AAC/

Apple Lossless/MP3/
ADPCM/
A-law/U-law/
Linear PCM

o

MPEG2

MPEG-2

MPEGI1 Audio
Layer-2/
Dolby Digital (AC-3)/
Linear PCM

GXF

MPEG-2

D10

DV

DVCPRO25

DVCPRO50

DVCPRO HD

AVC-Intra 50

AVC-Intra 100

Linear PCM/A-law

Still image

A

O

TWF

X

X

O

*1  When importing AVI(Grass Valley HQX), the file will be automatically converted to AVI(Grass

Valley HQ).

*2 Native format import is only available for T2 Elite. T2 Pro or T2 Express will import files after
converting them to Grass Valley HQ AVL
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Output format

Sources imported to T2 can be exported in “Post-export format” in the table.

O: Supported, x: Not supported

Container

Video

Audio

Post-export format

Format

Format

Native

Conversion

TWF

AVI

Grass Valley HQ

Linear PCM

023

O1234

O*

MXF

Grass Valley HQ

Linear PCM

AVC-Intra 50

AVC-Intra 100

D10

DV

DVCPRO25

DVCPRO50

DVCPRO HD

MPEG-2

Linear PCM/A-law

Ok

o

AVCHD

H.264/AVC

Dolby Digital (AC-3)/Linear PCM

O*S, 7

o

P2

DV

DVCPRO25

DVCPRO50

DVCPRO HD

AVC-Intra 50

AVC-Intra 100

Linear PCM (48kHz, 16 bit/24 bit)

O*S, 7

o

XDCAM

HD 422 (50Mby/s)

HD (35Mby/s)

HD (25Mb/s)

HD (18Mby/s)

DV

IMX

8 channels AES3/Linear PCM/A-law

O*S, 7

o

XDCAM EX

HD (35Mbys)

HD (25Mbys)

Linear PCM (48kHz, 16 bit)

O”S, 7

o

GF

DV

DVCPRO25

DVCPRO50

MPEG-2

Linear PCM (48kHz, 16 bit/24 bit)

O*S, 7

o

QuickTime

ProRes422

ProRes422 HQ

ProRes422 Proxy

ProRes4444

Grass Valley HQ

AAC/Apple Lossless/MP3/ADPCM/
A-law/U-law/Linear PCM

O*S, 7

o

Still image

ok

o®

Playlist

O*S, 9

o

*1 You can export by converting them to the following formats.
- XDCAM HD422 (1920 x 1080 59.94i/50i/29.97p/25p 50 Mbps)

- XDCAM HD (1440 x 1080 59.94i/50i/29.97p/25p/23.98p 25 Mbps)

- XDCAM IMX (720 x 486 59.94i, 720 x 576 50i)
- XDCAM DV (720 x 486 59.94i, 720 x 576 50i)
*2 Cutting out exporting a clip between In and Out points and subclip are supported.

*3 Time-shift export is supported.
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*4 Clips are converted to have no alpha.
*5 Cutting out exporting a clip between In and Out points are not supported.
*6 When TWEF files are imported to T2, In/Out point settings are restored.

*7 FTP export is not supported.
*8 You can export to convert Grass Valley HQ AVL
*9 Cutting out exporting a clip between In and Out points are supported. Exporting a subclip are

not supported.

Supported video format and output port

Input/output format list

. . DVI-I

Video format Composite SDI DVI-I (YPhPY) RGB

1920 x 1080 50/59.94p CEA861D

1920 x 1080 50/59.94i 292M CEA861D 274AM

1920 x 1080 24p (PsF) 292M CEA861D 274M

1280 x 720 50/59.94p 292M CEA861D 296M

1280 x 720 24p 292M

720 x 480 59.94i 170M 259M EBU N10

720 x 576 50i BT.470 259M EBU N10

1280 x 1024 60p DVI 1.0 DMT

1024 x 768 60p DVI 1.0 DMT

800 x 600 60p DVI 1.0 DMT

640 x 480 59.94p DVI 1.0 DMT

Notes on export and growing clip editing
O: Supported, x: Not supported
Export FTP export
Clip media type State I I I I
Export ‘?T“‘”‘“g ol FTP export (_il_'owmg e
editing on EDIUS editing on EDIUS

Recording O o X2 —

Grass Valley HQ

AVI Finished O 0*3 0O %
recording
Recording O O @) X

Grass Valley HQ —

AVIto XDCAM" | Finished o o o 056
recording
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Export FTP export
Clip media type State Growing clip Growing clip
Export | e diting on EDIUS | F'F PO | eiting on EDIUS
Recording X2 — O™ O™56
XDCAM L
Flrush?d o y o -
recording

*1 Transcode to XDCAM when exporting

*2 Export starts after finishing record

*3 Import to EDIUS bin to edit

*4  Only valid when [Allow to edit growing MXF File] is checked in the [R1] -> [Input Setting] tab.
*5 Must be on K2 server to edit

*6 Import to EDIUS Source Browser to edit

Notes on record of external device and growing clip editing
O: Supported

Record of external device
Clip media type State
Record Growing clip editing on EDIUS
Grass Valley HQ AVI Recording O o
XDCAM Recording O o

*1 Import to EDIUS bin to edit

Notes on FTP download and growing clip editing
O: Supported, x: Not supported

Record of external device
Clip media type State
Record Growing clip editing on EDIUS
Recording X1 —
Grass Valley HQ AVI
Finished recording O X
Recording O O3
XDCAM
Finished recording O O

*1 Not show the list of FTP client while recording
*2 Only valid when [Allow to edit growing MXF File] is checked in the [R1] -> [Input Setting] tab.
*3 Import to EDIUS Source Browser to edit
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Input/output format list

Notes on Direct Access Folder and growing clip editing(T2 Elite only)

O: Supported, x: Not supported

Clip media type State Growing clip editing on EDIUS
Recording o2
Grass Valley HQ AVI
Finished recording O
Recording o2
XDCAM
Finished recording O

*1 Use FTP download for transfering clips
*2 Import to EDIUS Bin Window to edit
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AMP command list

The AMP commands available in T2 are listed in the following tables. The commands with gray-

colored cells in the list are not supported by T2.

NOTE

¢ The latency in the number of frames from the time the command such as Play or Stop is
issued to the time the operation actually starts is not fixed. The video loaded on multiple
T2 cannot be synchronized in the accurate frames by AMP commands.

e .For AMP specifications and settings, refer to the Grass Valley AMP protocol documents
on our website or the following URL.
http:/www.gvgdevelopers.com/concrete/apis/amp_protocol/documentation/

¢ For sample source codes of AMP protocol, refer to our website or the following URL.
http://www.gvgdevelopers.com/concrete/apis/amp_protocol/amp-socket-connection-
example/

* The port number of T2 for connecting AMP is 3811.

* AMP control sample programs can be downloaded from our website.

Device management

Fill/Key
Command Channel- R1 | P1/P2 Sync | signal Supplementary_ note on T2
less mode mode | output operation
mode
[DF mode] setting that is in
[Miscellaneous] of [General]
in the setting screen will be
Set Drop changed.
01.06 O O O O O
Frame Mode Since [DF mode:] is a common
setting for R1/P1/P2, the
setting change will be applied
to the other channels.
Enabling and disabling of
00.0C | Local Disable No O O O O local control or remote control
can be set for each channel.
Enabling and disabling of
0X.1D | Local Enable No O O O O local control or remote control
can be set for each channel.
0x20 and 0x50 are returned
Device Type corresponding to the device
0011 Request © © © © © category and the model
number, respectively.
20.04 | Standby Off No No | No No No
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AMP command list

Fill/Key
Command Channel- R1 | P1/P2 Sync | signal Supplementary_ note on T2
less mode mode | output operation
mode
20.05 | Standby On No No No No No
20.60 | EE Off No No @) No No
20.61 | EE On No No @) No No
It takes several seconds from
Set Mute the time the command has
21.62 Mode No No © © © been issued until the time the
setting is applied.
A8.20 | Set Device ID O O O @) @)
A021 | Device ID O O O O O
Request
A0.2C Device Name o o o o o
Request
Transport controls
Fill/Key
Command Channel- R1 | P1/P2 Sync | signal Supplementary_ note on T2
less mode mode | output operation
mode
Specifying the timecode value
on the command execution
2X.00 | Stop No © © © © (event schedule) is not
supported.
Specifying the timecode value
on the command execution
2X01 | Play No No © © © (event schedule) is not
supported.
Specifying the timecode value
on the command execution
2X.02 | Record No O No No No (event schedule) is supported
only when the input type is
LTC or VITC (SDI).
20.0F | Eject No @) O O O
20.10 | Fast Forward No No O No No P.lays back the video in 32
times the normal play speed.
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Fill/Key
Command Channel- R1 | P1/P2 Sync | signal Supplementary. note on T2
less mode mode | output operation
mode
2X11 | Jog Forward No No O No No™
2x12 | Yariable No No | O | No | Not
Forward
2x13 | Shuttle No No | O | No | Not
Forward
Plays back in reverse the
20.20 | Rewind No No O No No video in 32 times the normal
play speed.
2X.21 | Jog Reverse No No O No No™
2X.2p | Variable No No | O | No | Not
Reverse
2Xp3 | Shuttle No No | O | No | Not
Reverse
X 31 Cue Up With No No o o o A pseudo clip “<BLACK>" is
Data not supported.
2052 | Lension No No | No | No | No
Release
44.05 User Bits No No No No No Not supported on T2.
Preset
40.20 | In Reset No No O O O
For R1, the setting will be
applied on the timecode
that is saved when video is
Timecode recorded.
41.36 N O N N N
Mode Preset ° © © © For LTC, the timecode of TC
input is recorded, and for
VITC, the timecode of SDI
input is recorded.
4040 | AutoMode No No | O O O
Off
4041 é‘;to Mode No No | O O O
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AMP command list

Fill/Key
Command Channel- R1 | P1/P2 Sync | signal Supplementary. note on T2
less mode mode | output operation
mode
If you want to change
Set Loop t}I: fiﬁgsgr?élr}it? emmemd
4142 | Playback No |[No | O | © o |Payvack ©
Mode approximately four or more
seconds before it comes to the
position to set loop.
Set
4143 | Widescreen No O No No No
Mode
If you want to change
the setting during the
4144 Set Stop No No o o o playbachk, send the command
Mode approximately four or more
seconds before it comes to the
position to set stop.
Get Stop
40.45 Mode No No O O O
State Change
60.0B | Latency No No No No No | Not supported on T2.
Request
Since obtaining User Bits is
not supported, 00000000 will
always be returned.
The response is always the
same value regardless of the
) type of LTC or VITC.
C tT
61.0C Surren me O O O O O If LTC source or VITC source
ense e .
has been specified, R1 input
timecode is returned.
Only 1.LTC, 4Timer,
8:WindowsTime, and 40:LTC
(Src) (R1 LTC input) are
supported.
2
61,20 Status Sense o o o o o
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Fill/Key
Command Channel- | o, | py/pp | Sync | signal Supplementary note on T2
less mode mode | output operation
mode
Record Cue o .
AX.02 | Up With No O | No | No | No |Onlyspecifying the clipname
Data is available.

*1 Operates only when the specified speed is 0 (Stop).
*2 Supported status flag

Data0 Busy, Remote+Local/ Local
Datal Play, Record, FFW, REW, Stop
Data2 Still, TapeDirection, Var, Shuttle

InPreset, OutPreset, AutoMode, FolderalreadyEXxist,

Data3 InvalidFolderName, FolderDeletionFail, SourceMissing

Data4 EEOn, LoopPlayBack

Data9 FolderNotFound, OutPresetFail, PreviewInPreset, PreviewOutPreset
DataA IDNotFound, MovieDeleteComplete, MovieDeleteFail

DataD TapeTop, TapeEnd, LTC, Timer, VITC, TimeOfDay, DropFrame

Managing clips on the timeline

Fill/Key
Command Channel- R1 | P1/P2 Sync | signal Supplementary_ note on T2
less mode mode | output operation
mode
4X14 | In Preset No | No | O | O o | A pseudoclip “BLACK>"is
not supported.
If you want to set an Out
point during the playback,
4X.15 | Out Preset No No O O O send th? command
approximately four or more
seconds before it comes to the
position to set the Out point.
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AMP command list

Command

Channel-
less mode

R1

P1/P2

Sync
mode

Fill/Key
signal
output
mode

Supplementary note on T2
operation

4F.16

Append
Preset

No

No

If you want to execute

the command during the
playback, send the command
approximately four or more
seconds before it comes to the
end point of Preset Timeline.

4X.21

Out Reset

If you want to set an Out
point during the playback,
send the command
approximately four or more
seconds before it comes to the
position to set the Out point.

A0.06

Preview In
Reset

No

No

AX.07

Preview Out
Reset

If you want to set an Out
point during the playback,
send the command
approximately four or more
seconds before it comes to the
position to set the Out point.

4431

Pre-roll

No

No

No

No

No

Not supported on T2.

AX.04

Preview In
Preset

No

No

If you want to execute

the command during the
playback, send the command
approximately four or more
seconds before it comes to the
end point of Preset Timeline.
A pseudo clip “<BLACK>" is
not supported.

AX.05

Preview Out
Preset

No

If you want to set an Out
point during the playback,
send the command
approximately four or more
seconds before it comes to the
position to set the Out point.
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Fill/Key
Command Channel- R1 | P1/P2 Sync | signal Supplementary. note on T2
less mode mode | output operation
mode
If you want to execute
the command during the
Append layback, send the command
AF.0A | Preview No No | O O o | Payback
Preset approximately four or more
seconds before it comes to the
end point of Preset Timeline.
Only switching on/off of sync
mode by Instant Ganging is
available on T2. (P1 only)
A1.32 | Set Ganging No No ©) O No Send Data 1:
0 Sync Off
6 Sync On (Channel 2 (bit 1)
and Channel 3 (bit 2) ganged)
A0.33 | Get Ganging No No O O No
AX.34 Set Gang.lng No No No No No | Not supported on T2.
Information
A0.35 Get Gangmg No No No No No | Not supported on T2.
Information
AX11 Erase No No No No No | Not supported on T2.
Segment
Ao.16 | I Loaded No o | o ® ®
Request
AX.01 | Auto Skip No No O O O
Managing stored clips
Fill/Key
Command Channel- R1 | P1/P2 Sync | signal Supplementary_ note on T2
less mode mode | output operation
mode
A0.26 | 1D Count o o| o | o o
Request
AX.14 | List First ID O O O O O
AX.15 | List Next ID ©) O O O O
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AMP command list

Fill/Key
Command Channel- R1 | P1/P2 Sync | signal Supplementary_ note on T2
less mode mode | output operation
mode
AX1s | 1D Status o o| o] o o
Request
Set Working
A2.0E | Folder O O O O O
Request
Get Working
AO0.0F | Folder O ©) ©) O O
Request
In and Out points are
A012 Il?s Changed o o o o o changed 31mu1tane9usly a}nd
List Request you can not recognize which
point has been changed.
AX.10 | Erase ID O O O O O
A02A | List First o o| o] o o
Folder
Q2B | List Next o o| o] o o
Folder
Total/
Axc | Available O o | o | o e
Storage
Request
Set Record Recording duration cannot be
A4.1D . No O No No No | changed during the recording
Duration .
operation.
A2.31 | Create Folder O O O O O
Rename
A2.28 Folder O O O O O
A2.29 | Delete Folder O O O ©) O
A205 ID Start Time o o o o o
Request
A217 ID Duration o o o o o
Request
AE.30 | Replace Edit No No No No No | Not supported on T2.
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Fill/Key
Command Channel- R1 | P1/P2 Sync | signal Supplementary_ note on T2
less mode mode | output operation
mode
In the properties for the
Stripe clip and playlist, [Replace
AX.2D Timecode © © © © © timecode media:] will be set
to [Specify Start Time].
AX2E | Set Mark In o o o o o This set.tmg cannot be applied
to playlists.
If you want to set an Out
point during the playback,
send the command
AX.2F | Set Mark Out O O O O O approximately four oF tmore
seconds before it comes to the
position to set the Out point.
This setting cannot be applied
to playlists.

It takes several seconds from
Set Audi the time the command has
AE.1E © ) ucio @) O O O @) been issued until the time the
Gain .. .
setting is applied on a loaded
clip.
AA1p| GetAudio 0o ol ol o 0O
Gain
Abort
C0.28 Transfer ID O O O O O
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AMP command list

Command

Channel-
less mode

R1

P1/P2

Sync
mode

Fill/Key
signal
output
mode

Supplementary note on T2
operation

Transfer
CX.27 | ID Status
Request

This setting will be applied
only on the transfer that

has started when Extended
Transfer ID command is
issued. (Not applied to the
transfer that has started in the
workstation mode/front panel
mode of T2.)

type 2 (data containing
number of bytes transferred),
3 (data containing number

of fields transferred) are not
supported.

C2.26 | Transfer ID

No

No

No

No

No

Not supported on T2.
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Command

Channel-
less mode

R1

P1/P2

Sync
mode

Fill/Key
signal
output
mode

Supplementary note on T2
operation

C2.25

Extended
Transfer ID

Setting of In and Out points is
only supported for FFFFFFFFE.
(The range for the transfer
cannot be set.)

The setting for the transfer type
will be disabled. The transfer
type follows the settings in
[Transfer] -> [AVI] or [Playlist]
on the setting screen.

The recommended transfer

type is 0x03 (Profile), which

is described in “K2_Protocol_
developers_Guide” as a sample of
transfer via Grass Valley server.
Set the clip/playlist name for
the transfer source of export.

Set the transfer destination as
follows.
¢ Network Drive:localhost/[n]:/
[dir]/[file name]
For “n”, specify the network
drive allocated by [General] ->
[Network-3] on the setting screen
or the drive connected via USB.
Example)localhost/z:/Export/Clipl
e FTP server:[address]/v:/[bin
name]/[file name]
For address, specify the
address registered in [Hose
Name/IP Address]| in [FTP
Export List] of [General] ->
[FTP] on the setting screen.
Example)169.254.138.3/v:/
Default/Clipl
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AMP command list

Fill/Key
Command Channel- | o, | py/pp| Sync | signal Supplementary note on T2
less mode mode | output operation
mode

Set the transfer source of

import as follows.

e [n];/[dir]/[file name]

For “n”, specify the network
Extended drive allocated by [General]
C225 Transfer ID O O © O O -> [Network-3] or the drive

AX19

New Copy

connected via USB.

Set the transfer destination as
follows.

V:/[bin name]/[clip name]

Deep copy is not supported.

Setting In and Out points to
playlists is not available.

Only Shallow and Move are
supported.
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Clip data information

Fill/Key
Command Channel- | o, | py/pp | Sync | signal Supplementary note on T2
less mode mode | output operation
mode

AA.08| Set Clip Data No No | No No No | Not supported on T2.

If Send Data 1 is 'C;,
Compression Type and Video

AA13 Clip Data O O O O O Format are not supported.
Request B e
If Send Data 1 is 'E’, this
setting is not available.
Get A JPEG data with the size of
A2.09 Thumbnail © © © © © 160 x 90 will be returned.
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AMP command list

Flags
Flags Command Availability| Note Flags Command Availability| Note
Status hyte 0 Status byte 4
bit0: Local O bit0: Preroll @)
bitl: Remote+Local O bit1: Event Schedule Failed O
bit2: Hard Error O bit2: —
bit3: General Error O bit3: —
bit4: — bit4: Mute O
bit5: Cassette Out O Always0  bit5: Loop Playback Mode O
bit6: — bité: EE On O
bit7: Busy O bit7: —
Status byte 1 Status byte 9
bit0: Play O bit0: Preview In Preset ©)
bit1: Record O bitl: Preview Out Preset O
bit2: Fast Forward O bit2: Folder Not Found O
bit3: Rewind O bit3: Disk Overflow O
bit4: Eject O Always0  bit4: Metadata Not Found No
bit5: Stop O bit5: Clips Dropped O
bit6: Tension Release O Always 0 bité: Out Preset Failed O
bit7: Standby On O Always 1 bit7: Overwrite Clip o
Status byte 2 ' Name
bit0: Cue Complete O Status byte A
bitl: Still O bit0: ID Not Found O
bit2: Direction ©) bit1: Timecode Not Found O
bit3: Variable Play O bit2: Transfer ID Complete O
b%t4: Jog O bit3: Transfer ID Abort o
bit5: Shuttle ©) Complete
bit6: — bit4: Movie Delete Complete O
bit7: Servo Lock O bitb: Transfer ID Failed @)
SFatus byte 3 bit6: Traimsfer ID Abort o
bit0: In Preset O Failed
bitl: Out Preset O bit7: movie Delete Failed O
bit2: Spéciﬁed Folder o SFatus byte D .
Exist bit0: Time Of Day O
bit3: Invalid Folder o bitl: Widescreen Mode O
Name bit2: Drop Frame O
bitd: Fo?der Deletion o b%tS: V.ITC ©)
Failed bit4: Timer O
bit5: Jog Reject O bit5: LTC O
bit6: Source Missing O bit6: Tape End O
bit7: Auto Mode O bit7: Tape Top O
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BVYW command list

The BVW commands available when controlling an external controller from T2 in the R1-VTR mode
are listed in the following tables.
The commands with the “O” mark are available on the optional action as DEVICE, and if mentioned
in the RETURN column, RETURN + DATA is returned, and if not mentioned, 10 01 ACK is returned.
The commands with the “A\” mark return ACK or return RETURN as STATUS, but the action will

not be performed.

Command RETURN

00 | 11 |DEVICE TYPE REQUEST 12 | 11 |DEVICE TYPE RETURN O
20 | 00 |STOP O
20 | 01 |PLAY O
20 | 02 |RECORD O
20 | 04 |STANDBY OFF O
20 | 05 |STANDBY ON O
20 | 10 |FAST FWD O
2X | 11 {JOG FWD O
2X | 12 |VAR FWD O
2X | 13 |SHUTTLE FWD O
2X | 20 |REWIND O
2X | 21 |JOG REV O
2X | 22 |VAR REV O
2X | 23 |SHUTTLE REV O
24 | 31 |{CUE UP WITH DATA O
20 | 54 | ANTI-CLOG TIMER DISABLE A
20 | 55 |ANTI-CLOG TIMER ENABLE A
44 | 00 |TIMER-1 PRESET O
40 | 08 |TIMER-1 RESET O
41 | 36 |TIMER MODE SELECT O

74 | 00 |TIMER-1 DATA O

74 | 04 |LTC TIME DATA O

78 | 04 |LTC TIME & UB DATA O
61 | 0C | CURRENT TIME SENSE 74 | 05 |LTC UB DATA ©

74 | 06 | VITC TIME DATA O

78 | 06 |VITC TIME & UB DATA O

74 | 07 |VITC UB DATA O

70 | 0D |REQUEST TIME MISSING O
61 | 20 |STATUS SENSE 7X | 20 |STATUS DATA O
60 | 2E | COMMAND SPEED SENSE 71 | 2E | COMMAND SPEED DATA O
60 | 36 | TIMER MODE SENSE 71 | 36 |TIMER MODE DATA O

* Start Delay value = 10 (*16 hexadecimal)
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BVW list supporting remote mode

BVW list supporting remote mode

The BVW commands available when controlling T2 from an external controller in the R1-remote

mode and P1/P2-remote mode are listed in the following table.

O: Supported, A: Not all supported, X: Not supported

Command

R1

P1/P2

DEVICE TYPE REQUEST

@)

STOP

PLAY, SYNC PLAY

RECORD

STANDBY OFF

STANDBY ON

FAST FWD

JOG FWD

VAR FWD

SHUTTLE FWD

REWIND

JOG REV

VAR REV

SHUTTLE REV

CUE UP WITH DATA

ANTI-CLOG TIMER DISABLE

ANTI-CLOG TIMER ENABLE

TIMER-1 PRESET

olol|o|o|ololololo|o|olo|Q|o|o|o|> || x| x| x|x|x|x|x|x|x|x|O|O|x|O] O

TIMER-1 RESET

TIMER MODE SELECT

CURRENT TIME SENSE !
TIMER-1 DATA
LTC TIME DATA
LTC TIME & UB DATA
LTC UB DATA
VITC TIME DATA
VITC TIME & UB DATA
VITC UB DATA
REQUEST TIME MISSING

STATUS SENSE

COMMAND SPEED SENSE

TIMER MODE SENSE

REC

X|{O|O|O|O|O|O|O|O|O|O|O|O0|0|O|O|>|P>|O]O|0]O|0|0|0|0|0|0]0|0]|0|0

*1 If you query the timecode, R1 returns the timecode currently being input. For CURRENT TIME
SENSE, the type of timecode to query can be specified (LTC/VITC). Whichever is specified, the
timecode type set in T2 (the timecode type selected in [Select Timecode] in [R1] -> [Timecode &

Remote] on the setting screen) is returned.
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Section 12 — Appendix

RS422 input/output pin

RS422 input/output pins are as follows.

5 1

E_D

9

R1(R1-VTR mode) R1/P1/P2 (remote mode)
D-Sub 9pin D-Sub 9pin

Pin Signal Pin Signal

1 GND 1 GND

2 RECEIVE- 2 TRANSMIT-
3 TRANSMIT+ 3 RECEIVE+

4 GND 4 GND

5 NC 5 NC

6 GND 6 GND

7 RECEIVE+ 7 TRANSMIT+
8 TRANSMIT- 8 RECEIVE-

9 GND 9 GND

GPI input/output pin

GPI input/output pins are as follows.

I
O 6 0::::::3 O

1' ;
Pin Signal Pin Signal
1 Output 1 9 Input 1
2 Output 2 10 Input 2
3 Output 3 11 Input 3
4 Output 4 12 Input 4
5 Output 5 13 Input 5
6 Output 6 14 Input 6
7 NC 15 NC
8 Common ground Frame | Common ground

NOTE ° Only GPI Output 1 to 6 and Input 1 to 6 are available on T2. Pin 7and Pin 15 are not

used.
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